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Telestream Contact
Information
To obtain product information, technical support, or provide comments on this guide, 
contact us using our web site, email, or phone number as listed in Table 1.

Table 1. Telestream Contact Information

Resource Contact Information

Telestream Technical 
Support

Web Site: http://www.telestream.net/telestream-support

Support Email. support@telestream.net

Vantage Technical 
Support

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Telestream, Inc. Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream, Inc. 
848 Gold Flat Road
Nevada City, CA. USA 95959

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/overview.htm
mailto:support@telestream.net
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
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Domain Management
Overview
Vantage domain management tasks include Vantage installation, configuration, and 
management. The Vantage domain administrator primarily uses the Vantage 
Management Console to configure and manage a Vantage domain.

The following topics introduce Vantage and the Vantage system components that an 
administrator installs and manages:

 Introduction to Vantage

 Vantage Domain Components

 Vantage Domain Configurations

 Vantage Programs

 Vantage Licenses

 Topics in this Guide

Introduction to Vantage
At the simplest level, Vantage is a software program that automates media workflows. 
A Vantage media workflow defines one or more actions to process source media files. 
The actions supported in a Vantage workflow are defined by the Vantage product 
licenses you select. Table 2 lists some typical workflow objectives, the Vantage licenses 
that support those objectives, and descriptions of the objectives.

Note: The license information in Table 2 is provided for reference only. Vantage 
licenses are introduced in Vantage Licenses.
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With the proper product licenses, Vantage workflows can incorporate some or all of the 
objectives listed in Table 2, as well as other workflow design and management features, 
which include the following:

• Workflow visualization—Vantage offers a highly flexible process design interface, 
with visual components that help you see what the workflow will accomplish

• Notifications—Vantage can send emails or notify external systems when media is 
available

• Intelligent branching—Vantage workflows can be configured to evaluate variables, 
metadata, and the results of other workflow tasks, and select the appropriate work-
flow branch for further processing.

Table 2. Vantage Workflow Objectives

Workflow Objective 
(Vantage License) Description

File-to-file transcoding 
(Vantage Transcode or 
Transcode Pro)

Transcoding workflows automate the process of 
converting a video file from one media format to another. 
Vantage can open most video files, regardless of the 
encoding and packaging format, and create one or more 
new video files using one or more selections from an 
extensive list of encoder and packaging formats.

To perform a simple transcode with Vantage, you create a 
workflow, which defines what you want to do and what 
the output format should be. (Vantage automatically 
detects the input format.)

Adaptive streaming 
encoding (Vantage 
Multiscreen)

Adaptive streaming workflows, when run on a Lightspeed 
Server, can automate multi-rate H.264 encoding and 
preparation of on-demand media for adaptive streaming 
playout on mobile devices. The Lightspeed Server 
accelerates this type of workflow, and Vantage also 
automates the packaging and delivery of media to 
Content Delivery Networks (CDNs) or HTTP origin servers.

Moving media between 
devices (Vantage 
Transcode Pro Connect)

Media transport workflows use Vantage native 
connections to move media between a wide variety of 
broadcast servers, edit systems, and other professional 
video devices. Using these integrations, Vantage can 
automate the process of receiving media into, or moving 
media between, different devices—ensuring the right file 
format at any of many possible destinations.

Media analysis and 
media-dependent 
processing (Vantage 
Analysis)

Media analysis workflows use Vantage features to analyze 
media, compare the results to configured values, and 
make decisions about how media should be routed or 
processed.
Vantage Domain Management Guide
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• Workflow monitoring and control—Vantage programs allow you to view the status 
of jobs that have been submitted to a workflow, and you can stop, cancel, or restart 
jobs.

• Operator control—Vantage provides tools for enabling operator management. 
Operators can submit files to workflows, view the results of workflow, and submit 
the results to yet another workflow. Operators can also view the status of workflow 
jobs and, if granted permission by a Vantage administrator, stop, cancel or restart 
jobs.

• Scalability and Redundancy—Vantage scales to thousands of jobs and dozens of 
servers in an enterprise environment.

Vantage also provides many system management features, allowing you to scale a 
Vantage system to many servers, manage user access, and optimize system 
performance and reliability. The system management features are described in topics 
throughout this guide.

Vantage Domain Components
Vantage supports the installation of multiple Vantage domains within a business. A 
Vantage domain is a collection of Vantage software components that are linked 
together as a single Vantage installation. For example, you might install a Vantage 
domain for the Sports Department and another for the News Department, creating two 
Vantage domains. Each Vantage domain maintains its own database, and automates its 
own workflows, independently of other Vantage domains.

As a Vantage domain administrator, it becomes your job to manage the components in 
a Vantage domain. Figure 1 shows a simplified view of the basic components of a 
Vantage domain.
Vantage Domain Management Guide
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Figure 1. Simplified View of the Basic Vantage Domain Components

The work that you want Vantage to perform is defined in a workflow, which is created 
using the Vantage Workflow Designer program. The workflow is made up of individual 
tasks called actions, which specify what needs to be done with the input files. A typical 
workflow contains actions to do some or all of the following:

• Discover media that is ready for processing at an input storage location

• Analyze and transcode input media

• Store temporary media files in the Vantage store

• Deliver finished media files to an output storage location

Many other actions are provided in the Vantage Workflow Designer. You can create and 
save many different workflows in a Vantage domain, and you can use them over and 
over with different files. Automation features allow you to initiate workflow processing 
whenever a new file appears in a hot folder. For more information on the available 
actions and workflow design, see the Vantage User’s Guide.

Vantage workflows are stored in the Vantage domain database, which is the control 
center of a Vantage domain. All configuration for the domain is stored in the Vantage 
domain database, as are statistics and status information about the workflows 
processed by the domain. Vantage domain administrators configure Vantage using the 
Vantage Management Console.

Working with the Vantage domain database, Vantage services execute workflow 
actions in a Vantage domain. Each service executes specific action types. For example, 
the Transcode service executes the Flip workflow action, which transcodes an input 
media file. 
Vantage Domain Management Guide
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The input and output storage locations shown in Figure 1 are not Vantage components, 
although they can reside on Vantage servers. When Vantage workflows contain actions 
to access input files or publish output files, these actions must access available storage 
locations. These storage locations can be folders that reside on a network server or 
workstation, a Network-Attached Server (NAS), or a Storage Area Network (SAN).

The Vantage store is a storage location that stores temporary files that are created 
during workflow processing, and it can store output files. Typically, temporary files are 
deleted after a job expires or is deleted, however, Vantage controls allow you to change 
this to retain files for a period of time or indefinitely.

Vantage Domain Configurations
While Vantage supports many different physical configurations, there are two primary 
domain configurations, the all-in-one domain and the distributed domain.

An all-in-one domain is a Vantage domain in which all the basic Vantage components 
shown in Figure 1 are installed on a single server. An all-in-one domain is simpler to 
install and manage, but it has performance limitations which are described in Before 
You Install.

A distributed domain is one in which the basic Vantage components are distributed 
among multiple servers. For example, you might install the Vantage domain database 
on one server, and install all Vantage services on each of two additional servers. This 
three-server Vantage domain separates database processing from Vantage service 
processing, which increases processing capacity for both the Vantage database and the 
Vantage services. Having Vantage services on two servers also increases capacity and 
supports load-balancing, which leads to better throughput, and redundancy, which 
enables failover protection for the Vantage domain.

Vantage Programs
Vantage programs allow you to manage the components in the Vantage domain. 
Table 3 lists the Vantage programs according to the Vantage management area they 
serve and the type of program.

Table 3. Vantage Programs

Management Area

Program Type

Client Applications Web Applications

Workflow Management Vantage Workflow 
Designer

Vantage Workflow Portal

Vantage Job Status Views

Vantage Workflow Portal

Domain Management Vantage Management 
Console

Vantage Dashboard
Vantage Domain Management Guide
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From a management point of view, each Vantage program can be classified as a 
workflow management program or a domain management program. Workflow 
management programs allow you to design workflows, evaluate and forward the 
results of a workflow, and track the status of workflows. Domain management 
programs allow you to configure the Vantage domain, view status and statistics for the 
domain, and control domain operation.

Each Vantage program can also be classified by application type, which is either as a 
client program or a Web application. Client programs run on Microsoft Windows 
servers and workstations. Web applications are hosted by a Microsoft Internet 
Information Services (IIS 7) server and can be accessed from any computer with a 
compatible browser and a network or Internet connection to the IIS 7 server hosting 
the Web applications.

Figure 2 shows how the additional Vantage programs not shown in Figure 1 fit into a 
Vantage domain.

Figure 2. Simplified View of Vantage Domain, Showing All Vantage Programs
Vantage Domain Management Guide
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The following topics introduce each of the Vantage programs:

 Vantage Workflow Designer

 Vantage Workflow Portal Client Application

 Vantage Workflow Portal Web Application

 Vantage Job Status Views

 Vantage Management Console

 Vantage Web Dashboard

Vantage Workflow Designer
Vantage Workflow Designer enables you to design and automate workflows to meet 
your organization's transcoding and workflow automation requirements. With Vantage 
Workflow Designer, you can design workflows that do the following:

• Detect media files and related files that are ready for processing

• Evaluate the contents of source media files and set variables that describe those 
contents

• Create actions that choose different workflow branches based on variable values

• Generate email and system messages in response to workflow events

• Incorporate related metadata content files or add metadata to the workflow or final 
output

• Transcode media files to other formats, including new package formats such as 
Apple HLS and Adobe HDS

• Save media output files and delete source files

• Combine any or all of the above features in hundreds of possible workflows

A typical workflow design session requires that you pick the actions you want to take, 
configure the sequence and settings of those actions, and then activate the workflow. 
When you activate the workflow, the Vantage domain database and Vantage services 
work together to process any source material that is submitted to the workflow. Each 
time source material is submitted, a Vantage job is started. A job represents a single 
instance of a workflow. If 10 unrelated media files are submitted to a workflow, 10 jobs 
are started.

Vantage Workflow Designer also includes tools that allow you to monitor the status of 
workflows and jobs in the domain.

For more information on the Vantage Workflow Designer, see the Vantage User’s Guide.
Vantage Domain Management Guide
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Vantage Workflow Portal Client Application
Vantage Workflow Portal allows workflow operators to manage jobs. Workflow 
designers create the workflows, and workflow operators use Vantage Workflow Portal 
to do some or all of the following:

• Submit media files to workflows

• Review media processed by workflows

• Attach metadata to media for workflow submission

• Stitch multiple files together

• View metadata labels generated by a workflow

• Make changes to metadata labels and variables in preparation for submission to a 
target workflow

Vantage Workflow Portal cannot operate until it is installed on a Windows server or 
workstation and configured within Vantage using the Vantage Management Console. 
To view media in Vantage Workflow Portal, you must also create a workflow to 
preprocess the media. For information on configuring support for Vantage Workflow 
Portal, see Configuring Workflow Portal Operation.

For information on using the Vantage Workflow Portal, see the Vantage User’s Guide.

Vantage Workflow Portal Web Application
The Vantage Workflow Portal Web application is a Web version of the Workflow Portal 
Windows program. For information on using the Vantage Workflow Portal Web 
application, see the Vantage User’s Guide.

Vantage Job Status Views
Vantage Job Status Views is a Web application that provides Vantage operators and 
managers with job status information. Using the Vantage Management Console, 
Vantage administrators can configure custom views, which define what information an 
operator sees when opening a view. When there is a large volume of jobs or when 
security policies dictate, you might want to create custom views for individual 
operators or departments.

For information on configuring support for Vantage Job Status Views, see Job Status 
Views.

For information on using the Vantage Job Status Views, see the Vantage User’s Guide.
Vantage Domain Management Guide
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Vantage Management Console
The Vantage Management Console enables you to configure and manage a Vantage 
domain. The following is a partial list of Vantage features that you can control with 
Vantage Management Console:

• Vantage stores

• Vantage users

• Vantage licenses

• Load balancing

• Vantage services

• Import and export of Vantage configuration components, such as workflows

• Vantage Job Status Views

• Vantage Workflow Portal

• Vantage domain database backup and restore

Vantage Management Console also allows you to view some domain status 
information.

Most of the features that you can configure are described in Using the Vantage 
Management Console. Some features, such as support for Vantage Workflow Portal are 
described in other chapters of the Vantage Domain Management Guide.

Vantage Web Dashboard
Vantage Dashboard is designed to help domain administrators track the status and 
system health for the entire Vantage domain, as opposed to other tools which enable 
management of domain components.

The Vantage Dashboard pages are designed to help you quickly assess the health of the 
domain and progressively dig into deeper detail as needed. For example, the Summary 
Status page allows you to quickly see the workflow completion success rate and the 
error rate on domain servers. The information on the Summary Status page can help 
you determine if it is more appropriate to look for problems in a workflow or in a 
particular server.

Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

For information on using Vantage Dashboard, see Monitoring the Domain with Vantage 
Dashboard.
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Vantage Licenses
Vantage licenses enable specific features or feature sets in Vantage programs. All 
Vantage software is available on the Telestream web site. Vantage licenses allow you to 
download and install Vantage software at your convenience and purchase only those 
features that you need. If you need additional features later, you can purchase an add-
on license. Each license is distributed in an XML file, and features may be bundled so 
that a single license file enables multiple features.

The following topics introduce the licenses available when this guide was created:

 Transcoding Licenses

 Feature-Specific Licenses

 Vantage Workflow Portal

 Vantage Array

 Vantage Team Management

 Vantage Enterprise Control

 Master Control

Transcoding Licenses
The transcoding licenses enable specific encoders and packagers. The following are the 
transcoding license configurations:

• Vantage Transcode

• Vantage Transcode Pro

• Vantage Transcode Connect

• Vantage Transcode Pro Connect

• Vantage Transcode Multiscreen (requires Lightspeed server)

• Vantage Transcode Multiscreen Pro (requires Lightspeed server)

For information on which encoders and packagers are provided with each license, refer 
to the Telestream web site: http://www.telestream.net/telestream-support/vantage/
support.htm

Workflow Licenses
The workflow licenses enable various features specific to automating media workflows:

• Vantage Analysis

• Advanced Avid Integration (requires Transcode Pro Connect)

• Screen MediaMate Integration (various models are available)

• Civolution Integration

• GraphicsFactory
Vantage Domain Management Guide

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm


Domain Management Overview
Vantage Licenses

27
Feature-Specific Licenses
Feature-specific licenses add support for one or more features to an existing Vantage 
domain. Vantage supports the following feature-specific licenses:

• Lightspeed Acceleration (comes with Lightspeed Server)

• SpectreView Windows Media Plug-In with Sequencing for Vantage Transcoding

• Dolby E Decode Option for Vantage Transcoding

• Nielsen Watermarking Option

• Screen Open Subtitling Option

Vantage Workflow Portal
The Vantage Workflow Portal requires a license for each operator that will 
simultaneously use the program. For example, if three operators will use the program, 
but only two operators are expected to use the program simultaneously, you need two 
licenses.

Vantage Array
The Vantage Array license allows you to install Vantage services on multiple Windows 
servers, increasing the capacity and reliability of your Vantage domain. Vantage Array 
features include the following:

• Redundancy. Multiple Vantage array servers can host the same service, increasing 
the processing capacity of the Vantage domain.

• Session-based load balancing. When a Vantage service is enabled on multiple Van-
tage array servers, individual workflow actions can be executed by any Vantage 
array server that is configured for the supporting service. Action execution is sched-
uled based on CPU availability and priority.

• Priority acceleration for transcoding actions. Vantage array servers can pause lower 
priority actions, execute the higher priority action, and then resume the lower pri-
ority action.

• N+1 failover protection. Vantage array servers communicate with each other and 
can redistribute the workload if a Vantage array server fails. If a job fails to complete 
due to a Vantage array server failure, another Vantage array server restarts the job.

• Support for mirrored Microsoft SQL databases to provide redundancy and failover 
protection for the Vantage domain database.

If the current domain is an all-in-one domain, the activation of a Vantage Array license 
changes the configuration to a distributed domain. In a distributed domain using the 
Vantage Array license, every Vantage server becomes a Vantage array server and 
requires the Vantage Array license.

If the current domain is an all-in-one domain, the activation of a Vantage Array license 
changes the role of the Vantage server to a Vantage array server, and you can create a 
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distributed domain by adding Vantage array servers. In a distributed domain using the 
Vantage Array license, every Vantage server becomes a Vantage array server and 
requires the Vantage Array license.

In this guide, features that require the Vantage Array license are flagged with the 
following icon:

Vantage Team Management
The Vantage Team Management license adds support for Vantage user access control 
to the following:

• Vantage Workflow Designer

• Vantage Management Console

• Vantage Workflow Portal

• Vantage Job Status Views

This license also enables the use of the Vantage Job Status Views program.

In this guide, features that require the Vantage Team Management license are flagged 
with the following icon:

Vantage Enterprise Control
As with the Vantage Array license, the Vantage Enterprise Control license allows you to 
install Vantage services on multiple Windows servers. The Vantage Enterprise Control 
features include the following:

• All Vantage Team Management features.

• All Vantage Array features

• Cost-based load balancing. When a Vantage service is enabled on multiple Vantage 
array servers, individual workflow actions can be executed by any Vantage array 
server that is configured for the supporting service. Action execution is scheduled 
based on a configurable action cost, a configurable target cost for each array server, 
CPU availability, and priority.

• Workflow analytics that display a visualization of real-time and historical workflows. 
This provides bottleneck analysis, workflow optimization, and the tracking of batch 
jobs through the overall process.

If the current domain is an all-in-one domain, the activation of a Vantage Enterprise 
Control license changes the role of the Vantage server to a Vantage array server, and 
you can create a distributed domain by adding Vantage array servers. In a distributed 
domain using the Vantage Enterprise Control license, every Vantage server becomes a 
Vantage array server and requires the Vantage Enterprise Control license.
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In this guide, features that require the Vantage Enterprise Control license are flagged 
with the following icon:

 

Master Control
As with the Vantage Array and Vantage Enterprise Control licenses, the Vantage Master 
Control license allows you to install Vantage services on multiple Windows servers. The 
Vantage Master Control features include the following:

• All Vantage Team Management features.

• All Vantage Array features.

• All Vantage Enterprise Control features.

• Vantage Dashboard program.

• Historical reporting, including external notification of key system statistics, and a 
user-configurable job history reporting system that allows report generation for 
billing, system utilization, and capacity planning.

• Agility 2G integration.

If the current domain is an all-in-one domain, the activation of a Vantage Master 
Control license changes the role of the Vantage server to a Vantage array server, and 
you can create a distributed domain by adding Vantage array servers. In a distributed 
domain using the Vantage Master Control license, every Vantage server becomes a 
Vantage array server and requires the Vantage Master Control license.

In this guide, features that require the Vantage Master Control license are flagged with 
the following icon:

Topics in this Guide
The following topics introduce the major topics in this guide:

• The Before You Install topic discusses Vantage requirements that should be 
addressed before you install your domain. This topic discusses hardware, operating 
system, software, and network requirements, as well as guidelines for planning 
your installation. Your Vantage domain installation will proceed more efficiently if 
you familiarize yourself with all the content in this topic.

• The Installing and Upgrading Vantage topic discusses how to install all-in-one 
domains and Vantage distributed domains, and how to install additional applica-
tions such as the Vantage client programs, Vantage Web applications, and Vantage 
Workflow Portal. Additional topics describe how to upgrade Vantage and how to 
move a Vantage domain database.

• The Using the Vantage Management Console topic discusses how to use the Vantage 
Management Console to configure and manage one or more Vantage domains.
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• The Configuring Workflow Portal Operation topic discusses how to use the Vantage 
Management Console to configure support for the Vantage Workflow Portal client. 
The Vantage Workflow Portal client is a separate program that requires a separate 
installation and a license option (which can be part of a package license). Before 
Vantage operators can use the Vantage Workflow Portal, the Vantage administrator 
must configure support as described in this topic.

• The Monitoring the Domain with Vantage Dashboard topic discusses how to use the 
Vantage Dashboard web application to view domain status at the domain, server, 
service, and job levels. This topic also describes how to use Vantage Dashboard 
controls to do tasks such as take services and servers offline, reset statistics coun-
ters, stop jobs, and change action priority.

• The Removing Vantage Software topic discusses how to uninstall Vantage products 
from servers and workstations, and how to remove the database and database files.

• The Glossary topic defines terms used in Vantage product documentation.
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Before You Install
Use this topic to understand the hardware, software, database, and network 
requirements before performing an installation. You’ll also learn about Vantage 
installers, how to obtain a Vantage license, and some distributed Vantage domain 
planning advice – this topic is about what you need to know before you install a 
Vantage domain.

Installing Vantage is easiest when you plan carefully, and you have a working 
knowledge of Windows server administration, networking, Microsoft SQL Server, and 
installation and configuration of enterprise-level software. Consult your IT group for 
assistance as necessary.

Note: Go to 
www.telestream.net/telestream-support/vantage/support.htm to browse the 
Vantage Web library, user’s guides, patches, app notes, and other documents.

The following topics provide information you should consider when planning a 
Vantage installation:

 Server Hardware Requirements

 Operating System Requirements

 Third-Party Software Requirements

 Network Requirements

 Database Selection and Configuration Guidelines

 Vantage Installers Overview

 Licensing Overview

 Planning for a Vantage Distributed Domain Installation
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Server Hardware Requirements
Vantage is optimized for dual quad-core Intel and Intel-compatible processors that 
support Windows operating systems. The following sections provide more information 
on Vantage server hardware requirements:

 Vantage Server Requirements

 Database Server Requirements for SQL Standard

 Disk Space Requirements

Note: Vantage Transcode Multiscreen requires the use of the Lightspeed Server, a 
high-density Windows server from Telestream that includes multiple GPUs and 
acceleration software. Transcode Multiscreen will not operate on generic Windows 
hardware.

Vantage Server Requirements
Vantage server requirements depend on which domain components (services, media 
files, and database) are installed on the server, as well as how much media you plan to 
store on the server. Table 4 lists the hardware requirements for servers that host 
Vantage and SQL Express database services.

Table 4. Vantage Server Hardware Requirements

Hardware Requirements

Processor Dual quad-core processors, 4MB cache recommended. 64-bit 
processor computers should be used for running Windows 
Server 2003 R2 or Windows Server 2008 R1 or R2 for best 
performance.

RAM At least 4GB RAM recommended, depending on the number of 
concurrent translation sessions desired. More than 4GB is 
recommended when running a 64-bit operating system.
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Database Server Requirements for SQL Standard
Telestream recommends using a dedicated database server for high-traffic distributed 
domains that use SQL Standard. The requirements for SQL Standard are different from 
those for SQL Express. Table 5 lists the hardware requirements for servers that host SQL 
Standard.

Note: The computer name of the server hosting the principal Vantage domain 
database is used as the Vantage domain name. Telestream recommends providing a 
computer name that is appropriate to your Vantage installation. For example: Vantage 
or Vantage_DB.

Disk space All-in-one installations: 500 GB; approximately 100 MB for 
Vantage services and clients, approximately 500 MB for the 
Transcode and Analysis Engine, and approximately 400 GB for 
the Vantage store media and database. The initial database size 
is approximately 100 MB.

For more information, see Disk Space Requirements.

Ethernet/Fibre All-in-one installations: Gigabit Ethernet (GbE / 1 GigE) 
minimum. (Dual Ethernet may be needed in some situations). 

Distributed domains: Gigabit Ethernet (GbE / 1 GigE) minimum. 
Recommend dual bonded Ethernet or 10GigE. The Vantage 
domain database and all Vantage services should be on the 
same subnet.

Numeric Processing 
Instruction Set

 MMX, SSE, and SSE2 enabled.

Table 4. Vantage Server Hardware Requirements (Continued)

Hardware Requirements
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Note: Vantage may have difficulty decoding MPEG2 or H.264 video when running on 
a server with more than 32 cores (or 16 hyperthreaded cores). This does not include 
certain MOV wrapped H.264 files. Symptom: the job hangs at 0 percent.
To solve this problem, host the Transcode service on servers with 32 cores or less, or 
turn off hyper-threading in the BIOS.

Note: Telestream recommends utilizing a Gigabit Ethernet or Fibre-Channel for 
connecting Vantage servers and connecting to media stores to improve performance.

For more guidelines on database installation in a Vantage domain, see Database 
Selection and Configuration Guidelines.

Disk Space Requirements
A Vantage domain requires disk space for the following:

• Vantage services

• Vantage domain database

• Vantage input and output files

Table 5. Database Server Recommendations (With or Without Vantage)

Configuration Recommendations

Processor Dual quad-core processors, 4MB cache recommended. 
64-bit processor computers should be used for running 
Windows Server 2003 R2 or Windows Server 2008 R1 or 
R2 for best performance.

RAM • Recommended: minimum 8 GB RAM
• Preferred: 32 GB RAM

Disk space All-in-one installations: 30 GB

Distributed domain database servers:

• Minimum 300 GB drive space for the database.
• Recommend: 2 physical hard drives or RAID arrays, one 

for the OS, and one for SQL and the database files.

For more information, see Disk Space Requirements.

Ethernet/Fibre Gigabit Ethernet (GbE / 1 GigE) minimum. Recommend 
dual bonded Ethernet or 10GigE. The Vantage domain 
database and all Vantage services should be on the same 
subnet.

Numeric Processing 
Instruction Set

 MMX, SSE, and SSE2 enabled.
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Compared to the storage needs for the database and input and output files, the 
Vantage services and clients require relatively little disk space (approximately 100 MB). 
The disk space requirements for a Vantage domain database are listed in Table 4 and 
Table 5, and additional database guidelines are provided in Database Selection and 
Configuration Guidelines.

The disk space required for the input and output files depends on the size of the files 
and how long the files are stored. In a Vantage store, files related to a specific job are 
deleted when the job expires or the job is deleted by a user. 

For all-in-one installations, the disk space requirements listed in Table 4 should be 
sufficient for all Vantage services, client applications, the database, and the input and 
output files. However, it is a good practice to monitor disk usage after installation and 
at periodic intervals to determine if the available disk space is appropriate.

For distributed domains, some form of centralized storage must be used for media files. 
The centralized storage, which might be a SAN, a NAS, or a network share, is required so 
that all Vantage services and clients can access the files. To determine the storage 
needed for input and output files, evaluate the expected media file size and storage 
duration, and add sufficient disk space. The recommended disk space listed in Table 5 is 
for the database only; media file storage is not included. If media files are added to the 
database server, they should be stored on a different drive than the database to 
prevent resource contention.

Operating System Requirements
The following topics describe the operating system requirements for Vantage 
components:

 Vantage Web Applications

 Vantage Client Software

 Vantage Services

Vantage Web Applications
Vantage Web applications should be installed on an IIS server running on the same 
subnet as the Vantage domain database, so that the Web applications can auto-
discover the Vantage domain. To improve the performance of Vantage Web 
Applications and Vantage services, place the Vantage Web applications on a dedicated 
server, separate from the Vantage domain database and Vantage services. The 
following list ranks the possible Vantage Web Application configurations from most 
preferred (#1) to least preferred:

1. Dedicated Vantage Web Application server.

2. Vantage Web Applications installed on a Vantage domain database server that 
does not host Vantage services.

3. Vantage Web Applications installed with the Vantage domain database and 
Vantage services on the same server (includes all-in-one domains).
Vantage Domain Management Guide



Before You Install
Operating System Requirements

36
Vantage Web applications should only be installed and operated on the following 32-
bit or 64-bit operating systems:

• Windows Server 2008 R1 (32-bit|64-bit) + IIS 7 + .NET Framework 4.0

• Windows Server 2008 R2 (64-bit only) + IIS 7 + .NET Framework 4.0

IIS must be installed with ASP.NET and IIS 6 Management Capability installed.

Note: For information on Vantage Web application browser requirements, see 
Vantage Web Applications Browser Requirements.

Vantage Client Software
Vantage client programs (Vantage Management Console, Workflow Designer, and 
Workflow Portal) may be installed and run directly on a Vantage server, or on client 
workstations.

Note: Telestream recommends installing Vantage client programs only on user’s 
workstations (not directly on Vantage servers) when there are three or more Vantage 
servers and over 500 jobs routinely in the Vantage domain database.

Vantage client programs are supported on the following operating systems:

• Windows Vista

• Windows 7

• Windows Server 2003 R2

• Windows Server 2008 R1 and R2

• Windows XP Pro

Note: To effectively operate Vantage services and their client programs in a 
distributed domain, and with other networked devices or systems, you must disable 
the Windows Firewall.
All operating systems must be upgraded with the latest service packs and security 
updates from Microsoft.
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Vantage Services
Vantage services should only be installed and operated on the following 32-bit or 64-
bit operating systems (64-bit recommended for performance):

• Windows Server 2008 R2 (64-bit only)

• Windows Server 2008 R1 (32-bit | 64-bit)

• Windows Server 2003 R2 (32-bit | 64-bit)

• Windows XP with SP3 (32-bit, all-in-one installations only)

• Windows XP with SP2 (64-bit, all-in-one installations only)

All-in-one installations can be installed on Windows XP Pro. However, the Vantage 
Enterprise system management products are not supported on XP Pro.

The following sections describe additional Vantage service operating system 
requirements:

 Windows XP Pro Requirements

 Windows Server 2003 Requirements

 Windows Server 2008 Requirements

Windows XP Pro Requirements
The following sections describe additional Vantage requirements for the Windows XP 
Pro operating system:

 Use Windows Installer 4.5

 Supporting Windows Media Advanced Profile Codec

Use Windows Installer 4.5

Windows servers hosting a Vantage domain database must be updated with Windows 
Installer 4.5, the application installation and configuration service for Windows, before 
installing the Vantage domain database. To obtain the installer, go to Microsoft’s 
Download Center Windows Installer 4.5 page. Review the requirements, download the 
appropriate installer, and install it on your server(s) before continuing.

Supporting Windows Media Advanced Profile Codec

If you plan to use the Windows Media Advanced Profile codec on Windows XP Pro, 
install Windows Media Player 11 from Microsoft. Windows XP Pro does not include the 
Windows Media Video V9 Advanced Profile (VC1 Advanced Profile) codec, which is 
included in Windows Media Player 11.

If you install Windows Media Player 11 and Vantage is already installed, restart the 
Vantage server after installation.
Vantage Domain Management Guide

http://www.microsoft.com/download/en/details.aspx?id=8483


Before You Install
Operating System Requirements

38
Windows Server 2003 Requirements
The following sections describe additional Vantage requirements for the Windows 
Server 2003 operating system:

 Use Windows Installer 4.5

 Supporting Windows Media Advanced Profile Codec

Use Windows Installer 4.5

Windows servers hosting a Vantage domain database must be updated with Windows 
Installer 4.5, the application installation and configuration service for Windows, before 
installing the Vantage domain database. To obtain the installer, go to Microsoft’s 
Download Center Windows Installer 4.5 page. Review the requirements, download the 
appropriate installer, and install it on your server(s) before continuing.

Supporting Windows Media Advanced Profile Codec

If you plan to use the Windows Media Advanced Profile codec on Windows Server 2003, 
install Windows Media Player 11 from Microsoft. Windows Server 2003 does not include 
the Windows Media Video V9 Advanced Profile (VC1 Advanced Profile) codec, which is 
included in Windows Media Player 11.

If you install Windows Media Player 11 and Vantage is already installed, restart the 
Vantage server after installation.

Windows Server 2008 Requirements
The following sections describe additional Vantage requirements for the Windows 
Server 2008 operating system:

 Use Windows Installer 4.5

 Install the Desktop Experience

 Understand User Account Control Admin Approval Mode

 Enable Computer Browser Service

Use Windows Installer 4.5

Windows servers hosting a Vantage domain database must be updated with Windows 
Installer 4.5, the application installation and configuration service for Windows, before 
installing the Vantage domain database. To obtain the installer, go to Microsoft’s 
Download Center Windows Installer 4.5 page. Review the requirements, download the 
appropriate installer, and install it on your server(s) before continuing.

Install the Desktop Experience

Prior to installing Vantage, the Desktop Experience must be installed. Follow these 
steps.

1. Click Start > Administrative Tools > Server Manager.

2. In the console tree, click Features, then click Add Features.

3. Check Desktop Experience and click Next.
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4. Follow the steps to complete Desktop Experience installation.

5. When installation is complete, restart the server when prompted to do so.

Understand User Account Control Admin Approval Mode

If User Account Control: Run all administrators in Admin Approval Mode is enabled, run 
installers by right-clicking the installer and selecting Run as Administrator. If this feature 
is disabled, you can run the installer normally. 

To verify the setting value (Enabled | Disabled):

1. Display the command window (Start > Command Prompt).

2. In the command window, type secpol.msc and press Enter.

3. In the Local Security Policy window, select Local Policies > Security Options. In the 
Policy column, find User Account Control: Run all administrators in Admin Approval 
Mode and view the Security Setting.

Enable Computer Browser Service

Although set by default on the standard distribution of Server 2008, ensure that the 
Computer Browser service is enabled by doing the following:

1. In Windows, display the Services Control Panel.

2. If the Computer Browser service is set to disabled, right-click and open the 
Properties window.

3. On the General tab > Startup type, select Automatic and click OK.

4. Start the service.

Third-Party Software Requirements
The following sections describe Vantage software requirements and recommendations 
for third-party products:

 QuickTime Requirements

 .NET Framework Requirements

 Anti-Virus Software Recommendations

CAUTION: If you do not install/upgrade all required software, Vantage may not 
operate correctly.

QuickTime Requirements
The Telestream Media Transcode and Analysis engine requires QuickTime if you plan to 
transcode QuickTime files. Obtain the QuickTime installer or download it from 
www.apple.com/quicktime/win.html. Click Free Download to download and install it.

Vantage includes Telestream Media Transcode and Analysis engine version 2012.1, 
which is qualified with QuickTime version 7.6.9.
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Note: If you do not install the Telestream Media Transcode and Analysis engine 
version that is supplied with the Vantage installer, be sure to install the QuickTime 
version that is recommended for the version you are installing.
The Vantage Setup installer checks for QuickTime. If it isn’t installed in the default 
directory, the installer alerts you that QuickTime is not installed or up to date.
After installation, be sure to uncheck Check for Updates, so that this version is not 
updated without your knowledge, then restart the server.
If you do not install the correct QuickTime version, encoding some formats causes this 
error: “An error occurred during execution of the Transcode Task: RenderSession 
Configuration Error, message: Requested encoder | decoder not installed.”

.NET Framework Requirements
Vantage requires .NET Framework 3.5 Service Pack 1 on all servers that host the Vantage 
domain database, Vantage services, or Vantage client programs. All workstations that 
run Vantage client programs must also run .NET Framework 3.5 Service Pack 1.

Vantage Web applications require .NET Framework 4 on the IIS server.

Note: Microsoft .NET Framework 3.5 Service Pack 1 and .NET Framework 4 provide 
different services and can both be installed on the same server. Microsoft .NET 
Framework 4 does not provide all the services provided in .NET Framework 3.5 Service 
Pack 1, so you must install both applications on Vantage servers that support Vantage 
Web applications.

Install the .NET Framework as follows:

• For Windows Server 2008 R2, install .NET 3.5 SP1 directly from Server Manager > 
Features.

• For Windows XP, Server 2003 and 2008 R1, download .NET 3.5.1 from Microsoft and 
install it.

• To install .NET 4.0, download .NET 4.0 from Microsoft and install it.

Anti-Virus Software Recommendations
Telestream recommends that you do not use anti-virus software on Vantage servers. 
You should not enable real-time scanning. If you do use anti-virus software, you should 
identify Vantage as a safe or trusted application. Telestream recommends that you 
disable real-time file scanning, because it will impact performance and potentially lock 
files being processed, impacting Vantage’s ability to operate properly.

Note: Be sure to turn off anti-virus software during Vantage installation or install the 
anti-virus software after you install Vantage.
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Network Requirements
The following sections provide information on Vantage network requirements and 
guidelines:

 IP Address Requirements

 Port Requirements

 Firewall Guidelines

 Windows Authentication Guidelines

 Time Synchronization Guidelines

IP Address Requirements
Telestream recommends using static IP addresses for all machines within a Vantage 
domain. This is especially important when the network does not have a DNS server.

In a distributed domain installation, Telestream recommends that you install the 
Vantage domain database, Vantage services, and client programs in the same subnet to 
avoid communication bottlenecks. Within Vantage client and web applications, the 
service discovery feature automatically discovers all Vantage domains within a subnet. 
If you must access a Vantage domain from outside the subnet that hosts the Vantage 
domain database, you can use a DNS host name or IP address to specify the domain.

Port Requirements
Vantage uses the ports (default) listed in Table 6, which must be available to Vantage 
services and client programs hosted on the computer.

Note: The ports utilized by third-party products are obviously beyond control of 
Telestream; they change over time, and some are user or runtime configurable. Please 
contact the product’s vendor for additional port usage details.

Table 6. Ports Used in a Vantage Domain

Service Ports

FTP FTP: 21

HTTP HTTP port: 80

Mail Mail: 25

Vantage Agility service HTTP: 8678, TCP: 8679

Vantage Analysis service HTTP: 8672, TCP: 8673

Vantage Catalog service HTTP: 8664, TCP: 8665

Vantage Communicate service HTTP: 8662, TCP: 8663
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Firewall Guidelines
Telestream recommends that you disable the Windows Firewall on all computers that 
will communicate with or support Vantage services. The default Windows Firewall 
configuration will block access to a Vantage server from other Vantage components, 
such as other Vantage servers or workstations running Vantage client software.

If you must run a firewall, keep in mind that Vantage communicates with the following 
systems/component ports, which should be considered when configuring firewall 
settings:

• Vantage system ports listed in Port Requirements.

• Microsoft Distributed Transaction Coordinator (DTC)

User configurable; default port: 3372 when TIP is enabled. See Microsoft documen-
tation for details.

• Microsoft SQL Server

TCP port: 1433, UDP port: 1434—see Microsoft documentation for details.

• Avid Interplay (Unity Client, Transfer Engine, Web Services)

Discovery: UDP port 8321. For other ports, see Avid documents including Interplay 
Admin Guide and Avid Interplay Software Installation and Configuration Guide.

• Agility ECS

Port numbers as configured in the Vantage Management Console and in Agility 
ECS.

• FTP

Port number as configured in the Vantage workflow.

• Grass Valley AMP

Port 3811 by default.

Vantage Metadata service HTTP: 8674, TCP: 8675

Vantage Monitor service HTTP: 8658, TCP: 8659

Vantage Multiscreen service HTTP: 8682, TCP: 8683

Vantage SDK service HTTP: 8676, TCP: 8677

Vantage Staging service HTTP: 8686, TCP: 8687

Vantage Transcode service HTTP: 8670, TCP: 8671

Vantage Transport service HTTP: 8660, TCP: 8661

WS-Discovery UDP port: 3702, TCP port: 46123

Table 6. Ports Used in a Vantage Domain (Continued)

Service Ports
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Windows Authentication Guidelines
By default, Vantage services use the Windows Local System account when accessing file 
space for media storage and delivery. When all Vantage services, clients, and delivery 
targets are on one server, the default configuration works well. When any Vantage 
service, client, or delivery target is on another computer, Windows authentication 
requirements must be met to enable communication between multiple computers.

The following sections provide additional authentication guidelines:

 About Vantage Windows Authentication

 Configuration Guidelines the Vantage Windows User Account

 Configuring Folders for Vantage Access

About Vantage Windows Authentication
A Vantage domain requires authentication planning when workflows require Vantage 
to ingest media from or send media to another computer. For remote file access, use 
the following guidelines:

• Configure each Vantage service that accesses files on another server to use a Win-
dows log on ID and password. For example: VantageWinUser.

• Configure each remote storage folder to support access from the log on ID for Van-
tage services.

• If the same service operates on multiple Vantage servers, and requires access to 
files at a remote location, configure the same log on ID and password for all 
instances of that service. 

For example, if the Transcode service is running on three servers, it operates as one 
Transcode service with three instances or nodes. Vantage requires that every Van-
tage node within a service use the same log on ID. 

Note: When a service is comprised of multiple nodes, the Local System account, 
which is the default log on ID for all-in-one installations, cannot be used because it 
represents a different user on each system.

Configuration Guidelines the Vantage Windows User Account
To support Vantage service access to other Vantage servers and file folders on other 
computers, Telestream recommends that you create a Vantage user account within the 
Windows domain or workgroup. To distinguish the Vantage Windows user account 
from regular Vantage user accounts, use a name that indicates that this is a Windows 
user account. For example, VantageWinUser. 
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Your Windows domain or workgroup administrator can configure the Vantage 
Windows user account before Vantage installation. When configuring this account, 
consider the following guidelines:

• The Vantage Windows user account should be added to the local administrator 
group on each server so that Vantage has the proper authority to run Vantage ser-
vices and install Vantage software.

• The Vantage Windows user account must be authorized to log on as a service (see 
your Windows domain or workgroup administrator), so that Vantage services can 
log on as the Vantage Windows user on each Vantage server.

• The Vantage Windows user account should have appropriate read and write per-
mission to network locations that Vantage will access. These network locations 
include the Vantage store and input and output storage locations.

• You can use the Vantage Windows user account to install the Vantage software.

For instructions on configuring services to use the Vantage Windows user account, see 
Setting the Vantage Windows Log On ID for a Service.

Configuring Folders for Vantage Access
Vantage servers and clients may need access to folders on other computers for any of 
the following:

• Input of files in Watch folders

• Manual submission of input files

• Storage of output files for future Vantage use

• Delivery of output files to remote destination folders

The following sections describe how to configure folders for Vantage use:

 Configuring Folder Access Within the Windows Domain or Workgroup

 Configuring Folder Access Outside of the Windows Domain or Workgroup

 Configuring Access to a SAN System

Note: Vantage cannot access network locations defined using a Windows mapped 
drive. You must use a UNC path to define network locations for Vantage use.

Configuring Folder Access Within the Windows Domain or Workgroup

If you create a Vantage Windows user account as described Configuration Guidelines the 
Vantage Windows User Account, granting Vantage access to any folder within the 
domain is as simple as granting access to the Vantage Windows user. If Vantage 
workflow designers, operators, or administrators also need access, grant folder access 
to their Windows user names.

Configuring Folder Access Outside of the Windows Domain or Workgroup

When Vantage needs to access computers in a different Windows domain or 
workgroup, the Windows log on ID from the current domain or workgroup is not 
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accepted. To support Vantage service access, you can configure a Vantage 
authorization record as described in Authorization Settings.

Configuring Access to a SAN System

When you want to access files in a SAN system, be aware that some systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. Although Vantage cannot reference a Windows mapped drive, you can 
reference SAN drives via a drive letter, provided that each Vantage server is a client of 
the SAN and that all mount points use the same letter.

Time Synchronization Guidelines
When a Vantage domain includes multiple servers and workstations, you should verify 
that all the computers are set to the same regional settings and the correct time zone. 
Otherwise, the timestamps associated with Vantage events may display incorrectly and 
time-driven events might not occur on schedule. When checking the time 
configuration in the Vantage domain, be sure to check the configuration on the 
following:

• All servers with Vantage services

• All Vantage domain database servers

• All Vantage web hosts

• All file servers that support Vantage stores and folders

• All workstations that run Vantage Workflow Designer, Vantage Workflow Portal, and 
Vantage Management Console

Network time protocols on your network should keep the time within tolerances, as 
long as you correctly configure the following:

• The time zone for each server or workstation should be correct for the respective 
time zone.

• Any adjustment for daylight savings time should be consistent on all servers and 
workstations within the same time zone.

Database Selection and Configuration Guidelines
Vantage is supported on the following database systems:

• Microsoft SQL Server 2008 R1 SP2 Express

• Microsoft SQL Server 2008 R1 SP2 Standard

• Microsoft SQL Server 2008 R2 Standard

Note: Microsoft SQL Server 2005 SP3 Standard is supported only for Vantage 3.0 
systems which are upgraded, not for new Vantage 4.0 installations.
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Telestream recommends the following database installation configurations:

• All-in-one domain with SQL Server 2008 R1 SP2 Express

• All-in-one domain with SQL Server 2008 R2 Standard

• Distributed domain with SQL Server 2008 R2 Standard

If your Vantage installation requires an all-in-one domain, you can choose between SQL 
Express and SQL Standard. If your installation requires a distributed domain, Telestream 
recommends SQL Standard. The following sections provide guidelines for choosing a 
database and for implementing a database:

 Guidelines for Selecting SQL Express or SQL Standard

 Guidelines for an All-In-One Installation with SQL Express

 Guidelines for an All-In-One Installation with SQL Standard

 Guidelines for a Distributed Domain Installation with SQL Standard

 Tips for Improving Performance on Non-Dedicated Servers

 Improving Availability with Mirroring

Note: You cannot use database utility programs to move a Vantage domain database 
of one version to a later version of Vantage. To upgrade Vantage, only use Vantage 
installers, as described in the upgrade instructions (see Preparing to Upgrade to 
Vantage 4.0).

Guidelines for Selecting SQL Express or SQL Standard
The decision about whether to use SQL Standard instead of Express should consider 
your planned maximum database size and the expected average volume of database 
traffic. The following sections provide information that can help you choose which 
database system to use:

 Database Size Guidelines

 Database Traffic Guidelines

 SQL Express Limitations

 SQL Standard Limitations

Database Size Guidelines
The size of the database is generally related to the number of jobs in a database. Each 
workflow record stores its entire job history, which means that simple workflows (such 
as a basic transcode) require less database space for each job than complex workflows 
(such as those involving decision-making or multiple steps).

As a rule of thumb, if you plan to store more than 500-1,000 jobs in your Vantage 
domain database at the same time—either running or in job history—use SQL 
Standard.
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Database Traffic Guidelines
Several factors affect the volume of database traffic. While there is no single rule for 
when you should use SQL Standard, the following factors may influence your decision:

• The number of actions in current jobs. If you often have more than 50-100 actions 
running simultaneously, you may improve performance by using SQL Standard.

• Distributed domain installations (such as a 3-node Vantage Array) are designed for 
high job throughput and may often have more than 50-100 actions running simul-
taneously. SQL Standard is recommended for distributed domains where high vol-
umes of media are submitted for concurrent processing.

• High Use of Web Applications. If you have more than three Web clients accessing 
Vantage simultaneously, or if you have more than 100 jobs in the job history view, 
consider using SQL Standard to improve client performance.

• Workflow Analytics (provided with Vantage System Management) typically requires 
SQL Standard, especially if you have more than 50-100 jobs in the database.

Note: Domains with database mirroring require SQL Standard. Database mirroring is 
not available when using SQL Express.

SQL Express Limitations
SQL Express has the following limitations:

• Database Size, SQL 2008 Express: 10 GB

• Maximum RAM Usage: 1 GB RAM

• Number of CPUs: 1 CPU 

SQL Standard Limitations
SQL Standard has the following limitations:

• No size limit for database

• Maximum RAM Usage: 64 GB RAM usage

• Number of CPU Threads: 4 CPUs

Guidelines for an All-In-One Installation with SQL Express
An all-in-one installation with SQL Express supports all Vantage features up to the limits 
imposed by SQL Express.

When installing an all-in-one domain with SQL Express, ensure that the database 
requirements do not exceed the limits of SQL Express (see Guidelines for Selecting SQL 
Express or SQL Standard) and that the server hardware meets the requirements 
described in Vantage Server Requirements.
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Guidelines for an All-In-One Installation with SQL Standard
When your installation requires the additional features and performance provided by 
SQL Standard, SQL Standard may compete for system resources (CPU activity and RAM) 
with Vantage media file transport, analysis, and transcoding services. Both SQL 
Standard and Vantage services can require a significant amount of network traffic.

When installing an all-in-one domain with SQL Standard, ensure that the server 
hardware meets the requirements described in Vantage Server Requirements. For 
optimum Vantage performance, install SQL Standard and the database on a dedicated 
physical drive or RAID array, separate from the operating system, the Vantage store, and 
the input and output files. For performance improvement suggestions, see Tips for 
Improving Performance on Non-Dedicated Servers.

Guidelines for a Distributed Domain Installation with SQL 
Standard

For high traffic installations, Vantage performance improves when you use SQL 
Standard and separate the database from other services such as the operating system 
and Vantage services. The following guidelines provide increasing levels of 
performance improvement:

• Place SQL Standard and the database on a dedicated physical drive or RAID array, 
separate from the operating system and Vantage services. This approach provides 
the lowest level of performance improvement.

• Place SQL Standard and the database on a dedicated server, separate from Vantage 
services, the Vantage store, and the input and output files. This approach provides 
the largest increase in performance.

• Place the database on a dedicated server, and use dedicated drives as follows:

– Dedicated physical drive or RAID array for the operating system.

– Dedicated physical drive or RAID array for SQL Standard and the database files.

Note: Installing a Vantage domain database on a separate server does not require an 
extra Vantage license for that server.

When installing a distributed domain with SQL Standard, ensure that the server 
hardware meets the requirements described in Database Server Requirements for SQL 
Standard. To improve database availability, see Improving Availability with Mirroring. 
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Tips for Improving Performance on Non-Dedicated Servers
When installing the Vantage domain database on a non-dedicated server, consider the 
following performance improvement guidelines:

• If you are using SQL Standard, place SQL Standard and the database on a dedicated 
physical drive or RAID array, separate from the operating system and Vantage ser-
vices.

• Limit the number of concurrent Transcode/Analysis tasks on the server to ensure 
that adequate CPU and network resources are available for the database.   This can 
be done by configuring the relevant services in the Vantage Management Console.

• In a distributed domain, limit the number of concurrent transport actions on the 
server to ensure that adequate network resources are available for database access.

• Limit the typical size of processed media files to less than 1GB.

• Limit CPU processing for the Transcode and Analysis services to 75% by restricting 
the number of jobs that are performed. This can be done by configuring the Trans-
port service in the Vantage Management Console.

• Limit Transport actions within a workflow to the transport of one large file (>1GB) 
at a time. This can be done by using the Vantage Management Console to config-
ure the Transport service to allow only one session at a time.

• To limit the resources used by Vantage services, set service limits to a low number. 
For more information, see Services.

Improving Availability with Mirroring
Telestream supports mirroring for SQL 2008. Database mirroring can prevent Vantage 
domain interruption if a single database server fails. A mirrored database requires the 
following physical servers:

• A dedicated server to host the principal database

• A dedicated server (of similar capability to the principal database server) to host the 
mirror database

• An optional dedicated server to host the witness server. 

The witness database is a lightweight service which can run effectively on a low-end 
server, but cannot be installed on a database server.

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

Note: Telestream strongly recommends using a dedicated server for the witness 
server to ensure uninterrupted operation in case of a database failover. If the witness 
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server function is placed on a server with Vantage services. transcoding can consume 
too many resources and prevent timely database switchover.

Microsoft SQL Server Standard Client Access Licenses (CALs) are required for the 
principal and optional mirror servers. The witness server can use SQL Express, which 
does not require a license.

Note: CAL is an acronym for Client Access License, offered by Microsoft for their SQL 
Server products. There are two types of CAL’s: A device CAL allows any number of users 
to gain access to licensed server software from a particular device, and a user CAL 
allows a particular user gain access to licensed server software from any number of 
devices. For example, a customer with fifteen Vantage nodes requires one CAL per 
node. Additionally, if the Vantage Workflow Portal is deployed for use, a CAL for each 
connection is required.

Vantage Installers Overview
The following sections introduce the Vantage installers:

 Obtaining the Vantage Installer

 Vantage Installation Package

Note: The Vantage installer on CD-ROM is available upon request. Contact 
sales@telestream.net to request a CD-ROM.

Obtaining the Vantage Installer
The Vantage installer is available from Telestream’s Web site. To locate and download 
the Vantage installer, follow these steps:

1. Use your Web browser to go to dynamic.telestream.net/downloads/download-
vantage.asp?prodid=vantage.

2. If you don’t have a Telestream account, click Create an Account to display the 
Create a Telestream Account page. Fill out the form and click Create Account. You 
can use your user name and password immediately. Telestream will send you a 
confirmation email.

3. On the login page, enter your authorized user name & password, then click Log In.

4. On the Downloads page, click Download Now to download the Vantage installer 
package.

Select a folder (or desktop) destination and click Save to download and save the zip 
file on your computer. The zip file is named Vantage_x.x.x.zip. For example: 
Vantage_4.0.0.zip.

5. The Download Progress window displays as the file is downloaded to your 
computer. When the download is complete, close the Web browser.
Vantage Domain Management Guide

mailto:support@telestream.net
http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=vantage
http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=vantage


Before You Install
Vantage Installers Overview

51
6. Right-click the Vantage installer zip and select Extract All. Follow the steps to 
extract the installers and related files:

– VantageClient

– VantageSetup

– VantageDatabaseSetup

– VantageWebApplicationsSetup

– WorkflowPortal

Vantage installers can include a version and build number in the filename. For example, 
VantageSetup_xx.xx.xxx.xxxxx.exe.

Also included:

• A quick start guide for a demonstration all-in-one installation.

• Vantage Patch installers as necessary

• Release Notes

• Vantage Installation Guide (this document).

Later, you’ll use these installers to install Vantage as directed.

Vantage Installation Package
The installation package includes the following installers:

 Vantage Domain Database Setup Installer

 Vantage Setup Installer

 Vantage Client Installer

 Vantage Web Applications Setup Installer

 Vantage Workflow Portal Installer

Vantage Domain Database Setup Installer
When you install the Vantage domain database (using VantageDatabaseSetup) in an all-
in-one domain, the installer performs the following:

• Installs SQL Server 2008 Express

• Creates a SQL instance named VANTAGE

• Creates the Vantage domain database on the VANTAGE instance.

Note: If you run the database installer and a SQL instance name VANTAGE already 
exists, this installer will populate the existing instance.
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Vantage Setup Installer
When you install Vantage client programs and services (using VantageSetup), the 
installer provides the option of performing an All-in-One installation or a custom 
installation.

Custom installation is typically used when performing a distributed domain installation 
so that you can control which servers host specific Vantage components (services and 
client programs).

The installer performs these tasks during installation:

• Installs Intel Performance Primitives software for Intel processors

• Checks for QuickTime (only Telestream Media Transcode and Analysis engine uti-
lizes QuickTime, if implemented in your workflows) and advises if missing or obso-
lete.

• Creates a Telestream directory for Vantage and related files

• Installs the Telestream Media Transcode and Analysis engine

• Installs Vantage services and client programs, per your selections

• Installs sample media files: FlipDemo.wmv (48 seconds), FlipDemo_short.wmv (15 
seconds), and FlipDemo.MSS (48 seconds) in the /Program Files/Telestream/Van-
tage/Store directory

• Creates a Telestream > Vantage entry in the Windows Programs list and provides 
entries for the Vantage Management Console and the Vantage Workflow Designer

• Creates desktop shortcuts (Vantage Management Console and Vantage Workflow 
Designer) on your desktop

• Creates a temporary storage directory on the local hard drive, and creates a default 
Vantage catalog in the database. (These two items are not created during a custom 
install – only during an All-in-One install.)

Vantage Client Installer
When you are only installing Vantage Management Console and/or Workflow Designer 
client programs, you can use the VantageClient installer to simplify installation.

Vantage Web Applications Setup Installer
The Vantage Web Applications installer 
(VantageWebApplicationsSetup.xx.xx.xxx.xxxxx.exe) installs the following Vantage web 
applications on the Vantage server:

• Vantage Dashboard, which enables Vantage administrators to view Vantage system 
information.

• Vantage Job Status Views, which enables Vantage operators to view job status 
information, and if properly authorized, execute job controls.

• Vantage Workflow Portal, which enables Vantage operators to view job status infor-
mation, preview job output, and manage job variables and metadata labels.
Vantage Domain Management Guide



Before You Install
Licensing Overview

53
Vantage Workflow Portal Installer
The Vantage Workflow Portal Installer (VantageWorkflowPortal) installs Vantage 
Workflow Portal, a client program intended for operators who are defining/reviewing 
asset metadata, creating edit decision lists, and submitting or forwarding jobs.

Licensing Overview
The following sections describe Vantage license topics:

 Using Vantage in Demo Mode

 Obtaining a Vantage License

 Replacing | Adding License Files

Note: A distributed Vantage domain requires one Array, Enterprise Control, or Master 
Control license per server. All servers in the same domain must use the same license 
type. For example, you cannot use an Array license on one server and a Master Control 
license on another.

Using Vantage in Demo Mode
When you install Vantage without a license, Vantage operates in demo mode. Demo 
mode allows you to design workflows, input Windows Media (.wmv and .avi) files for 
transcoding (with a watermark), and analyze a few seconds of video and audio. Some 
features that are not available in demo mode include:

• Support for broadcast server protocols

• Support for Transcode Multiscreen, which requires a Lightspeed Server

Note: If you'd like to unlock the entire set of features in Vantage for a time-limited 
trial, please contact your Telestream sales representative, or contact the Telestream 
sales team at sales@telestream.net.
Demonstration mode is limited to all-in-one domains.

Obtaining a Vantage License
You must obtain, install, and activate a license to:

• Test a Vantage distributed domain in demo mode

• Operate Vantage in production

• Upgrade Vantage from one version to another

• Add more Vantage services (more Transcode services, for example)

• Add licensed features (GraphicsFactory, for example).
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Please contact your Telestream sales representative or contact the Telestream sales 
team at sales@telestream.net to determine your Vantage requirements and obtain or 
update your license. When your license has been prepared, Telestream will email you 
the license as an attachment.

For Telestream contact details, go to www.telestream.net/company/contact-
telestream.htm.

When you receive the license (an XML file), save it in a safe place for installation and 
activation at the end of the installation process.

Replacing | Adding License Files
Depending on your requirements, you may obtain new license file or you may obtain 
updated files. Follow Telestream Sales or Customer Service instructions for adding or 
updating license files.

Note: You can evaluate an All-in-One Vantage installation without installing a license. 
Demo mode allows you to design workflows, perform transcoding with a watermark, 
and analyze short video or audio clips.
However, in demo mode (no license is installed), some features (such as broadcast 
server protocols) are disabled, and Vantage can only read Windows Media (.wmv and 
.avi) files for transcoding or analysis.
You can’t operate a Vantage distributed domain without a license.

Planning for a Vantage Distributed Domain 
Installation

Prior to installing a Vantage distributed domain, Telestream recommends that you 
develop a system diagram, indicating each server and the Vantage services and client 
programs it should host, plus the database server (and optional mirror and witness 
server), prior to installing the software.
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Figure 3. Typical Vantage Distributed Domain

The diagram should also identify which computers host client programs (Vantage 
Management Console, Workflow Designer, and Workflow Portal).

Additionally, document all network resources utilized by the Vantage domain (file 
sources and destinations).

When adding Vantage services to scale performance, Telestream generally 
recommends adding one or more Vantage transcoding servers, which is typically the 
first service to max out server capacity. Multiple transcode servers improves load 
balancing and speeds overall job throughput. Secondly, if you use the Vantage Analysis 
service heavily, consider hosting it on a dedicated server as well.

Note: Each server hosting Vantage services requires a Vantage Array or Vantage 
Enterprise System Management license. Dedicated database servers do not require a 
special license.
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Installing and
Upgrading Vantage
Use this topic to install, upgrade, or scale Vantage, and configure it for operation.

Note: Go to www.telestream.net/telestream-support/vantage/support.htm to 
browse the Vantage Web library, user’s guides, app notes, and other documents.

The following topics describe how to install and upgrade Vantage components:

 Preparing to Upgrade to Vantage 4.0

 Installing an All-in-One Domain

 Installing a Vantage Distributed Domain

 Enabling a Vantage License

 Installing Vantage Client Programs on Workstations

 Installing Workflow Portal

 Installing and Upgrading Vantage Web Applications

 Moving the Vantage Domain Database to Another Database

 Adding a Server to a Vantage Domain

 Adding a Lightspeed Server to an Existing Vantage Domain

 Verifying DTC Service Settings

Preparing to Upgrade to Vantage 4.0
If Vantage is already installed, you must properly remove the Vantage software before 
you install Vantage 4.0. If Vantage is not installed, skip this procedure and install 
Vantage as described in:

 Installing an All-in-One Domain

 Installing a Vantage Distributed Domain
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To remove Vantage software in preparation for installing Vantage 4.0, do the following:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Workflow Portal and click Remove or Uninstall.

4. Select Vantage Web Applications and click Remove or Uninstall.

5. To uninstall any Vantage update packs that are installed, select each Vantage 
update pack in reverse sequential order, and click Remove or Uninstall. Perform this 
step for all installed update packs.

6. To uninstall the Telestream Media Transcode and Analysis engine, follow these 
steps:

a. Select Start > Administrative Tools > Services to display the Services window.
b. Right-click and select Stop for the following services: Vantage Analysis service 

and the Vantage Transcode service.
c. In the Control Panel tool (see Step 2), select Telestream Media Transcoding & 

Analysis and click Remove or Uninstall.

7. In the Control Panel tool (see Step 2), select Vantage and click Remove or Uninstall.

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created is 
not removed.

8. In the Control Panel tool to remove programs (see Step 2), select Vantage Domain 
Database and click Remove or Uninstall.

Note: If you want to change the Microsoft SQL version (for example, from Express to 
Standard), or if you want to move the Vantage domain database to a different server, 
follow the procedure in Moving the Vantage Domain Database to Another Database 
before you continue.

At this stage, your database files and SQL Server are still intact. When you install 
Vantage 4.0, Vantage will allow you to use these database files, and it will upgrade 
them for version 4.0.

9. Install the Vantage 4.0 software as described in one of the following topics:

 Installing an All-in-One Domain

 Installing a Vantage Distributed Domain
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Installing an All-in-One Domain
An all-in-one Vantage domain is one in which all Vantage server components —all 
Vantage services, the Vantage domain database, and any Web applications—are 
installed and operate on a single computer. Vantage client programs are also installed 
on the single computer, and additional client programs can be installed on 
workstations.

The default all-in-one installation creates a default storage location (at Program Files 
(x86)\Telestream\Vantage\Store) and a Vantage catalog.

To install an all-in-one Vantage domain, perform the tasks described in the following 
sections in the specified order:

1. Installing the Vantage Domain Database

2. Installing Vantage Services and Client Programs

3. Installing Vantage Updates

4. Setting Up a Vantage Store

5. Additional Installation Tasks

Installing the Vantage Domain Database

Note: For instructions on obtaining the Vantage installation software, see Obtaining 
the Vantage Installer.

To install the Vantage domain database, follow these steps:

1. Log on to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: For additional information on Vantage use with anti-virus software, see Anti-
Virus Software Recommendations. For more information on Vantage use with the 
Windows Firewall, see Firewall Guidelines.

2. Run the VantageDatabaseSetup installer (for example, 
VantageDatabaseSetup_SQL2008_xx.xx.xxx.xxxxx.exe), which extracts the 
components, then installs SQL Server. 

When SQL Server 2008 SP2 Express installation completes, the installer displays the 
Vantage Domain Database Setup Wizard.

3. When the Welcome dialog appears, click Next to display the license agreement and 
click I Accept if you agree to license terms, then click Next.

4. If you are installing Vantage for the first time on this server, when the Database 
install mode dialog appears, select Install new database, and click Next.
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Note: Telestream recommends that you install the database on a different hard drive 
from the one allocated for temporary media storage. For more information, see 
Database Selection and Configuration Guidelines.

5. If you are upgrading Vantage on this server, when the Database install mode dialog 
appears, select Upgrade existing database, and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

Note: Existing workflows do not require updating to run as they did on an earlier 
Vantage release. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading.

6. When the Destination Folder dialog appears, accept the default folder or click 
Change to select an alternate directory on another drive; then click Next.

7. When the Ready to Install Vantage Domain Database dialog appears, click Install to 
begin database installation. This process takes a few minutes to complete.

8. When installation is complete, click Finish to quit.

Installing Vantage Services and Client Programs
The procedure in this topic installs the Vantage services, Vantage Management 
Console, and Vantage Workflow Designer on a server. The install procedure also installs 
some support programs that are required for operation.

Note: Vantage installers modify Windows Distributed Transaction Coordinator 
(MSDTC) properties to meet the communication requirements of Vantage services and 
the database as appropriate. This modification is automatic, and requires no action on 
your part.
Telestream recommends not using anti-virus software on Vantage servers. If you use 
anti-virus software, you should identify Vantage as a safe/rusted application. Be sure 
to turn off anti-virus software during Vantage installation or install anti-virus software 
after installing Vantage.

To install the Vantage services, client programs, and support programs, do the 
following:

1. Log on to the target server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall is off.

Note: For additional information on Vantage use with anti-virus software, see Anti-
Virus Software Recommendations. For more information on Vantage use with the 
Windows Firewall, see Firewall Guidelines.
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2. Run the VantageSetup installer (VantageSetup_xx.xx.xxx.xxxxx.exe, for example). The 
installer extracts components, then continues.

The IPP, QuickTime, Telestream Media Transcode and Analysis engine steps are 
silently skipped if they are already installed.

If any subsystems need installing, the Vantage Setup dialog (Figure 4) appears and 
lists the subsystems to install.

Figure 4. Sample Vantage Setup Dialog

3. Click Install to install required software and components.

CAUTION: Telestream recommends that you install/upgrade all software and 
components or Vantage may not operate correctly.

If Intel Performance Primitives (IPP) is not present, it is installed.

If QuickTime 7.5.5 or later is not installed, the installer displays a message advising 
you to visit Apple’s QuickTime for Windows Web page (www.apple.com/quicktime/
win.html), download the current version, and install it. Telestream recommends 
that you install version 7.6.9, which is not available on the Apple Web site.

Note: If you install a different version of the Telestream Media Transcode and Analysis 
engine than supplied with this Vantage installer, be sure to use the QuickTime version 
recommended for the version you are installing.

4. If you install QuickTime, do the following when QuickTime installation completes:

a. Uncheck Check for Updates, so that QuickTime is not updated without your 
knowledge.

b. Re-run the Vantage Setup installer to continue.

Note: If you install QuickTime after the Telestream Media Transcoding and Analysis 
engine is installed, you must restart the server. If you don’t, during encoding of some 
formats, this error may occur: An error occurred during execution of the Transcode Task: 
RenderSession Configuration Error, message: Requested encoder | decoder not installed.
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5. If you choose to install the Telestream Media Transcoding and Analysis engine, do 
the following:

a. When the Welcome Window appears, click Next to display the license 
agreement.

b. When the License Agreement appears, read the Vantage Software License Terms 
and Conditions, click I Accept (if you agree to license terms), and click Next.

c. Accept the default destination folder or click Change to select an alternate folder. 
Click Next.

d. When the Ready to Install dialog appears, click Install to begin installation of 
Telestream Media Transcode and Analysis engine components.

6. When installation of support programs is done, click Finish to close the installer.

7. When the Welcome window appears, click Next to display the license agreement.

8. Read the Vantage Software License Terms and Conditions, click I Accept if you agree 
to license terms, and click Next.

9. Click All-in-One Install.

10. To accept the default destination folder, click Next. To change the destination 
folder, click Change, select an alternate folder, and click Next.

11. When the Ready to install Vantage dialog appears, click Install.

Note: For an All-in-One installation, Vantage creates a temporary storage area on the 
local hard drive, and creates a default Vantage catalog in the database.

12. When installation is done, click Finish to close the installer. 

Installing Vantage Updates
Update installers are used to replace Vantage components as necessary between 
upgrades (version releases). Updates to the current version of Vantage are periodically 
published by Telestream, and are available from the Telestream Web site.

To locate and install Vantage updates, do the following:

1. Go to the Telestream Vantage download Web site:

http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=van-
tage

2. Review the Vantage download page to determine if there are any updates that 
should be installed.

3. If there is an update to install, review the Release Notes that accompany the update 
and install the update according to your requirements and the instructions in the 
Release Notes.
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Setting Up a Vantage Store
A Vantage store is a folder that serves as a temporary location where Vantage can store 
media files. Vantage must have at least one store to process jobs. When you install an 
all-in-one domain, Vantage creates a Vantage store named Local Store.

The Local Store will work correctly for all Vantage services and clients (Vantage 
Management Console, Vantage Workflow Designer, and Vantage Workflow Portal) that 
run on the Vantage server. However, if you install Vantage client programs on 
workstations, those client programs will not have access to the Local Store. This is 
because the Local Store is defined with a path from a local drive.

Note: For more information on Vantage stores, see Understanding Vantage Storage. 
For more information on path specifications, see Understanding Path Specifications for 
Vantage Storage.

To make the Local Store available to network workstations, do the following:

1. Define the Local Store folder as a Windows share. The path is:

[install_drive]:\Program Files (x86)\Telestream\Vantage\Store\

For more information, see Configuring Folders for Vantage Access.

2. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

Note: If you have a Team Management, Enterprise Control, or Master Control license, 
the default Vantage user account is Administrator with no password. This account has 
administrative privileges.

3. In the component (left) panel, open Vantage Domain to display the domain 
management options.

4. Open Storage to display the Vantage storage options.

5. Select Vantage Stores to display the Vantage Stores list in the details (right) panel.

6. Select Local Store.

7. To specify a UNC path for the folder that will be accessible to network workstations, 
do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.
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Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

8. Consider changing the Local Store name to Network Store to indicate that the store 
is available to network users.

9. Click OK.

10. Click the Save button  to save the reconfigured store.

Additional Installation Tasks
After installation, you should enable a Vantage license and you might want to install 
optional programs as described in the following topics:

 Enabling a Vantage License

 Installing Vantage Client Programs on Workstations

 Installing Workflow Portal

 Installing and Upgrading Vantage Web Applications

Note: During installation, Vantage configures and starts the Distributed Transactional 
Coordinator (DTC) Windows service. There is no need to verify DTC configuration and 
operation after the install, but if you later suspect that the DTC service has stopped or 
the DTC configuration has changed, see Verifying DTC Service Settings for information 
on verifying the DTC status and configuration.

Note: If a service cannot access a folder, change the log on ID for that service to a log 
on ID that has access rights to the folder. For more information, see Setting the Vantage 
Windows Log On ID for a Service.

Installing a Vantage Distributed Domain
A Vantage distributed domain is one in which two or more Vantage server 
components—Vantage array services, the Vantage domain database, and Vantage Web 
applications—are distributed between two or more servers.

To implement a Vantage domain across multiple servers—creating a distributed 
domain—specific configurations must be applied to all computers that host any 
Vantage service or host the Vantage domain database for the distributed domain.
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A Vantage distributed domain installation and configuration generally takes two to six 
hours, depending on the complexity of the installation. To install a Vantage distributed 
domain, perform the tasks described in the following sections in the specified order:

1. Setting Up the Vantage Domain Database

2. Setting Up Vantage Array Servers

3. Setting Up a Vantage Store

4. Additional Installation Tasks

Note: A distributed Vantage domain requires one Array, Enterprise Control, or Master 
Control license per server. All servers in the same domain must use the same license 
type. For example, you cannot use an Array license on one server and a Master license 
on another.

Setting Up the Vantage Domain Database
Although you can install and operate the Vantage domain database and Vantage 
services on the same server (as is done in an all-in-one domain), Telestream 
recommends that you use a dedicated server for the Vantage domain database. If you 
do plan to install the Vantage domain database and Vantage services on the same 
server, you should install the Vantage domain database first and then install the 
Vantage services.

To set up the Vantage domain database, follow the procedures in the following topics 
in the order presented:

1. Installing SQL Server 2008 Standard

2. Configuring SQL Server Standard Memory Settings

3. Installing the Vantage Domain Database

Installing SQL Server 2008 Standard
If you are installing SQL Server 2008 Standard on a server, follow these steps:

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

1. Log on to the target server with a local administrator account.

2. Insert the SQL Server 2008 Standard DVD into the server and start the installer 
(setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.
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6. License Terms—Accept the license terms and click Next.

7. Setup Support Files—Click Install, allow the installer to complete its actions, then 
click Next.

Note: If Restart computer... Failed displays in the report, this is due to a bug in the SQL 
Server 2008 Standard R1 installer. 
To correct the problem, run Regedit and navigate to this key: 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\PendingFileRenameOperations. Clear the Value Data string.
After you clear the Value Data string, return to Setup Support Rules and click Re-run on 
the right by the status bar. The Setup Support Rules should complete successfully—
click OK to continue.

Note: On SQL Server 2008 R2 only, select SQL Server Feature Installation and click 
Next.

8. Feature Selection—Do the following:

a. Check Database Engine Services and Management Tools.
b. If you are installing the database on a separate drive (see Database Selection and 

Configuration Guidelines), change the directories listed for shared features to 
another drive. For example:

Shared feature directory: D:\Program Files\Microsoft SQL Server\
Shared feature directory (x86): D:\Program Files (x86)\Microsoft SQL Server\

c. Click Next.

9. Instance Configuration—Do the following:

a. Select Named instance and enter VANTAGE in the Named instance field and the 
Instance ID field.

b. If you are installing the database on a separate drive (see Database Selection and 
Configuration Guidelines), change the Instance root directory to refer to the correct 
drive.

c. Click Next.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration—Do the following:

a. For SQL Server Agent, select NT AUTHORITY\NETWORK SERVICE.
b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

12. Database Engine Configuration—Do the following:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.
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13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the installer.

Configuring SQL Server Standard Memory Settings
When using SQL Server Standard, the maximum server memory for SQL should be set 
to utilize a maximum 75% of the system's memory.

1. Select Start > SQL Server Management Studio.

2.  Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

4. In the Server Properties window, go to the Memory page.

5. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

6. Click OK.

7. Close the SQL Server Management Studio.

Installing the Vantage Domain Database
This task installs the Vantage domain database instance.

Follow these steps:

1. Log on to the database server with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Locate the Vantage domain database installer (for example, 
VantageDatabaseSetup_SQL2008_xx.xx.xxx.xxxxx.exe), copy it to your server, or 
obtain the Vantage Installer CD.

Note: The setup program checks for SQL Server 2008 Standard, and if the product is 
found, setup skips the install of SQL Express.

3. Run the Vantage domain database installer, which extracts the components, then 
continues. Component installation takes a few minutes.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display 
the license agreement.
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5. License Agreement—Read the Vantage Software License Terms and Conditions, 
then click I Accept if you agree to license terms. Click Next.

6. If there is no database on this server, when the Database install mode dialog 
appears, select Install new database, and click Next.

Note: Telestream recommends that you install the database on a different hard drive 
from the one allocated for temporary media storage. For more information, see 
Database Selection and Configuration Guidelines.

7. If there is a Vantage database on this server, when the Database install mode dialog 
appears, select Upgrade existing database, and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

Note: Existing workflows do not require updating to run as they did on an earlier 
Vantage release. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading.

8. Destination Folder—Accept the default folder or click Change to select an alternate 
folder. Click Next.

9. Ready to Install Vantage Domain Database—Click Install to begin database 
installation. This process takes a few minutes to complete.

10. Completed...—When installation is complete, click Finish.

Setting Up Vantage Array Servers
Although you can install and operate Vantage services and the Vantage domain 
database on the same server (as is done in an all-in-one domain), Telestream 
recommends that you use a dedicated server for the Vantage domain database.

Note: If you do plan to install the Vantage domain database and Vantage services on 
the same server, you should install the Vantage domain database first and then install 
the Vantage services.

To set up the Vantage services, follow the procedures in the following topics in the 
order presented:

1. Installing Vantage Services and Client Programs

2. Installing Vantage Updates

3. Setting the Vantage Windows Log On ID for a Service

4. Adding Vantage Services to a Distributed Domain
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Installing Vantage Services and Client Programs
The procedure in this topic allows you to install the Vantage services, Vantage 
Management Console, and Vantage Workflow Designer on a server. The install 
procedure also installs some support programs that are required for operation. 
Installation options allow you to install some or all of these programs.

Note: Vantage installers modify Windows Distributed Transaction Coordinator 
(MSDTC) properties to meet the communication requirements of Vantage services and 
the database as appropriate. This modification is automatic, and requires no action on 
your part.
Telestream recommends not using anti-virus software on Vantage servers. If you use 
anti-virus software, you should identify Vantage as a safe/rusted application. Be sure 
to turn off anti-virus software during Vantage installation or install anti-virus software 
after installing Vantage.

To install the Vantage services, client programs, and support programs, do the 
following:

1. Log on to the target server with a local administrator account. Make sure that virus-
checking software and Windows Firewall is turned off.

2. Locate the Vantage installer (VantageSetup_xx.xx.xxx.xxxxx.exe, for example) on a 
network server, copy or locate the Vantage installer on the target server, or obtain 
the Vantage Installer CD.

3. Run the installer. The installer extracts components, then continues. The IPP, 
QuickTime, Telestream Media Transcode and Analysis engine steps are silently 
skipped if they are already installed.

4. Click Install to install required subsystems (you can still skip Telestream Media 
Transcode and Analysis engine installation).

CAUTION: Telestream recommends that you install/upgrade all software components 
or Vantage may not operate correctly.

If Intel Performance Primitives (IPP) is not present, it is installed.

If QuickTime 7.5.5 or later is not installed, the installer displays a message advising 
you to visit Apple’s QuickTime for Windows Web page (www.apple.com/quicktime/
win.html), download the current version, and install it. Telestream recommends 
that you install version 7.6.9, which is not available on the Apple Web site.

5. If you install Quicktime, do the following when Quicktime installation completes:

a. Uncheck Check for Updates, so that QuickTime is not updated without your 
knowledge.

b. Restart the server. If you don’t, during encoding of some formats, this error may 
occur: An error occurred during execution of the Transcode Task: RenderSession 
Configuration Error, message: Requested encoder | decoder not installed.

c. Re-run the Vantage Setup installer to continue.
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6. If you choose to install the Telestream Media Transcoding and Analysis engine, do 
the following:

a. When the Transcode Installer screen displays, click Install.

Note: If you install a different version of the Telestream Media Transcode and Analysis 
engine than supplied with this Vantage installer, be sure to use the QuickTime version 
recommended for the version you are installing.

b. When the Welcome Window appears, click Next to display the license 
agreement, or click Cancel to skip installation of the Telestream Media 
Transcoding and Analysis engine (and skip to Step 8).

c. When the License Agreement appears, read the Vantage Software License Terms 
and Conditions, click I accept... (if you agree to license terms), and click Next.

d. Accept the default destination folder or click Change to select an alternate folder. 
Click Next.

e. When the Ready to install... dialog appears, click Install to begin installation of 
Telestream Media Transcode and Analysis engine components.

7. When installation of support programs is done, click Finish to close the installer.

8. When the Welcome window appears, click Next to display the license agreement.

9. Read the Vantage Software License Terms and Conditions, click I Accept... if you 
agree to license terms, and click Next.

10. Click Custom install to display the Custom Setup dialog.

Figure 5. Custom Setup Dialog
Vantage Domain Management Guide



Installing and Upgrading Vantage
Installing a Vantage Distributed Domain

71
11. Custom Setup—Use the dropdown lists in the Vantage component tree to select 
which Vantage clients and Vantage services are installed as follows (all are selected 
by default):

– To disable all features for a branch or to disable a single feature, select Entire 
feature will be unavailable. For example, to skip all client software installation, 
click the dropdown list for Vantage Client Components and select Entire feature 
will be unavailable.

– To enable all features for a branch, select Entire feature will be installed on local 
hard drive. For example, to install all Vantage services, click the dropdown list for 
Vantage Services and select Entire feature will be installed on local hard drive.

– To enable a single feature, select Will be installed on local hard drive. For example, 
to install a specific Vantage service, click the dropdown list for the Vantage 
service and select Will be installed on local hard drive.

Note: If you did not install the Telestream Media Transcode and Analysis engine on 
this computer, be sure to specify that the Transcode service, the Analysis service, and 
the Multiscreen service do not get installed. These services require that the Telestream 
Media Transcode and Analysis engine be installed on the same server.

12. To view the disk space required for the selected components, click Disk Usage; then 
click OK when done.

13. To specify a different directory for installation, click Browse, use the Change 
destination folder dialog to select a new directory, and click OK.

14. Click Next to finalize the component selection.

15. Ready to Install Vantage—Click Install to begin installation.

16. Completed...—When installation is done, click Finish to close the installer.

Installing Vantage Updates
Update installers are used to replace Vantage components as necessary between 
upgrades (version releases). Updates to the current version of Vantage are periodically 
published by Telestream, and are available from the Telestream Web site.

To locate and install Vantage updates, do the following:

1. Go to the Telestream Vantage download Web site:

http://dynamic.telestream.net/downloads/download-vantage.asp?prodid=van-
tage

2. Review the Vantage download page to determine if there are any updates that 
should be installed.

3. If there is an update to install, review the Release Notes that accompany the update 
and install the update according to your requirements and the instructions in the 
Release Notes.
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Setting the Vantage Windows Log On ID for a Service
After installation, the default log on ID for each Vantage service is the Local System 
account. This log on ID provides access to files on the local server only. If a service, such 
as Transcode, requires access to files on another server, the Local System account 
cannot provide that access. If Vantage services need access to input folders, output 
folders, or a Vantage store that is on another computer, you must do the following:

• Create a Vantage Windows user ID for the service

• Grant access to the Vantage Windows user ID for the appropriate file space on other 
file systems.

For more information, see Windows Authentication Guidelines.

All Vantage services except the following require a Vantage Windows user ID to access 
files on other computers:

• Agility

• Catalog

• Sdk

For services of the same type, the Windows log on ID for that service must be the same 
on all Vantage servers in the domain. For example, all Analysis services within the 
domain must use the same log on ID. However, the Catalog service, which does not 
access files, can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the distributed domain:

1. Log on to the target server with a local administrator account.

2. On the Vantage server, select Start > Administrative Tools > Services.

You can also select Start, type services.msc in the search box, and press Enter.

3. Right click on a Vantage service and select Properties. (All Vantage services begin 
with the word Vantage.)

4. Select the Log On tab.
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Figure 6. Vantage Service Log On Properties

5. Select This account.

6. Click Browse and use the Select User dialog to select the Vantage Windows user 
account name (for example, VantageWinUser), then click OK.

If the Vantage Windows user name has not been defined, it will not appear in the 
browser. You can also enter a user name in the This account text box. For informa-
tion on the Vantage Windows user name and how to create it, see Windows Authen-
tication Guidelines.

Note: All Vantage services in a Vantage domain should be located in the same 
Windows domain. In Figure 6, Starfleet represents the Windows domain.

7. Enter the password for the Vantage Windows user in the Password and Confirm 
password text boxes, then click OK.

8. Repeat Steps 3 to 7 as needed for the other Vantage services.

Note: In some cases; you may be required to indicate that the specified user has been 
granted log on as a service right. If the service fails to start and displays an error 
indicating that the service log on user name may not have the necessary permissions, 
consult your IT administrator to set the appropriate rights for the new account.

9. Restart any updated services.
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Adding Vantage Services to a Distributed Domain
When Vantage services are installed on a server, the installer looks for the Vantage 
domain database on the server. If the Vantage domain database is present, all services 
are configured to connect to that domain. If no Vantage domain database is present, 
the Vantage services are not configured, and you must configure each service to 
connect to the appropriate Vantage domain.

To add Vantage services to a Vantage domain, follow these steps:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

Note: If you have a Team Management, Enterprise Control, or Master Control license, 
the default Vantage user account is Administrator with no password. This account has 
administrative privileges.

2. Select Services in the component (left) panel.

The Services details (right) panel shows all services on all servers that are con-
nected to the domain you selected.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.

4. Select one or more services to add to this domain, and click OK to add them.

Services are identified by name, machine or host, and Vantage domain. Make sure 
that you don’t select services that are properly attached to another domain. To 
select multiple services, use shift-click to select a series of services, or use option-
click to select individual services.

5. If you are moving a service from one domain to another, the Management Console 
displays the Reassign Services window. Click OK to add them to this domain.

Setting Up a Vantage Store
A Vantage store is a folder that serves as a temporary location to store media files. 
Vantage must have at least one store to process jobs. For more information, see 
Understanding Vantage Storage.

To add a new Vantage store, do the following:

1. If you have not created a Windows share to serve as the Vantage store, create it now 
and make it available to the Vantage Windows user. For more information, see 
Configuring Folders for Vantage Access.

2. In the component (left) panel, open Vantage Domain to display the domain 
management options.

3. Open Storage to display the Vantage storage options.

4. Select Vantage Stores to display the Vantage Stores list in the details (right) panel.
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5. Click the New Vantage Store button  in the toolbar to display the Add New Store 
dialog.

6. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

7. To specify the store root directory, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

Note: If you use a local drive letter to specify a directory, only Vantage services and 
clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

8. Click OK.

9. Click the Save button  to save the new store.

Additional Installation Tasks
After installation, you should enable a Vantage license and you might want to install 
optional programs as described in the following topics:

 Enabling a Vantage License

 Installing Vantage Client Programs on Workstations

 Installing Workflow Portal

 Installing and Upgrading Vantage Web Applications

Note: During installation, Vantage configures and starts the Distributed Transactional 
Coordinator (DTC) Windows service. There is no need to verify DTC configuration and 
operation after the install, but if you later suspect that the DTC service has stopped or 
the DTC configuration has changed, see Verifying DTC Service Settings for information 
on verifying the DTC status and configuration.
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Enabling a Vantage License
If you are implementing Vantage in a production environment, enable your license 
now. If you haven’t yet obtained a license or if you need additional licenses, see 
Licensing Overview.

The following topics describe Vantage license installation:

 Installing a Vantage License

 Troubleshooting License Installation Problems

 Activating a Vantage License Offline

 Resolving a DEP Conflict

Note: A distributed Vantage domain requires one Array, Enterprise Control, or Master 
Control license per server. All servers in the same domain must use the same license 
type. For example, you cannot use an Array license on one server and a Master license 
on another.

Installing a Vantage License

Note: You should remove a license from one domain before you use it in another 
domain—you can’t use the same license in more than one domain at a time. For 
instructions on removing a license, see Deactivating a License.

When you receive a license (an XML file), install it using these steps:

1. Store a copy of the license file in a safe place. 

Always keep a backup in case you need to move the database later.

2. Store a copy of the license file in a location that is accessible to the server where 
you are installing the license, and note the directory where the file is stored. 

3. Start the Vantage Management Console as described in Starting the Vantage 
Management Console.

4. In the left panel, select Licenses.

5. In the right panel, click the Add License button  in the toolbar to display the Add/
Update License dialog.

6. Navigate to the directory where the license is stored, select one or more licenses, 
then click Open.

If this computer has an Internet connection, Vantage prompts you to accept the 
license agreement. If an error message appears, see Troubleshooting License Installa-
tion Problems.

7. Read the Vantage Software License Terms and Conditions, click I accept... if you 
agree to license terms, and click OK.
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8. When the Licensing Changed dialog appears, read the message and click OK.

9. Repeat this procedure to install additional licenses.

When installation is complete, the license is stored in the Vantage domain database for 
use by all Vantage services and clients in the domain. Telestream recommends that you 
archive a copy of the original XML file, in case you need to move the license to another 
Vantage domain later.

Troubleshooting License Installation Problems
There are two common problems that might occur during license installation:

• No Internet connection—see Activating a Vantage License Offline

• Data Execution Prevention (DEP) conflict—see Resolving a DEP Conflict

Activating a Vantage License Offline
If the computer has no Internet connection, this error displays:

The Vantage Management Console might not have access to the Internet, or the 
network firewall might be prohibiting Web server (HTTP) traffic.

You can activate the Vantage license yourself using a different computer, or you can call 
Telestream Customer Service and they will assist you to activate your license.
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To activate your license with a different computer, do the following:

1. Click Cancel to continue. Vantage displays the Product Activation dialog:

2. Click the second option (Activate using a different computer that has Web Access) 
to indicate you’re using a different computer, and click Next. Vantage displays the 
Activate Using Another Computer dialog, along with the installation ID for your 
license (sample ID displayed):

3. Click Save to display a File Save dialog, so that you can create a text file which 
contains the activation key.

4. Save this file locally and copy this file to a computer with Internet access or save it 
directly to a share on (or accessible to) a computer which has Internet access. 

After saving the file, leave the dialog open and proceed to the computer with Inter-
net access to validate the Installation ID.
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5. On the computer with Internet access, open a Web browser and navigate to 
activate.esellerate.net.

6. Open the installation ID text file and copy and paste the Installation ID into the 
Installation ID field on the Web page:

7. Click Submit – Vantage connects to the eSellerate server. 
The eSellerate server validates the installation ID and returns a page which displays 
your unique activation key composed of ten groups of numbers and letters. 

8. If your Vantage server is not immediately adjacent, print this page or write down 
the activation key.
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9. Return to the Vantage server where the Activate Using Another Computer dialog 
displays:

10. Click Next to display the Enter Activation Key dialog:
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11. Paste (or manually enter) the activation key and click Activate (sample shown – this 
is not a valid activation key).

The activation key is accepted and the Vantage license is activated. Vantage dis-
plays a dialog confirming the activation:

12. Click Done—Vantage displays the activated license in the license details panel.

Resolving a DEP Conflict
If Vantage displays the error eSellerate can not run with Data Execution Prevention 
enabled, follow these steps:

1. Right-click My Computer to display the System Properties dialog.

2. On the Advanced tab, click the Performance Settings button to display the 
Performance Options window.

3. On the Data Execution Prevention tab, check Turn on DEP for all programs and 
services except those I select.

4. Click Add and navigate to the location of the mmc.exe program (Normally located 
in C:\Windows\System32\mmc.exe).

5. Click Open, and click OK to apply this change.

6. Click OK to restart the computer.

7. Restart your computer and activate the license.

The activated license is stored in the Vantage domain database for use by Vantage 
services in this domain.

Note: If you move your Vantage domain database to another server, remove your 
license to deactivate it when you move to the new computer; then you can import it 
again, and activate it in the new database. Be sure to keep your license file (XML) as a 
backup.
Vantage Domain Management Guide



Installing and Upgrading Vantage
Installing Vantage Client Programs on Workstations

82
Installing Vantage Client Programs on 
Workstations

The Vantage Client programs include the Vantage Management Console and the 
Vantage Workflow Designer.

To install the Vantage client programs on a workstation, do the following:

1. Copy the Vantage Client installer (VantageClient_xx.xx.xxx.xxxxx) to the 
workstation where you want to install the software, or make the installer available 
on a network share.

2. Double-click the installer program.

3. When the Welcome dialog appears, click Next to display the license agreement.

4. Read the Vantage Software License Terms and Conditions, click I Accept... if you 
agree to license terms, and click Next.

5. To accept the default destination folder, click Next. To change the destination 
folder, click Change, select an alternate folder, and click Next.

6. When the Ready to Install Vantage Client dialog appears, click Install to install the 
Vantage client software.

7. When installation is done, click Finish to close the installer. 

Installing Workflow Portal
The Workflow Portal is a desktop application which allows operators to browse assets, 
enter metadata, trim clips or highlights, create edit decision lists, and forward media to 
workflows. You can install Workflow portal on an operator’s workstation or on a server.

If you install Vantage Workflow Portal on an operator’s workstation, verify that the 
workstation has the following:

• Network access to any proxy or thumbnail files, using the operator's user account.

• Network access directly to the Vantage domain database server, with port access 
configured to allow SQL queries.

• Sufficient memory to run Workflow Portal. Specific hardware requirements will vary 
depending upon what you want your operator to do, and how many assets will be 
in the portal.

You can install Workflow portal on a server in an all-in-one domain or a distributed 
domain, which can impact Vantage domain performance. If you install Vantage 
Workflow Portal on a all-in-one server, verify that the server has the following:

• Local access to any proxy or thumbnail files, using the operator's user account.

• Local access directly to the Vantage domain database server, with port access con-
figured to allow SQL queries.

• Sufficient memory to run Workflow Portal.
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Note: Each running instance of the Workflow Portal requires a Workflow Portal 
license. When purchased, these licenses are included in your Vantage license XML file, 
and are stored in the Vantage domain database. When an operator logs into the Portal, 
they will acquire a license. If no license is available, the Portal will run in demo mode, 
which allows asset browsing, but not metadata entry or job submission.

To install Vantage Workflow Portal on a server or workstation, follow these steps:

1. Log on to the target computer with a local administrator account.

2. Run the Vantage Workflow Portal installer file: For example, 
VantageWorkflowPortal_xx.xx.xxx.xxxxx.msi.

3. When the Welcome Window appears, click Next to display the license agreement.

4. Read the Vantage Software License Terms and Conditions, click I Accept... if you 
agree to license terms, and click Next.

5. When the Destination Folder dialog appears, accept the default folder or click 
Change to select an alternate directory on another drive; then click Next.

6. When the Ready to Install Vantage Workflow Portal dialog appears, click Install.

7. When installation is done, click Finish to close the installer. 

Vantage client programs and services installation is complete.

Installing and Upgrading Vantage Web 
Applications

The following sections describe how to manage installation of the Web applications:

 Installing Vantage Web Applications

 Upgrading Vantage Web Applications

 Troubleshooting Vantage Web Applications Installation

Installing Vantage Web Applications
When installing the Vantage Web Applications on a server for the first time, the 
procedure is different for Lightspeed servers and standard servers:

• Standard servers—You must set up IIS first. If IIS is already installed, Telestream rec-
ommends that you uninstall IIS and then reinstall IIS using the procedure described 
in this topic. 

• Lightspeed servers—Lightspeed servers ship with IIS properly installed. There is no 
need to remove and reinstall IIS on a Lightspeed server.

Note: If you are upgrading the Web applications, see Upgrading Vantage Web 
Applications.
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Note: If you are installing the Vantage Web Applications on a server that will have 
Vantage services running on it in the future, Telestream recommends that you install 
the Vantage Web Applications before the Vantage services so that you do not have to 
restart Vantage services after installation. If Vantage services are already installed, plan 
to install the Vantage Web Applications when the upgrade will cause the least 
interruption to Vantage users.

Note: If UAC is enabled, the installer displays this error: “You do not have sufficient 
privileges to complete this installation...”. 
To resolve this, either disable UAC before installation, or:
1. Select Start > All Programs > Accessories.
2. Right-click the Command prompt and select Run as Administrator.
3. CD to the Vantage Web Applications installer directory.
4. Run the installer from the elevated command prompt.

To install the Vantage Web Applications and IIS, follow these steps:

1. Log on to the target server with a local administrator account.

2. If you are installing the Vantage Web applications on a Lightspeed server, skip to 
Step 7

Note: If you are upgrading the Web applications, see Upgrading Vantage Web 
Applications.

3. Verify that your IIS server requirements are met (see Vantage Web Applications).

Note: The following step ensures that .NET 4.0 is correctly installed; you re-install IIS 7 
in a later step.

4. If IIS 7 is installed on the target server, uninstall it as follows:

a. Open the Server Manager and select Roles.
b. When the Roles page appears, click Remove Roles.
c. Click Server Roles.
d. Uncheck Web Server (IIS) and agree to remove any dependent features.
e. Click Remove.
f. Click Close.
g. When prompted, restart the server.

5. Install .NET 4.0 Framework. If already present on the target system, repair it with the 
installer option.
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6. Install IIS 7 with ASP.NET and IIS 6 Management Compatibility as follows:

a. Open the Server Manager and select Roles.
b. When the Roles page appears, click Add Roles.
c. Click Server Roles.
d. Check Web Server (IIS) and click Next.
e. Click Next.
f. Enable ASP.NET, IIS 6 Management, and all IIS 6 Management subcomponents, 

and click Next.
g. Click Install.

7. To start the Vantage Web applications installation, run the Vantage Web 
Applications installer file: For example, 
VantageWebApplicationsSetup_xx.xx.xxx.xxxxx.msi.

8. When the Welcome Window appears, click Next.

9. Read the license agreement, and if you accept the terms, click I Agree, and click 
Next.

10. When the Installation Notes dialog appears, read the installation notes, and click 
Next.

11. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings to meet your server requirements, 
and click Next.

Note: The Application Pool setting automatically defaults to ASP.NET 4.0. If it is not set 
to ASP.NET 4.0, there is an issue with the IIS or .NET installation.

12. Click Next to confirm installation.

13. When the Installation Complete dialog appears, click Close.

14. If Vantage services were running before the Vantage Web Applications installation, 
restart those services using the Microsoft Services tool (Start > Administrative Tools 
> Services).

15. Provide the Vantage Web Applications login requirements to each of your Vantage 
users, so that they know how to access them.

For example, send Vantage users an email with this suggested text: “You can access 
the Vantage Web Applications at http://[hostname]/Vantage,” where [hostname] is 
the server where you installed them.

Note: For information on the browser requirements for Vantage Web Applications, 
see Vantage Web Applications Browser Requirements.

Note: If your installation uses the Vantage Workflow Portal Web application, 
configure support for this program as described in Managing Alias Support for the 
Vantage Workflow Portal Web Client.
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Upgrading Vantage Web Applications

Note: If you are upgrading the Vantage Web Applications on a server that also hosts 
Vantage services, the Vantage Web Applications upgrade will stop those services, 
which will interrupt Vantage operation. Plan to upgrade the Vantage Web 
Applications when the upgrade will cause the least interruption to Vantage users. This 
is not an issue when the Vantage Web Applications are installed on a dedicated server.

If you are upgrading the Vantage Web Applications from version 3.0 to 4.0, you do not 
need to repeat the IIS and .NET server preparation described for new installations. To 
upgrade Vantage Web Applications from 3.0 to 4.0, do the following:

1. Uninstall the version 3.0 application as described in Uninstalling Vantage Web 
Applications.

2. To start the Vantage Web applications installation, run the Vantage Web 
Applications installer file: For example, 
VantageWebApplicationsSetup_xx.xx.xxx.xxxxx.msi.

3. When the Welcome Window appears, click Next.

4. Read the license agreement, and if you accept the terms, click I Agree, and click 
Next.

5. When the Installation Notes dialog appears, read the installation notes, and click 
Next.

6. When the Select Installation Address dialog appears, click Next to accept the 
default configuration, or change the settings to meet your server requirements, 
and click Next.

Note: The Application Pool setting automatically defaults to ASP.NET 4.0. If it is not set 
to ASP.NET 4.0, there is an issue with the IIS or .NET installation.

7. Click Next to confirm installation.

8. When the Installation Complete dialog appears, click Close.

9. If Vantage services were running before the Vantage Web Applications upgrade, 
restart those services using the Microsoft Services tool (Start > Administrative Tools 
> Services).

Note: For information on the browser requirements for Vantage Web Applications, 
see Vantage Web Applications Browser Requirements.
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Troubleshooting Vantage Web Applications Installation
The following are some symptoms and remedies that apply to troubleshooting the 
installation of the Vantage Web Applications:

• HTTP 500.19 error appears in the browser when you attempt to access the Vantage 
Web Applications after a new install.

Run the ASP.NET registration tool (aspnet_regiis.exe) to fix the .Net installation. For 
more information, refer to the Microsoft MSDN Web site.

• If your Web applications do not display correctly, it is likely due to problems with 
.NET Framework 4.0 not being installed correctly.

To solve this problem, uninstall IIS, repair .NET 4.0, and reinstall IIS with ASP.NET and 
IIS 6 Management Capability.

Moving the Vantage Domain Database to Another 
Database

You might want to move the Vantage domain database because:

• You are upgrading SQL Server from Express to Standard

• You are upgrading SQL Server from 2005 to 2008

• You are moving the database from one server to another

Note: If you are moving the database in conjunction with a Vantage upgrade, you 
should complete the upgrade prior to moving the database.

Note: This guide does not provide instructions for moving a mirrored database. 
Consult your database administrator or contact your Telestream representative 
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following sections in 
the sequence presented:

1. Preparing for the Move

2. Backing up the Existing Database

3. Removing the Vantage Domain Database

4. Removing Microsoft SQL Server

5. Installing SQL Server 2008 Standard

6. Configuring SQL Server Standard Memory Settings

7. Installing the Vantage Domain Database

8. Restoring the Vantage Domain Database Backup

9. Finishing the Move
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Note: This procedure backs up the database, moves the database to a different 
SQL Server version and/or server, and restores the database. Vantage does not 
support a Vantage restore from a version 3 Vantage database to a version 4 domain.

Preparing for the Move
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database, but it isn’t required. However, if you are moving the Vantage domain 
database to a new server, you must backup the database, as the backup file will be used 
to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new 
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status 
Views web application, or Vantage Dashboard to either determine when all jobs are 
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do the following:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

When you move the Vantage domain database from one server to another, the 
Storage, Variable, and Qualification rule configuration for each service is lost. 
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost 
when you change the SQL Server version on a server. Skip to Step 4 if you are not 
moving the Vantage domain database to a different server.

b. In the Vantage Management Console, remove all services from the Vantage 
domain as described in Removing a Service from the Domain.

Note: If you have a Team Management, Enterprise Control, or Master Control license, 
the default Vantage user account is Administrator with no password. This account has 
administrative privileges.

c. In the Vantage Management Console, select Licenses in the component panel.
d. On the Licenses tab, select all licenses and click the Delete button .

Note: To add the licenses back a the end of this procedure, you will need access to the 
license files. If you do not know where these files are, you might want to postpone the 
move until you have located them.
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4. If you are changing the Microsoft SQL version on a server (and not moving the 
database to another server), place all services in Maintenance Mode as described in 
Entering and Exiting Service Maintenance Mode.

Backing up the Existing Database
If you are upgrading SQL Server, it is recommended that you back up the Vantage 
domain database, but it isn’t required. However, if you are moving the Vantage domain 
database to a new server, you must backup the database, as the backup file will be used 
to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the 
new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select 
Domain Backup/Restore in the component panel, click Backup, and use the file save 
dialog to save the backup file to a safe location.

You will need to access the backup file to restore the Vantage domain database 
after you move it. For more information, see Using Backup and Restore Utilities.

2. Close all Vantage clients, including Vantage Workflow Designer, Vantage Web 
applications, Vantage Workflow Portal, and Vantage Management Console.

Removing the Vantage Domain Database
To remove the Vantage domain database, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

Removing Microsoft SQL Server
When you are upgrading Microsoft SQL Server, you will need to remove either 
Microsoft SQL Express or Microsoft SQL Server 2005. If Microsoft SQL Server 2008 
Standard is installed and you are moving the Vantage domain database to another 
server, you might want to remove Microsoft SQL Server 2008 Standard. 

To remove Microsoft SQL Server, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.
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3. If Microsoft SQL Server 2008 Express or Standard is installed, do the following:

a. Select Microsoft SQL Express or Microsoft SQL Standard and click Remove or 
Uninstall.

b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.

4. If Microsoft SQL Server 2005 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2005 and click Remove or Uninstall.
b. In the Component Selection dialog, check Remove SQL Server 2005 instance 

components, select VANTAGE: Database Engine, check Workstation Components, 
and click Next.

c. Click Finish.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLEXPRESS and VANTAGE for example), you 
will need to remove them both.

5. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. For information on removing the database files, 
see Removing Vantage Domain Database Files.

At this point, the Vantage domain database and the SQL Server are removed from the 
server and any Vantage services and clients that were installed on the server remain 
installed. The domain cannot resume operation until the Vantage domain database 
and SQL Server are reinstalled on this server or set up on another server.
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Installing SQL Server 2008 Standard
This procedure begins the set up of the Vantage domain database and the SQL Server 
on the server from which you just completed the uninstall or on a new server. The first 
step is to install Microsoft SQL Server 2008 R2 Standard so that Vantage discovers the 
server instance when you install the Vantage domain database.

To install SQL Server 2008 Standard on a server, follow these steps:

Note: This guide does not provide instructions for installing a mirrored database and 
implementing mirroring. Consult your database administrator or contact your 
Telestream representative regarding installation service options.

1. Log on to the target server with a local administrator account.

2. Insert the SQL Server 2008 Standard DVD into the server and start the installer 
(setup.exe) if it does not run automatically.

3. SQL Server Installation Center—Click Installation in the left column, then select 
New installation or add features to an existing installation.

4. Setup Support Rules—Click OK.

5. Product Key—Enter your product key and click Next.

6. License Terms—Accept the license terms and click Next.

7. Setup Support Files—Click Install, allow the installer to complete its actions, then 
click Next.

Note: If Restart computer... Failed displays in the report, this is due to a bug in the SQL 
Server 2008 Standard R1 installer. 
To correct the problem, run Regedit and navigate to this key: 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\PendingFileRenameOperations. Clear the Value Data string.
After you clear the Value Data string, return to Setup Support Rules and click Re-run on 
the right by the status bar. The Setup Support Rules should complete successfully—
click OK to continue.

Note: On SQL Server 2008 R2 only, select SQL Server Feature Installation and click 
Next.

8. Feature Selection—Do the following:

a. Check Database Engine Services and Management Tools.
b. If you are installing the database on a separate drive (see Database Selection and 

Configuration Guidelines), change the directories listed for shared features to 
another drive. For example:

Shared feature directory: D:\Program Files\Microsoft SQL Server\
Shared feature directory (x86): D:\Program Files (x86)\Microsoft SQL Server\

c. Click Next.
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9. Instance Configuration—Do the following:

a. Select Named instance and enter VANTAGE in the Named instance field and the 
Instance ID field.

b. If you are installing the database on a separate drive (see Database Selection and 
Configuration Guidelines), change the Instance root directory to refer to the correct 
drive.

c. Click Next.

10. Disk Space Requirements—Click Next to continue.

11. Server Configuration—Do the following:

a. For SQL Server Agent, select NT AUTHORITY\NETWORK SERVICE.
b. For Server Database Engine, select NT AUTHORITY\NETWORK SERVICE
c. Click Next to continue.

12. Database Engine Configuration—Do the following:

a. Click Add Current User.
b. Select Mixed Mode.
c. Enter the Vantage sa user password (vantage12!) in the Enter Password and 

Confirm Password fields.
d. Click Next to continue.

13. Continue to click through the installer windows accepting the default settings to 
complete installation.

14. Complete—Click Close to close the installer.

Configuring SQL Server Standard Memory Settings
When using SQL Server Standard, the maximum server memory for SQL should be set 
to utilize a maximum 75% of the system's memory.

1. On the target server, select Start > Microsoft SQL Server 2008 R2 > SQL Server 
Management Studio.

2.  Connect to the Vantage domain database using the following information:

Server type: Database Engine
Server name: [hostname]\VANTAGE
Authentication: SQL Server Authentication
Login: sa
Password: vantage12!

3. In the Object Explorer panel, right-click [hostname]\VANTAGE and select Properties.

4. In the Server Properties window, go to the Memory page.

5. Set the Maximum server memory (in MB) to 75% of the system's memory. For 
example: If the system's memory is 8 GB (8192 MB), then the maximum server 
memory for SQL should be set to 6 GB (6144 MB) (8192 x 0.75 = 6144).

6. Click OK.

7. Close the SQL Server Management Studio.
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Installing the Vantage Domain Database
This task installs the Vantage domain database instance.

Follow these steps:

1. Log on to the database server with a local administrator account, and make sure 
that virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or 
systems, you must turn off Windows Firewall.

2. Locate the Vantage domain database installer (for example, 
VantageDatabaseSetup_SQL2008_xx.xx.xxx.xxxxx.exe), copy it to your server, or 
obtain the Vantage Installer CD.

3. Run the Vantage domain database installer, which extracts the components, then 
continues. Component installation takes a few minutes.

4. When the Vantage Domain Database Setup Wizard appears, click Next to display 
the license agreement.

5. License Agreement—Read the Vantage Software License Terms and Conditions, 
then click I Accept if you agree to license terms. Click Next.

6. Database Install Mode—Click Install new database and click Next to continue.

7. Destination Folder—Accept the default folder or click Change to select an alternate 
folder. Click Next.

8. Ready to Install Vantage Domain Database—Click Install to begin database 
installation. This process takes a few minutes to complete.

9. Completed...—When installation is complete, click Finish.

If you are upgrading SQL Server on the same server, the upgrade is almost complete. 
Vantage should have discovered the old database files. Now you need to finish the 
process as described in Finishing the Move. 

If the old database files are not found, or if you are installing the Vantage domain 
database on a different server, restore the database from the backup file as described in 
Restoring the Vantage Domain Database Backup.
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Restoring the Vantage Domain Database Backup
To restore the Vantage domain database using the backup file you previously created, 
follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of 
the Vantage domain changed to the name of the new host server.

2. In the Vantage Management Console, select the domain you want to modify, select 
Domain Backup/Restore in the component panel, click Restore, and use the file 
open dialog to select the file to restore.

For more information, see Using Backup and Restore Utilities.

Finishing the Move
To finish the move, you must enable the services you disabled when preparing for the 
move. If you moved the Vantage domain database to another server, you must also 
install the appropriate Vantage licenses. To return Vantage to operation, follow these 
steps:

1. If you changed the Microsoft SQL version on a server (and did not move the 
database to another server), do the following:

a. Remove all services from Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode.

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage 
Domain licenses as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Licenses in the component panel.

b. On the Licenses tab, click the Add License button  and use the open file dialog 
to select the license file.

If your domain has multiple license files (for multiple features), repeat this step 
for additional licenses.

3. If you moved the database to another server, update the configuration of services 
as follows:

a. In the Vantage Management Console, open the domain you want to modify, and 
select Services in the component panel.

b. In the Services panel, click the Add Service button  and use the dialog to select 
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for 
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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Adding a Server to a Vantage Domain
Table 7 lists the types of servers you might want to add to a Vantage domain and shows 
where you can find instructions for adding these servers.

Table 7. Adding Servers to a Vantage Domain

Server Type Instructions

Vantage Lightspeed 
server

A Vantage Lightspeed server can be added to a Vantage domain that uses 
Vantage version 4.0 or later. When you add a Vantage Lightspeed server 
to a Vantage domain, the Lightspeed server must be running the same 
Vantage version as the Vantage domain.

The Vantage Lightspeed server ships with an installed Vantage domain 
database, and all Vantage services on the Lightspeed server are assigned 
to that Vantage domain database. To add the Vantage services on the 
Lightspeed server to the existing domain, use the Vantage Management 
Console to reassign the services.

After you reassign the Vantage services, Telestream recommends that you 
remove the Vantage domain database on the Lightspeed server so that 
the old Vantage domain is no longer advertised to Vantage client 
programs and Web applications.

To remove the Vantage domain database from the Lightspeed server and 
reassign services, see Adding a Lightspeed Server to an Existing Vantage 
Domain.

Vantage domain 
database server

A Vantage domain can host one Vantage domain database, which can be 
installed on a single or mirrored database server. 

If your Vantage domain has a Vantage domain database on a single 
database server, you can do the following:

• Move the Vantage domain database to another server as described in 
Moving the Vantage Domain Database to Another Database.

• Add a database server to mirror the current server. 

This guide does not provide instructions on setting up a mirrored 
database server. Consult your database administrator or contact your 
Telestream representative regarding installation service options.
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Adding a Lightspeed Server to an Existing Vantage 
Domain

This topic describes how to add a Lightspeed server to an existing Vantage domain. A 
Vantage domain can host just one Vantage domain database. When you add a 
Lightspeed server to an existing domain, Telestream recommends that you remove the 
Vantage domain database and SQL Server on the Lightspeed server so that Vantage 
does not advertise the unused Vantage domain on the Lightspeed server, and so that 
memory used by the SQL Server becomes available for Vantage use.

Note: The Lightspeed server and the existing Vantage domain must be using the 
same Vantage release, which must be Vantage 4.0 or later.

To add a Lightspeed server to an existing Vantage domain, follow the procedures in the 
following sections in the sequence presented:

1. Moving Licenses to Another Domain

2. Moving Vantage Services to Another Domain

3. Setting the Vantage Windows Log On ID for a Service

4. Removing the Vantage Domain Database

5. Removing Microsoft SQL Server

Moving Licenses to Another Domain
Any purchased licenses that have been added to the Lightspeed server should be 
removed from the Lightspeed server so they can be added to the existing domain. 
Most Vantage domains have a single license that contains multiple license options. 
However, Vantage can accept and combine license options in multiple license files. In 
most cases, you need to remove the license from the Lightspeed server and contact 

Vantage array server Additional Vantage array servers add more throughput capacity to your 
Vantage domain. When you add a Vantage array server to a Vantage 
domain, the server must be running the same Vantage version as the 
Vantage domain. For instructions on adding a Vantage array server, see 
Setting Up Vantage Array Servers.

Vantage Web 
Applications server

For instructions on adding a Vantage Web applications server, see 
Installing and Upgrading Vantage Web Applications.

Vantage store You can add multiple Vantage stores to a domain. A Vantage store can 
reside on a dedicated server or with Vantage services. For instructions on 
setting up a Vantage store, see Setting Up a Vantage Store.

Table 7. Adding Servers to a Vantage Domain (Continued)

Server Type Instructions
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Telestream to arrange a Lightspeed server update to the license for the existing 
domain.

To delete licenses from the Lightspeed server and add them to the existing Vantage 
domain, do the following:

1. In the Vantage Management Console, open the domain for the Lightspeed server, 
and select Licenses in the component panel.

Note: If you have a Team Management, Enterprise Control, or Master Control license, 
the default Vantage user account is Administrator with no password. This account has 
administrative privileges.

2. Place all services in Maintenance Mode as described in Entering and Exiting Service 
Maintenance Mode.

3. On the Licenses tab, select all licenses and click the Delete button .

Note: To add licenses to the other domain, you will need access to any license files 
sent from Telestream or an updated license file for the other domain.

4. In the Vantage Management Console, open the domain to which you want to add 
the licenses, and select Licenses in the component panel.

5. If you are updating the license for the existing domain, do the following:

a. Select the license you are updating and click the Delete button .
b. Click the Add License button  and use the open file dialog to select the 

updated license file.

6. If you are adding licenses to the existing domain, click the Add License button  
and use the open file dialog to select a license file.

Repeat this step for additional licenses.

7. Take all services out of Maintenance Mode as described in Entering and Exiting 
Service Maintenance Mode.

Moving Vantage Services to Another Domain
To move services from the Lightspeed server domain to the existing Vantage domain, 
do the following:

1. In the Vantage Management Console, open the existing domain to which you want 
to add the Lightspeed server services.

2. Select Services in the component (left) panel.

3. Click the Add Service button  to display the Select Service dialog. 

The Select Service dialog lists all Vantage services running in this subnet, and the 
list includes unassigned services and services running on other Vantage domains.
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4. Select one or more Lightspeed server services to add to this domain, and click OK 
to add them.

Services are identified by name, machine, and Vantage domain. Use the machine 
name to identify the services on the Lightspeed server. To select multiple services, 
use shift-click to select a series of services, or use option-click to select individual 
services.

5. If you are moving a service from one domain to another, the Management Console 
displays the Reassign Services window. Click OK to add them to this domain.

Setting the Vantage Windows Log On ID for a Service
On the Lightspeed server, the default log on ID for each Vantage service is the Local 
System account. This log on ID provides access to files on the local server only. If a 
service, such as Multiscreen, requires access to files on another server, the Local System 
account cannot provide that access. If Vantage services need access to input folders, 
output folders, or a Vantage store that is on another computer, you must do the 
following:

• Create a Vantage Windows user ID for the service

• Grant access to the Vantage Windows user ID for the appropriate file space on other 
file systems.

For more information, see Windows Authentication Guidelines.

All Vantage services except the following require a Vantage Windows user ID to access 
files on other computers:

• Agility

• Catalog

• Sdk

Within a single service, the Windows log on ID for that service must be the same on all 
Vantage servers in the domain. For example, all Analysis services within the domain 
must use the same log on ID. However, the Catalog service, which does not access files, 
can remain set to use the Local System account.

To change the log on ID for a Vantage service, do the following for that service on each 
Vantage server in the distributed domain:

1. Log on to the target server with a local administrator account.

2. On the Vantage server, select Start > Administrative Tools > Services.

You can also select Start, type services.msc in the search box, and press Enter.

3. Right click on a Vantage service and select Properties. (All Vantage services begin 
with the word Vantage.)

4. Select the Log On tab.
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Figure 7. Vantage Service Log On Properties

5. Select This account.

6. Click Browse and use the Select User dialog to select the Vantage Windows user 
account name (for example, VantageWinUser), then click OK.

If the Vantage Windows user name has not been defined, it will not appear in the 
browser. You can also enter a user name in the This account text box. For informa-
tion on the Vantage Windows user name and how to create it, see Windows Authen-
tication Guidelines.

Note: All Vantage services in a Vantage domain should be located in the same 
Windows domain. In Figure 6, Starfleet represents the Windows domain.

7. Enter the password for the Vantage Windows user in the Password and Confirm 
password text boxes, then click OK.

8. Repeat Steps 3 to 7 as needed for the other Vantage services.

Note: In some cases; you may be required to indicate that the specified user has been 
granted log on as a service right. If the service fails to start and displays an error 
indicating that the service log on user name may not have the necessary permissions, 
consult your IT administrator to set the appropriate rights for the new account.

9. Restart any updated services.
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Removing the Vantage Domain Database
To remove the Vantage domain database, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

Removing Microsoft SQL Server
To remove Microsoft SQL Server, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs (Control Panel > Programs and 
Features > Uninstall Programs).

3. Remove Microsoft SQL Server 2008 Standard as follows:

a. Select Microsoft SQL Standard and click Remove or Uninstall.
b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLSTANDARD and VANTAGE for example), you 
will need to remove them both.

4. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. For information on removing the database files, 
see Removing Vantage Domain Database Files.
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Verifying DTC Service Settings
During installation, Vantage configures and starts the Distributed Transaction 
Coordinator (DTC) Windows service. There is no need to verify DTC configuration and 
operation after the install, but if you suspect that the DTC service has stopped or the 
DTC configuration has changed, you can use the information in this topic to verify the 
DTC status and configuration.

Vantage uses DTC for communication between services and the SQL Server database to 
guarantee that messages are processed as atomic messages (that is, the entire message 
is successfully processed or the database state is reverted to the pre-message state). 
This guarantees that services do not duplicate jobs and that jobs do not register in a 
partial or incomplete state in the database. 

In a Vantage domain, DTC must be running and correctly configured on each Vantage 
database server and Vantage server, or Vantage services cannot communicate with the 
Vantage domain database, and the domain stops operation.

To verify operation and configuration, use the procedures in the following topics:

 Verifying DTC Operation

 Verifying the DTC Configuration

Verifying DTC Operation
To verify that the DTC is running, do the following:

1. In Windows, select Start > Administrative Tools > Services.

2. Verify that the startup type for Distributed Transaction Coordinator is set to 
Automatic.

3. If you need to change the startup type, do the following:

a. Right-click on the Distributed Transaction Coordinator service and select 
Properties to display the Properties window.

b. Select Automatic from the Startup Type dropdown and click OK.

4. If the DTC service is not running, right click on the service name and select Start.

Verifying the DTC Configuration
To verify that DTC is configured correctly, do the following:

1. In Windows, select Start > Administrative Tools > Component Services.

2. In the left pane, navigate to Component Services >Computers > My Computer > 
Distributed Transaction Coordinator. 

3. In the right pane, right-click Local DTC and select Properties.

4. Click the Security tab.

5. To enable transactions to properly flow from one machine to another, set the 
Security configuration settings as shown in Figure 8, and click OK.
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Figure 8. DTC Security Settings

Note: You have to restart the database instance in order for SQL to receive 
notification of the changes to the DTC. You can restart the database by restarting the 
server that the database is on.
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Using the Vantage
Management Console

This chapter describes how to use the Vantage Management Console.

The Vantage Management Console is a Windows MMC snap-in that enables Vantage 
system administrators to configure their Vantage domain and to scale Vantage services 
across multiple servers (creating a distributed Vantage domain) to meet their operating 
requirements.

Note: Features in products for which you don't have a license are disabled and 
indicate that you need a license to use them.

The following topics describe how to use the Vantage Management Console:

 Introduction

 Starting the Vantage Management Console

 Managing the Domain Connection

 Using the Vantage Management Console Workspace

 Settings and Options

 Catalogs

 Storage

 Services

 Licenses

 Status

 Workflow Design Items

 Domain Workflow Analytics

 Support Utilities

 Application Configurations

 Report Configurations

 User Management

 Domain Backup/Restore

 Using the Help System

 Renaming a Vantage Domain
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Introduction
The Management Console is designed to facilitate centralized management of the 
software components and resources that comprise a Vantage domain, including 
settings and options, Vantage catalogs, Vantage stores, Vantage services, licenses, 
workflow design items, and client application configurations. The Management 
Console also provides real-time status details for services, machines, and the domain at 
large, plus a domain backup/restore utility and other support utilities.

The Management Console manages a single Vantage domain at a time. 

CAUTION: Although the Management Console is a multi-user application, when used 
for modifying a domain, it is intended for use by one user on one domain at a time. 
Connecting multiple consoles to the same Vantage domain for any other purpose 
than viewing status and configuration details is not recommended and can lead to 
domain configuration problems.

Each Vantage domain includes a single Vantage domain database, which consists of a 
Microsoft SQL Server instance, Vantage domain database software, and database files. 
All configurations that you create with Management Console are stored in the Vantage 
domain database.

Many organizations implement Vantage as a single domain. However, in large facilities, 
you may have several separate and independent Vantage domains for scaling to high-
volume workflow processing or for specialization and departmentalization purposes.

In a facility with multiple Vantage domains, you can connect to any Vantage domain in 
the network from any Management Console in the network, for more centralized 
management and control.

Starting the Vantage Management Console
To start the Vantage Management Console, do one of the following:

• Select Start > Programs > Telestream > Vantage > Vantage Management Console

• Double-click the Vantage Management Console shortcut on your desktop:

Figure 9. Management Console Shortcut.

After you start the Management Console, your domain configuration may prompt you 
for additional information, which is described in the following sections:

 Selecting a Domain

 Entering a Username and Password
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Selecting a Domain
Each time you start the Management Console, the program connects to the last 
domain to which it was connected. If you are starting the program for the first time, the 
Management Console polls the network for domains in the same subnet, and displays 
the domains that responded in a list (Figure 10).

Figure 10. Vantage Domain Selection Panel

To select a domain, do the following:

1. If the domain you want appears in the list, select the domain (Figure 10). 

2. If the Vantage domain’s SQL database default username and password were 
changed during installation, do the following:

a. Click Connection Settings to display a dialog that you can use to specify the 
correct username and password for the MS SQL Server (Figure 11).

Figure 11. MS SQL Login Settings

b. Enter the Vantage domain database SQL Server account username and password 
(obtained from your Vantage administrator).
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3. If the domain you want is not in the list (not in your current subnet), do the 
following:

a. Click My Vantage Domain isn’t Listed to display a dialog to manually enter the 
domain (Figure 12).

Figure 12. Vantage Domain Server Identification

b. Enter the computer name or IP address (for example, VantageServer203 or 
192.168.1.1).

4. Click OK to continue.

Entering a Username and Password
If you have not installed the Team Management, Enterprise Control, or Master Control 
license, or if the user management feature is disabled, Vantage does not require you to 
enter a user name and password when starting the Management Console. Anyone with 
access to your computer can open the Management Console and manage the domain.

When the Team Management, Enterprise Control, or Master Control license is installed 
and user management is enabled (see User Management), Vantage prompts you for 
user information when you start the Management Console (Figure 13).

Figure 13. Logging in to the Management Console.

Enter your Vantage username, and password, if required, and click OK to connect.

The default Vantage user is Administrator, with no password assigned—this user has 
Administrator privileges. Only Vantage users who are administrators can log into the 
Management Console.

Note: All user passwords are encrypted in the Vantage domain database.
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Managing the Domain Connection
The Management Console connects to one domain at a time. You must connect to a 
domain before you can use the console to manage that domain. In an environment 
where more than one Vantage domain is operating, you can use the same 
Management Console to connect to any single domain.

The following sections describe tasks for managing your domain connection:

 Identifying the Selected Domain

 Selecting a Different Domain

Identifying the Selected Domain
Each Vantage domain is identified by the name of the computer on which the Vantage 
domain database instance is running. To determine the domain to which the Vantage 
Management Console is currently connected, note the computer name of the Vantage 
Domain component in the component panel or click to display its details panel.

To display the Vantage Domain details panel, which enables you to connect to another 
Vantage domain, click the Vantage Domain button  in the component panel.

Figure 14. Vantage domain component.

Click Select to discover and display all other 
Vantage domains on the network.

Select Vantage Domain to display its details panel.

Current Vantage 
domain.
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Selecting a Different Domain
To select a different Vantage domain, do the following:

1. Select the current domain in the component panel, which is the left panel in the 
Management Console display.

2. In the Vantage Domain details panel (the right-hand panel), click Select.

3. Select a domain as described in Selecting a Domain.

When you change domains, the Management Console closes its connection to the 
current domain’s Vantage domain database and connects to the new domain’s 
database, refreshing the details of all of its components.

Using the Vantage Management Console 
Workspace

The Management Console workspace is composed of panels you utilize to configure 
and manage all of the components that comprise a Vantage domain to meet your 
operating requirements.

Figure 15. The Vantage Management Console workspace.

Component Panel
On the left is the domain component panel, which lists Vantage domain components 
that are arranged hierarchically under the domain they support.

Details panel—view & update selected 
component details.

Component panel displays 
domain components.
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Details Panel
To the right of the component panel is the details panel. The interface displayed in the 
details panel is specific to the selected component.

For example, when you select Catalogs, the Vantage Management Console displays a 
comprehensive, three panel interface designed so that you can manage your catalogs. 
When you select Licenses, the Management Console displays a simple file table, with 
details about each license, and you can view the contents of a given license.

To learn how to use each component, select it and then click the Online help button in 
the toolbar to display its topic. For specific details about each control in a component, 
display the tooltip for the control by hovering your cursor over the control.

Settings and Options
The Settings & Options component provides tabs for the following:

 General Settings

 Email Settings

 Authorization Settings

 Configuring an Agility ECS Server

General Settings
The General tab provides controls that you can use to complete the following tasks:

 Managing Load Balancing

 Enabling and Disabling User Administration

 Enabling and Disabling Expiration of Failed Jobs

 Setting the Vantage Workflow Designer Grid Width/Height

 Restoring Tips and Warnings

 Hiding Tips and Warnings

Managing Load Balancing
The following sections provide information on managing load balancing:

 Overview of Load Balancing

 Examples of Cost-Based Load Balancing

 Enabling and Disabling Cost-Based Load Balancing
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Overview of Load Balancing

Load balancing distributes the processing of individual workflow actions between the 
same service on multiple Vantage servers. For example, if you have the Transcode 
service running on three Vantage servers, the Flip action, which is processed by the 
Transcode service, can run on any of the servers. Load balancing determines which 
server receives the action to process.

Vantage supports session-based load balancing and cost-based load balancing.

Session-based load balancing requires a Vantage Array license and allows you to 
distribute the processing of service actions across multiple servers that support the 
same service. Session-based load balancing distributes action processing among the 
available servers up to the configured session limit for each server. This load balancing 
is done by taking the CPU utilization of each machine into account, as well as ensuring 
that any Run On rules (which allow tasks to be routed to specific machines) are 
observed. When the configured limit is reached on all servers, actions are queued until 
the workload drops below the configured session limit.

Cost-based load balancing requires the Enterprise Control or Master Control license 
and is similar to session-based load balancing. Cost-based load balancing allows you to 
do the following:

• Assign a default cost for each type of action used in workflows

• Define a target resource usage level for each service on a server

• Override the default action cost in workflows as needed

Note: Session limits are ignored when cost-based load balancing is enabled, and the 
target resource usage level is ignored when session-based load balancing is enabled.

To determine its available resources, each service monitors the total cost of all actions it 
is processing and compares that cost to the configured target resource usage level for 
that service. A service can accept an action for processing if the available resource 
usage is at least half the cost of the action.

Actions are assigned to services in the order they are processed, which prevents low 
cost actions from consuming all service resources and starving higher-cost actions. 
Each action is forwarded to the service with the most available resources. If the action is 
forwarded to a service that does not have resources to immediately process the action, 
the action is queued for later processing.
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To implement cost-based load balancing, enable the feature (as described in Enabling 
and Disabling Cost-Based Load Balancing) and monitor the following:

• The server performance using server monitoring tools.

• The Services panel in the Management Console, which displays a list of services, 
including the current and target resource usage levels. For more information, see 
Using the Services Details Panel.

If the server is under- or over-loaded, you might adjust the default target resource 
usage level for each service as described in Configuring Vantage Services.

If you want to adjust the default cost of an action, see Action Defaults. For information 
on overriding the default action cost in a workflow, see the Vantage User’s Guide.

Examples of Cost-Based Load Balancing

You can use the target resource usage setting to limit the total action cost that a service 
will simultaneously process. For example, if you configure the Transcode service for a 
target resource usage of 16 and you configure the default Flip action resource cost to 4, 
the Transcode service supports a maximum of 4 simultaneous Flip actions.

Some services support multiple actions, and you can set the action resource cost for each 
action to a different value to define the relative usage levels. For example, the Transport 
service supports the Copy, Delete, Deploy, and Move actions, which are assigned default 
resource costs of 2, 1, 1, and 2, respectively. Based on the default values, a Transport 
service can support twice as many Delete and Deploy actions as Copy and Move actions.

Different codecs require different levels of processing resources. Using Workflow 
Designer, you can override the default resource cost for specific actions within a 
workflow. For example, you might configure a Transcode service to target resource 
usage of 16, specify a resource cost of 1 for a 3GP Flip action, and a resource cost of 8 for 
an MPEG-2 HD Flip action. During load balancing, Vantage will ensure that:

• No more than two MPEG-2 HD jobs execute simultaneously

• Up to 16 3GP jobs can execute simultaneously

• One MPEG-2 HD and eight 3GP jobs can execute simultaneously in ideal situations

• MPEG-2 jobs are not starved by 3GP jobs which only require one slot

Note: Resource costs are integer values that have an ordinal relationship to one 
another. You can implement any scale you want in your domain. Greater scales enable 
finer-grained control.
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Enabling and Disabling Cost-Based Load Balancing

 

To enable or disable cost-based load balancing, do the following:

1. Start the Management Console as described in Starting the Vantage Management 
Console.

2. In the component panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable cost-based load balancing 
checkbox to enable this feature, or clear the checkbox to disable this feature.

4. Click the Save button .

5. When the Service Restart Required dialog appears, click OK.

6. Restart all Vantage services as described in Entering and Exiting Server Maintenance 
Mode.

Enabling and Disabling User Administration
 

To enable or disable user management, do the following:

1. Start the Management Console as described in Starting the Vantage Management 
Console.

2. In the component panel, select Settings and Options.

3. On the General tab in the details panel, check the Enable user administration 
checkbox to enable this feature, or clear the checkbox to disable this feature.

For instructions on managing Vantage users, see User Management.

Note: When you disable user management, users do not need to enter a user name 
and password to log in to Vantage Management Console, Vantage Workflow Designer, 
or the Vantage Workflow Portal client application. To access most Vantage Web 
applications, users must enter a user name and password. The exception for Vantage 
Web applications is Job Status Views. When public access is configured for Job Status 
Views, users do not need to enter a user name and password.

Enabling and Disabling Expiration of Failed Jobs
Each job has an expiration time and date, which can be disabled. If a job completes 
successfully and job expiration is enabled, the binder and all job-related files in the 
Vantage store are deleted at the end of the expiration period. If a job fails and the 
expiration period ends, the job is either retained or deleted, based on the configuration 
for this feature.
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To enable or disable expiration of failed jobs, do the following:

1. Start the Management Console as described in Starting the Vantage Management 
Console.

2. In the component panel, select Settings and Options.

3. Select the General tab.

4. To enable expiration of failed jobs, check the Expire failed jobs checkbox.

5. To retain failed jobs until manually deleted, clear the Expire failed jobs checkbox.

6. Click the Save button .

Setting the Vantage Workflow Designer Grid Width/Height
This feature is available in all products. Enter the default width and height values of the 
Workflow Designer grid.

Restoring Tips and Warnings
Click to restore tip and warning messages that were previously disabled by clicking 
“Don’t show me this again”. When tips and warnings are restored, these tips and 
warnings will again display as you interact with the Management Console.

Hiding Tips and Warnings
Click to disable all tip and warning messages. These messages can also be individually 
disabled by clicking “Don’t show me this again” when they appear.

Email Settings
Vantage can send email messages to announce workflow and service events.

Message actions in Vantage workflows can be configured to send email messages for 
workflow events. The configured email destination address can be for an individual, a 
system, or an alias for a group of Vantage users or administrators. 

Note: Until you configure these settings, you won’t be able to execute message 
actions that utilize email in your workflows.

If a Vantage Service starts or stops running, or if a service fails, an email is sent to the 
administrator email address.

Note: An email is not sent when a Vantage Service enters or exits Maintenance Mode.

Use the Email Settings tab to configure your SMTP host for outbound email 
transmission from Vantage. 
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Authorization Settings
Use the Authorization Settings tab to maintain the special credentials that Vantage 
services can use to access network servers to process files. These credentials typically 
supplement the normal Windows domain credentials supplied for each service.

To manage authorization settings, click the Settings & Options > Authorization tab.

Table 8. Email Tab Configuration Options

Option Description

Hostname or IP Address Supply the computer’s host name or IP address of the 
SMTP server.

SMTP Port Supply the port number of the SMTP server.

SMTP Host Requires 
Authentication

Check if the SMTP server is configured to require 
authentication.

Username and Password Supply the user name and password if SMTP Host 
Requires Authentication is checked.

This server requires an 
encrypted connection 
(SSL)

Check this checkbox if SMTP server requires an encrypted 
connection.

Administrator Email 
Address

Supply the email address of the Vantage administrator. 
The email specified for this account can be an alias for a 
larger group, maintained by your IT department.

Send Test Email Click to test your settings by sending an email to the 
administrator email address.

Email administrator upon 
service starting

Check to email the administrator when a service starts. 
For example, if a Vantage machine hosting an Analysis 
and a Monitor service is started without any problems, 
two emails are sent reporting the starting of each service.

Email administrator upon 
service stopping

Check this checkbox to email the administrator when a 
service stops.

Email administrator upon 
service failure

Check to email the administrator when this service fails 
(crashes or otherwise stops unexpectedly). For example, if 
a Vantage Analysis service is stopped from the Task 
Manager (forced termination), an email is sent to the 
administrator. Or, if a Vantage Analysis service crashes 
during start-up, an email is also sent to the administrator.
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The following sections provide information on managing authorization settings:

 Understanding Authorization Settings

 Refreshing the Authorization Record List

 Adding an Authorization Record

 Modifying an Authorization Credentials Record

 Deleting an Authorization Credentials Record

 Exporting and Importing Authorization Records

Understanding Authorization Settings
Authorization settings are considered supplemental to Windows account and share 
settings, which should be your primary means of providing access and authentication 
to required storage for Vantage services. When accessing computers in workgroups, 
users should make sure that Vantage services are running under an account that has 
access to the locations that will be referenced. If this is done, then authorization records 
are unnecessary unless some computers must have unique accounts.

Use the Authorization Settings tab to create and manage credentials for Windows 
shares (on Windows computers) or UNC paths, where media may be ingested, stored, 
or delivered by a Vantage service using an account that is different from its logon 
account, when this Windows account and share settings do not provide access.

When each service starts, it reads all authorization records and stores them for use at 
runtime, as necessary. For example, the transport service may be called to execute a 
copy action, which needs to write a file to a share or a non-domain server and directory, 
where the service is not authorized by its own account. The transport service will 
process the authorization records based on the path supplied, to determine if it can 
gain authority via one of its authorization records.

Note: Authorization settings should only be used when the normal Windows account 
and share settings do not provide access to necessary shares: for example, shares on 
other Windows domains, or on workgroups.

The purpose of entering authorization records is to enable Vantage to maintain this 
information for network locations—independent of the authentication inherent with the 
logon account of a specific service—the Vantage Monitor service, for example. If you 
know that a specific service doesn’t have the authorization to utilize a given network 
location, you can create an authorization record to provide credentials.

When you provide authorization records for a network location, any service in the 
domain can utilize it.

It is important to understand that when you access network locations via Vantage 
Workflow Designer, the locations you navigate to are accessed with Workflow 
Designer’s logon account permissions—which may be different than the logon 
account for Vantage services.
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However, these locations will ultimately be accessed by Vantage services during 
execution of your workflow—services which may have different users and permissions. 
Therefore, you need to take the extra step of ensuring that the service, which will be 
accessing this share at workflow runtime, has authenticated access to the location.

Additionally, authentication does not control sharing and security permissions (for 
example, access, and read/modify/delete/write permissions). Make sure that when you 
set up network locations, you have set each location with the proper permissions for 
the user accounts who will access it.

After you add, modify, or delete a record, click the Save button  to update the records 
in the Vantage domain database as encrypted data.

Refreshing the Authorization Record List
To refresh the list of authorization records, move a Vantage service in and out of 
maintenance mode as follows:

1. In the Vantage Management Console, click on Services in the details panel.

2. Right-click the target service and select Enter Maintenance Mode.

3. Right-click the service again and select Exit Maintenance Mode.

Figure 16. Authorization record management.

Adding an Authorization Record
Click the New Entry button  in the toolbar, and supply the details. Click Test to 
validate the record, and click the Save button to add this validated authorization record 
to the database for use by all Vantage services in the domain.
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Modifying an Authorization Credentials Record
Click on the record you want to modify. Make changes to the username, password, and 
folder and click the Save button  in the toolbar.

Deleting an Authorization Credentials Record
Click on the record you want to delete, click the Delete button  in the toolbar, and 
click OK to confirm.

Exporting and Importing Authorization Records
Vantage allows you to export an authorization record to an XML file, which you can 
then use to import the same record into another Vantage domain.

To export an authorization record, do the following:

1. Select the record to export.

2. Click the Export button .

3. Use the file system dialog to save the exported record.

The default file name is the record name, but you can change the file name.

Table 9. Authorization Tab Configuration Options

Option Description

Username Enter the authorized username required to access the 
Windows share identified by the UNC path.

If the user account is part of a Windows domain, the 
username must include the domain or computer name, in 
the format domain\username or 
ComputerName\Username. For example, 
SierraVideo\Vantage or NewsServer\Bill.

If the username is part of a workgroup (a non-domain 
account), you must provide the machine name in 
addition to the user name. For example, if you want to 
use the account: VantageUser that exists on machine 
FooServer1, you should specify FooServer1\VantageUser.

Password Enter the authorized password for the Windows share.

Folder Click Browse and navigate to the Windows share you are 
authenticating. Or, enter it manually. The path must be in 
valid UNC form: \\ComputerName\Sharename\.

Test Click Test to verify that your credentials are entered 
correctly for access to the specified Windows share.
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Note: Changing the name of the XML file does not change the name of the record in 
the XML file.

To import an authorization record, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the record to import, then click Open.

Note: If you try to import an authorization record that is already in this Vantage 
domain, Vantage prompts you to overwrite the record (click Yes) or cancel the import 
(click No).

Configuring an Agility ECS Server

When you configure an Agility ECS connection, you enable Vantage domain support for 
the following:

• Vantage client communications with Agility through the Agility service.

• Vantage Dashboard monitoring of Agility ECS server status and statistics.

To identify the Agility ECS server and test its connection, do the following:

1. Launch the Management Console and connect to the target Vantage domain.

2. Under the Vantage Domain option in the left pane, click Settings & Options.

3. Click the Agility ECS tab.

Figure 17. Identifying Agility ECS to Vantage.

4. Enter the Agility server’s host name or IP address.

5. If the default HTTP port value (80), is not correct, enter a new port number. 
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Note: If the Agility IIS server is using a port other than 80, enter that port number 
here.

6. To test the connection to the specified Agility ECS server, click Test Connection.

If there is a network problem, or you have supplied an invalid hostname or IP address, 
or the Agility server is not in a state where it can respond to queries, Management 
Console displays the following error: 

Figure 18. The Agility connection test has failed.

The connection to the Agility ECS server must be successful before you can use the 
action inspectors to configure Agility Job Profile and Agility Job XML actions in Vantage 
workflows and submit jobs.

Catalogs
Vantage catalogs allow you to organize your workflows for operator usage and to 
preserve binders beyond job expiration times and operator job deletions. Vantage does 
not require that you define and use catalogs, but if you are supporting Vantage 
Workflow Portal operators, catalogs can help you manage how operators use the 
workflows in your domain.

The Catalogs component in Vantage Management Console enables you to manage 
catalogs and the binders they contain. The following sections describe catalog 
management:

 Understanding Catalogs, Catalog Folders, and Binders

 Using the Catalogs Details Panel

 Creating and Deleting Catalogs

 Creating and Deleting Catalog Folders

 Configuring a Catalog or Folder Expiration Policy

 Managing Binders
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Understanding Catalogs, Catalog Folders, and Binders
The following topics discuss concepts that apply to the use of catalogs in a Vantage 
domain:

 Catalogs

 Catalog Folders

 Binders

 Binder Expiration and Related File Deletion

Catalogs
Catalogs are organization tools. Similar in concept to file folders that organize files, 
Vantage catalogs organize the binders that are created each time a workflow is run. 
(Binders can also be created manually in Vantage Management Console.) Vantage 
provides a default catalog named Default Catalog.

When your Vantage domain supports Vantage Workflow Portal operators, catalogs can 
be used to organize and control access to the binders for completed jobs. For example, 
Workflow Portal supports four configuration types, so you can create a catalog for each 
configuration type, or you can create catalogs for each configuration you create. 
Another option is to create catalogs for different organizations or departments. 
Workflow Portal operators can be restricted to managing binders in specified catalogs.

Workflows are not limited to accessing or registering media in a single catalog. For 
example, a given workflow might ingest media from Catalog A, produce another 
version of the content, and register the new content in Catalog B.

Catalog Folders
A catalog folder serves as a subfolder for a catalog or a catalog folder. Catalog folders 
allow you to further organize and group associated content together. For example, you 
might have a National Parks catalog, with a Yellowstone and a Yosemite folder. You can 
make as many folders as you need to organize your content, and you can create folders 
in a hierarchy.

Binders
When a workflow executes, Vantage creates a job and a binder, which is a collection of 
job-related references and metadata labels. The references in a binder identify media 
files and attachment (non-media) files such as XML or PDF files. The binder references 
identify the name and location of input, output, and temporary files used by a 
workflow. The information stored in a binder can be used to preview media, evaluate 
metadata and the success of a workflow, or as source material for another workflow.

Vantage stores binders in the Vantage domain database. If the workflow is associated 
with a catalog, the binder is also associated with the catalog. Workflow designers can 
associate a workflow with a catalog by adding the Register action to a workflow and 
configuring it for the appropriate catalog. Multiple catalogs can be associated with a 
workflow by creating multiple Register actions.
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When a binder is registered with a catalog, the catalog association can extend the 
binder lifetime in the Vantage domain beyond the expiration date associated with the 
job that created it. For example, if a job expires or is deleted, but the binder expiration 
time in the catalog has not expired, the binder and any related files in the Vantage store 
are retained.

Binder Expiration and Related File Deletion
To use storage space efficiently, Vantage can regularly delete binders and any 
associated temporary files in the Vantage store. When you configure binder expiration, 
binders and the related temporary files are deleted when all the following are true:

• The job expiration time is exceeded or an operator has deleted the job.

• The binder expiration time defined in the catalog is exceeded or the binder is 
deleted.

• Temporary files to be deleted are not being used by any other unexpired binder.

Note: Only files in a Vantage Store are automatically deleted according to the above 
rules. Files in an input or output folder can be deleted using a workflow Delete action, 
but input and output files are not automatically deleted when a binder expires.
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Using the Catalogs Details Panel
To prepare for catalog management, click Catalogs in the component panel (see 
Figure 19).

Figure 19. Vantage Catalogs Component.

Vantage Catalogs details panel enables you to 
manage catalogs and view binders.

Click Catalogs button in the 
component panel to display its details 

List of all 
catalogs and 
their folders in 
the Vantage 
domain.

Contents of the selected 
catalog or folder.
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To manage catalogs, use the controls in the Catalogs details panel (see Figure 20).

Figure 20. The Vantage catalog details panel.

The Catalog toolbar contains buttons for frequent tasks:

Figure 21. The catalog toolbar.

You can also use the context menu to perform the same tasks. Right-click on a catalog 
or folder to display a context menu for frequent tasks.

Catalogs Toolbar. 

Catalog explorer 
panel.

Media Files, 
Metadata Labels, 
and Attachments.

Catalogs/Folders/
Binders panel.

New catalog
New folder

New binder

Submit binder to workflow
Rename selected item

Delete selected item

Import folder

Refresh
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Creating and Deleting Catalogs
You can create as many catalogs as you need to meet the needs of your organization.

To create a new catalog, do the following:

1. Click the New Catalog button  in the toolbar.

The Vantage Management Console displays a new catalog in the catalog tree, with 
the default text selected.

2. Type in the name of the new catalog and click away from the catalog.

To delete a catalog, do the following:

1. Select the catalog to permanently remove.

2. Click the Delete button .

CAUTION: Removing a catalog permanently deletes binders and Vantage store files 
as described in Binder Expiration and Related File Deletion.

Table 10. Catalogs Panel Configuration Options

Option Description

Remove Select to permanently delete the selected catalog or 
folder.

Note: Removing a catalog/folder permanently deletes 
binders and Vantage store files as described in Binder 
Expiration and Related File Deletion.

Rename Select to rename the catalog/folder.

Import Folder Select to import a Windows directory of media, which is 
organized in the manner you want the catalog organized. 
Vantage replicates the directory structure, and create a 
binder for each media file located in the folder hierarchy 
being imported.

New Folder Select to create a new folder in the selected catalog.

New Binder Select to create a new binder in the selected folder or 
catalog.

Properties Select to display and configure properties (including the 
expiration time) for the selected catalog/folder. 
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Creating and Deleting Catalog Folders
Inside each catalog, you can create as many folders as you need to organize the media 
in this catalog. Folders can be created in a hierarchy, and you can drag them around to 
re-organize them.

To create a new folder, do the following:

1. Click the catalog or folder where you want to create a new folder.

2. Click the Add Folder button  in the toolbar.

The Management Console displays a new folder in the catalog explorer panel and 
also in the Folders panel, with the default text selected. 

3. Type in the name of the new folder and click away from the folder.

To delete a folder, do the following:

1. Select the folder to permanently remove.

2. Click the Delete button  in the toolbar.

CAUTION: Removing a catalog permanently deletes binders and Vantage store files 
as described in Binder Expiration and Related File Deletion.

Configuring a Catalog or Folder Expiration Policy
A catalog or folder expiration policy defines the default expiration policy for all binders 
in the catalog/folder. This policy can be overridden by a binder expiration policy as 
described in Configuring a Binder Expiration Policy.

To configure the binder expiration policy, do the following:

1. Right-click the catalog or folder you want to configure, and select Properties.

2. Edit the binder expiration date or check the Never Expire checkbox.

3. Click OK.

Note: The expiration policy can be set for individual binders when they are registered 
in a catalog; this is done using the workflow Register action.

Managing Binders
Each binder may contain references to media files, metadata, and attachments. You can 
view and manage these items by clicking the appropriate tab. You can also right-click a 
binder and select Properties to change the binder name or expiration policy.
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Figure 22. Binder assets—organized by tab.

The following topics describe binder management tasks:

 Creating and Deleting Binders

 Submitting Binders from the Management Console

 Renaming a Binder

 Configuring a Binder Expiration Policy

 Managing Media Files in a Binder

 Managing Metadata Labels in Binder

 Managing Binder Attachments

Creating and Deleting Binders
In normal operations, binders are created when a new job starts, and they are deleted 
as described in Binder Expiration and Related File Deletion.

Note: The Vantage Management Console controls for creating and deleting binders 
are provided for testing and troubleshooting, not for regular maintenance

To create a new binder, do the following:

1. Select the catalog to which you want to add the binder.

2. Click the New Binder button .

The Vantage Management Console displays a file system dialog so that you can 
navigate to and select the media you want to assign the binder. 

3. Select the target media file and click Open to create the binder for this media file.

To delete a binder, do the following:

1. Select the catalog and folder in which the binder resides.

2. Select the binder to remove.

3. Click the Delete button .

Media Files Toolbar. 

Mini-player controls.
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CAUTION: Removing a binder permanently deletes Vantage store files as described in 
Binder Expiration and Related File Deletion.

Submitting Binders from the Management Console
You can use the catalog feature in the Management console to submit binders to 
workflows. Binder submission in the Management Console is intended as a test/
diagnostic feature and is not recommended for regular use in production.

When submitting a binder, it is your responsibility to ensure that the binder contains 
the requisite items (source media, metadata labels and/or attachments) that the 
targeted workflow requires. If the binder specified does not contain all of the required 
items, the job will fail.

To submit a binder to a workflow from the Management Console, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Submit To Workflow.

Figure 23. Submit to Workflow dialog.

3. When the Submit To Workflow dialog appears, select a target workflow.

Select the 
workflow to 
which you want 
to submit the 
selected binder.

Click Submit to 
start the job.

Click Variables to submit them 
with the job.
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4. If you need to submit variables with the binder, do the following:

a. Click the Variables button.

The Vantage Management Console displays the Select Variable dialog 
(Figure 24).

Figure 24. Select the variables to submit with this job.

b. To add variables to the Variable list, click the Add Variable button , select one or 
more variables (control-click), and click OK.

c. To change a variable value, select a variable and change the value (which 
appears below the list).

The Vantage Management Console displays the Variables dialog, with the 
selected variables listed, so you can update the values:

Figure 25. Update variable values before submitting the job.

d. When all the variable values are set, click OK.

5. In the Submit To Workflow dialog, click Submit to process this binder using the 
selected workflow.

Select variables 
to submit.

Click OK to 
continue.

Select the 
variable to 
update its 
value.

Click OK to continue.Update the value in this field.
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To view job processing, open Vantage Workflow Designer, select the workflow, and 
click the Job Status tab.

Renaming a Binder
To rename a binder, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Properties.

3. Edit the binder name and click OK.

Configuring a Binder Expiration Policy
The binder expiration policy overrides the binder configuration policy for the parent 
catalog or folder.

To configure the binder expiration policy, do the following:

1. Select the catalog and folder in which the binder resides.

2. Right-click a binder and select Properties.

3. Edit the binder expiration date or check the Never Expire checkbox.

4. Click OK.

Note: The expiration policy can be set for individual binders when they are registered 
in a catalog; this is done using the workflow Register action.

Managing Media Files in a Binder
To view and manage the media files referenced in a binder, click the target binder in the 
binder list, then click the Media Files tab. You can add and delete media file references 
to a binder, and you can rename the media file names listed in the binder.

Adding a Media File Reference

When you add a media file to a binder, you select the file from a browse dialog, name 
the media file, and specify a media nickname.

Within a binder, each media and attachment file has a nickname; these nicknames are 
how Vantage workflows access the underlying files. Nicknames serve a dual purpose. 
First, because they are abstracted from the actual location of the underlying files, it 
allows workflows to be designed without worrying about the underlying file locations. 
Second, when a step in a workflow requires one or more input files, nicknames allow 
Vantage to pre-validate the workflow and availability of nicknames prior to execution.

However, binders may in fact be processed by more than one workflow simultaneously 
(either by using the Forward action or using the Workflow Portal). When this happens, 
Vantage cannot pre-detect which nicknames are necessary in each separate workflow. 
Administrators who build workflows in this way must take care to ensure that their 
design does not cause files necessary in one workflow to be deleted by another.
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To add a media file reference, do the following:

1. Click the Add Media File button  in the toolbar.

2. In the Select the Media Version text box, type a media nickname or select an 
existing media nickname from the drop down list.

3. Click the Browse button and use the browse dialog to select a media file.

4. In the Enter the Name text box, enter the media file name that appears in the 
binder.

Note: The filename you specify in this dialog applies only to the name displayed in 
the binder. The original media filename remains unchanged.

Removing a Media File Reference

To remove a media file reference from a binder, select the file, and click the Delete 
button  in the toolbar.

Note: Removing a file reference from a binder does not delete the source media file.

Renaming a Media File Reference

To rename a media file reference, click the media file name, and enter a new name.

Note: Renaming a media file does not rename the source media file.

Previewing a Media File

The preferred preview format for Vantage 4.0 is QuickTime H.264, and you can preview 
files that use this format in the Vantage Workflow Portal.

You can use the Management Console to preview ASF, WMV, and MP4 media files. 
Select the media file on the Media Files tab, and use the playback controls below the 
media display area to the right of the Media Files tab.

Note: You can also preview ASF, WMV, and MP4 media directly in the Workflow 
Designer (right-click a job on the Job Status tab and select View Binder).

Managing Metadata Labels in Binder
Metadata labels in a binder are stored in the Vantage domain database. Only one of 
each type of metadata label can be part of a binder (for example, a binder may contain 
one Identify label and one Curtains label, but not two Identify labels). Some labels may 
contain information that is specific to one media file—for example, an Identify label will 
typically contain file properties for one of the media files in a binder, not necessarily all 
of them.
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You can use the Vantage Management Console to view and manage the metadata 
labels assigned to a binder. To view, add, delete, or modify the labels assigned to a 
binder, start by clicking the target binder in the binder list, then click the Metadata 
Labels tab.

Note: This topic discusses metadata label use with binders. For additional metadata 
label management information, see Metadata Labels.

Adding a New Label

To add a new label, click the New Label  button in the toolbar.

The Vantage Management Console displays a list of labels, so that you can select the 
label you want to assign the binder. Select the label and click OK to add the label to the 
binder.

Removing a Label

To remove a label reference from a binder, select the label to remove, and click the 
Delete button  in the toolbar.

Note: This procedure removes the reference in the binder; it does not remove the 
metadata label from the Vantage domain.

Modifying Label Parameter Values

To modify a label parameter value for the binder, select the label to display the 
parameters and values in the parameter detail table on the right. Select the parameter 
to edit and make your changes. Click Save to update the Vantage domain database 
with your changes. 

Managing Binder Attachments
To view and manage attachments—independent files associated with this binder—
click the target binder in the binder list, then click the Attachments tab.

Binders can contain multiple attachments. You can add, delete and rename 
attachments.

Adding a New Attachment

To add a new attachment, click the Add Attachments button  in the toolbar.

The Vantage Management Console displays a file system dialog so that you can 
navigate to and select the file you want to assign the binder. Select the target 
attachment file, select an attachment tag, enter a name, and click OK to add the file 
reference to the binder for this media file.
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Removing an Attachment

To remove an attachment, select the attachment to permanently remove, and click the 
Delete button  in the toolbar.

Note: Removing an attachment does not delete the underlying file.

Renaming an Attachment

To rename an attachment, select the attachment to rename, and enter the new name.

Note: Renaming an attachment does not rename the underlying file.

Storage
Vantage storage is disk space that can be used to store files for Vantage processing. The 
following sections provide information on Vantage storage:

 Understanding Vantage Storage

 Understanding Path Specifications for Vantage Storage

 Managing Vantage Stores

 Managing Vantage Folder Addresses

Understanding Vantage Storage
Vantage storage is disk space that Vantage can use to store media files and 
attachments. Vantage storage is different from database storage, which stores data for 
Vantage configuration, job/binder status, and system status.

Vantage provides two types of storage:

• Vantage stores—Managed disk space where media files and attachments are auto-
matically deleted when they are no longer referenced by a binder.

• Vantage folder addresses—Unmanaged disk space to which media files and attach-
ments can be delivered, but from which files are not automatically deleted.

Vantage stores are defined in the Vantage Management Console and can be used in 
workflow actions that perform file operations. Vantage stores can also be associated 
with Vantage services for temporary storage (such as the location for a file that is being 
created during transcoding). Managed files remain in a Vantage store while either of 
the following is true:

• The files are referenced by a binder during job processing.

• The files are referenced by a binder that has been registered in a catalog, and the 
binder expiration date has not yet passed.
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Vantage folders can be created in the console or in Vantage Vantage Workflow 
Designer. Like stores, Vantage folders can then can be used in workflow actions that 
perform file operations. 

Transport actions that are responsible for saving files can use both stores and folders as 
file access and delivery points.

Understanding Path Specifications for Vantage Storage
Vantage stores and folders can be specified using the following path forms:

• UNC form: \\ComputerName\Sharename

• Physical drive-letter form: C:\folder\folder

• Mapped drive managed by SAN client software (for example, StorNext)

Note: Vantage cannot access network locations defined using a Windows mapped 
drive. For all network locations other than properly configured SAN locations, you 
must use a UNC path to define network locations for Vantage use.

If all your Vantage services, clients, and storage are on the same server, you can use 
either path form. However, Telestream recommends that you always use the UNC path 
form.

The disadvantage to using the drive-letter path form is that the drive letter is defined 
on the local machine, and the drive letter does not identify the computer that hosts the 
drive. For example, if you specify a Vantage store on drive C: using the drive-letter path 
form and a Workflow Portal operator tries to view files in that store on a different 
computer, Workflow Portal will search for those files on drive C: on the operator’s 
computer, not on the Vantage server.

When any Vantage service or client program will use Vantage storage from a different 
computer, you must specify the path using the UNC form. You should also use the UNC 
form if you think you might ever support Vantage services or clients on another 
computer. You can change the path form later, but it is easier to use the UNC path form 
now, and it can prevent troubleshooting issues in the future.

Note: When services or clients will access Vantage storage from another computer, 
the Vantage storage location must be published as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: If you are creating a store to hold proxy files viewed in the Vantage Workflow 
Portal, Telestream recommends that you reference the store with a UNC path. Some 
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SAN clients do not allow frame-accurate representation of proxies when using shared 
drives.

Managing Vantage Stores
Vantage stores management is performed in the Vantage Management Console. When 
you install Vantage in All-in-one mode, a default store named Local Store is created so 
that you can use Vantage Workflow Designer and access at least one store. You can add 
other stores as necessary.

To manage your stores, open the Storage folder in the component panel, and click 
Vantage Stores to display its details panel:

Figure 26. The Vantage stores details panel.

Use the Vantage Stores details panel to add and configure stores. You also use the 
details panel to modify and delete stores.

The following sections describe how to manage Vantage stores:

 Adding and Configuring Vantage Stores

 Viewing Files in a Vantage Store

 Modifying a Vantage Store

 Moving a Store Online or Offline

 Identifying Workflows that Use a Store

 Managing Alias Support for the Vantage Workflow Portal Web Client

Toolbar buttons:
New Vantage Store | Remove Vantage Store | Save | Duplicate Store | Search | Import and Export
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 Setting the Block Size

 Duplicating a Vantage Store

 Exporting and Importing Vantage Stores

 Deleting a Vantage Store

Adding and Configuring Vantage Stores
To add a new Vantage store, do the following:

1. Click the New Vantage Store button  in the toolbar to display the Add New Store 
dialog.

2. Type a name for the store in the Name text box.

The name that you enter here is the name that appears in Workflow Designer when 
an action is configured to access a media file or attachment.

3. To specify the store root directory with a UNC path (recommended), do the 
following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

4. To specify the store root directory with a drive letter path, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

5. Click OK.

6. Click the Save button  to save the new store.
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Viewing Files in a Vantage Store
The Files text box on the Vantage Stores page displays the files in the Vantage store. 
You can also use tools in the host file system (Windows Explorer, for example) to view 
the files in the store.

Modifying a Vantage Store
To modify a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.

2. To change the store name, type a new name in the Name text box.

3. To enter a description for the store, type a description in the Description text box.

4. To specify the store root directory with a UNC path (recommended), do the 
following:

a. Click Modify to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the store.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage store is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

5. To specify the store root directory with a drive letter path, do the following:

a. Click Modify to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

Note: If you use a physical drive letter to specify a directory, only Vantage services 
and clients on the same computer can access the store. For more information, see 
Understanding Path Specifications for Vantage Storage.

6. To specify a folder naming scheme for the store, select the scheme from the Folder 
Scheme drop down list.

When content is placed in a Vantage Store, Vantage creates a subfolder in the Store 
location to save the files in. If you select Identifier, the subfolder is named by auto-
generating a GUID. Date uses the current time and date stamp, and Name+Date 
uses the content name plus the time and date. For example, a Name+Date sub-
folder for a media file named Butterfly would be named something similar to: 
Butterfly_2010-09-17_01-59-50-5785.
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7. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to 
bring the store back online.

For more information, see Moving a Store Online or Offline.

8. To set the block size used for the store access, click the Advanced button and follow 
the instructions in Setting the Block Size.

9. For information on managing aliases for the store, see Managing Alias Support for 
the Vantage Workflow Portal Web Client.

10. Click the Save button  to save the changes.

Moving a Store Online or Offline
There may be times when you want to move a Vantage store offline to perform 
maintenance. When a store is offline, the Offline column in the Vantage Stores list 
displays an X for all stores that are offline. 

When you move a store offline, any jobs in progress that are using that store continue 
to run, but the offline store is no longer available for new jobs. A good practice is to 
take the store offline, let all jobs in progress for that store complete, and then perform 
the planned maintenance. If the store becomes inaccessible before the jobs in progress 
complete, the jobs in progress for that store fail.

To move a Vantage store offline or online, do the following:

1. Select an existing store in the Vantage Stores list.

2. To take a Vantage store offline, check the Offline checkbox. Clear the checkbox to 
bring the store back online.

The Offline checkbox is disabled if the store is assigned to a Vantage service. To 
enable the offline checkbox in this situation, identify to which service the store is 
assigned, and place that service in maintenance mode. You can located which ser-
vice is using the store by looking at the Storage tab for each service. For more infor-
mation, see Services.

3. Click the Save button  to save the changes.

Identifying Workflows that Use a Store
Vantage allows you to search all workflows in a domain to see which workflows are 
using a store. This is very useful when you need to change or delete a store, and you 
want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the store for which you want to search.

2. Click the Search button  in the toolbar. 

If the store is used by any workflows, Vantage displays a list of workflows that use 
the store. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the store is not used by any workflows, Vantage displays a message to that affect. 
Click OK to dismiss the message.
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Managing Alias Support for the Vantage Workflow Portal 
Web Client
The Web version of Vantage Workflow Portal requires HTTP access to Vantage stores for 
viewing of proxy media files. Providing HTTP access to Vantage stores requires the 
following:

• Create and configure a virtual directory on the IIS server that references the Van-
tage store. A virtual directory must be created for every store that will store proxy 
files for the Vantage Workflow Portal Web application.

• Create and configure a Vantage alias for the virtual directory.

• Create and configure a Workflow Portal configuration to support operator manage-
ment as described in Configuring Workflow Portal Operation.

The following topics describe how to manage an alias for a Vantage store:

 Creating a Virtual Directory

 Creating an Alias

 Modifying an Alias

 Deleting an Alias

Creating a Virtual Directory

For detailed instructions for creating an IIS virtual directory, refer to your Microsoft 
product documentation. The following procedure provides an example of how to 
configure a virtual directory on an IIS server:

1. If not already installed, install the Vantage Web Applications as described in 
Installing and Upgrading Vantage Web Applications.

2. On the server that hosts the Vantage Web Applications, select Start > 
Administrative Tools > Computer Management.

3. In the left pane of the Computer Management window, expand Services and 
Applications and select Internet Information Services (IIS) Manager.

4. In the Connections pane, expand the entry for the server, and expand the Sites 
entry.

5. Right click Default Web Site and select Add Virtual Directory.
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6. Configure the virtual directory as follows:

a. Enter an Alias name for the virtual directory.

Consider using a name that is easy to associate with the Vantage store directory, 
and note this name, as you will need to use it to create a Vantage alias.

b. Type the path to the Vantage store directory in the Physical path text box, or click 
the browse button to the right of the text box and select a directory.

For an all-in-one domain, the path to the default Local Store is [local drive]:\Pro-
gram Files (x86)\Telestream\Vantage\Store. The default path works only when 
the store and the Vantage Web Applications are located on the same server.

If your Vantage store is located on a network attached storage device or other 
network accessible location, enter the UNC path to the location (for example, //
myserver/myStore/ ).

c. Click Connect as, click Specific user, and click Set.
d. Enter user name and password information for a Windows user with access to the 

Vantage store directory, and click OK twice.

If required, the user name should include a domain name. For example, 
user@domain.net or VantageGuru@MyCompany.net.

Note: If you are operating in a Windows workgroup, the IIS 7 server machine name 
and the machine name of the file share for the Vantage store should have the same 
local account name (VantageUser, for example) and password. This allows for easy 
authentication from IIS to the Vantage store location. In this case, the user name in the 
Set Credentials window can be specified simply as VantageUser.

e. Click Test Settings.

The Test Connection dialog should show that the Authentication and Authoriza-
tion tests passed.

f. Click Close.
g. Click OK to complete the virtual directory configuration.

The virtual directory should now display in the Computer Management window 
as a folder below the Web site you modified.

h. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the Vantage Workflow Portal Web application.

Creating an Alias

After you create virtual directories for your Vantage stores, you need to create a 
Vantage alias for each Vantage store that will store proxy files. To create an alias, do the 
following:

1. Click the New Alias button .

2. In the Folder Location Editor dialog, select the HTTP file system and click Next.

3. Specify a host name or IP address for the HTTP server and the TCP port number, 
then click Next.
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4. Leave the User name and Password text boxes blank and clear the checkbox to Use 
anonymous login, then click Next.

5. Enter the virtual directory alias you created for the virtual directory, then click 
Finish.

6. Click the Save button  to save the changes.

7. Repeat this procedure for all Vantage stores that will store proxy files for use with 
the Vantage Workflow Portal Web application.

Modifying an Alias

To modify an alias, do the following:

1. Click the Modify Alias button  above the Alias text box.

2. Click Next to retain the HTTP file system selection.

3. Verify or change the host name or IP address for the HTTP server and the TCP port 
number, then click Next.

4. Verify that the User name and Password text boxes are blank and the checkbox to 
Use anonymous login is empty, then click Next.

5. Verify the correct virtual directory selection, or use the Folder Location Editor 
dialog to select the virtual directory, then click Finish.

6. Click the Save button  to save the changes.

Deleting an Alias

To delete an alias, click the Delete Alias button  above the Alias text box.

Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage stores. The default setting works best for most storage systems, but 
some fiber attached storage systems support higher throughput with larger block 
sizes.

CAUTION: This is an advanced system feature, and misconfiguration can disable your 
Vantage store. Be sure you understand the block size requirements of the storage 
system before making changes, and consider making changes to a production system 
only when you know the system is idle.
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To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog.

Figure 27. Advanced Stores Settings dialog.

2. Check the Specify desired block size checkbox.

3. Use the up and down arrows to specify the new block size.

4.  To test the new block size, do the following:

a. Click Test.
b. Use the file selection dialog to select a test file, and then click Open.

The test does not open the test file or evaluate file content, so you can use any 
file, regardless of file content. Larger files usually give a more accurate average 
throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to save the new setting and close the dialog.

Duplicating a Vantage Store
To duplicate a Vantage store, do the following:

1. Select an existing store in the Vantage Stores list.

2. Click the Duplicate button .

3. Select the new store and customize is as needed (see Modifying a Vantage Store).

Exporting and Importing Vantage Stores
Vantage allows you to export one or all Vantage stores to XML files, which you can then 
use to import the same stores into another Vantage domain.

To export one or all stores, do the following:

1. If you are exporting a single store, select the store to export.

2. Click the Export button  to export a single store, or select Export all from the 
Export button drop down menu.

3. Use the file system dialog to save the exported stores.

The default file name is the store name, but you can change the file name.
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Note: Changing the name of the XML file does not change the name of the store in 
the XML file.

To import a store, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the store to import, then click Open.

Note: If you try to import a store that is already in this Vantage domain, Vantage 
prompts you to either overwrite the existing store (click Yes) or cancel the import (click 
No).

Deleting a Vantage Store
Click on the store you want to delete, click the Delete button  in the toolbar, and click 
OK to confirm.

Note: If there are any files in the store that are maintained by Vantage—such as those 
for unexpired jobs or binders in a catalog, you cannot delete the store. Deleting a store 
permanently removes the store from the domain. It does not delete directories, shares, 
or any files in them.

Managing Vantage Folder Addresses
Vantage folder address book management can be performed either directly in the 
Vantage Management Console or in Vantage Vantage Workflow Designer (in Copy or 
Move actions).

To manage your address book’s folders in the Management Console, open the Storage 
folder in the component panel and click Vantage Folders Address Book to display its 
details panel.
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Figure 28. The Vantage Folders Address Book details panel.

You can use the Vantage Folders Address Book details panel to add and configure 
Vantage folders. You also use the details panel to modify and delete Vantage folders.

The following sections provide information on managing Vantage folder addresses:

 Adding Vantage Folder Addresses

 Deleting a Vantage Folder Address

 Setting the Block Size

 Duplicating a Vantage Folder Address

 Exporting and Importing Folder Addresses

Adding Vantage Folder Addresses
To add a new folder address, do the following:

1. Click the Add Folder button  to display the Add New Folder dialog.

2. Enter a folder name in the Add New Folder dialog.

3. Click Modify to display the Folder Location Editor dialog.

Toolbar buttons:
Add Folder | Remove Folder | Save | Duplicate | Search | Import and Export
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Figure 29. Folder Location Editor Dialog.

4. Select the file system where the Vantage files will be stored, then click Next.

5. To specify the folder root directory with a UNC path (recommended), do the 
following:

a. Click Browse to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the folder.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

Note: If the Vantage folder is on a different computer, you must publish a share and 
grant access to the appropriate Windows users before it will appear in the Browse for 
Folder dialog. For more information, see Windows Authentication Guidelines.

6. To specify the folder root directory with a drive letter path, do the following:

a. Click Browse to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click OK.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.

Note: If you use a drive letter to specify a folder, only Vantage services and clients on 
the same computer can access the folder. For more information, see Understanding 
Path Specifications for Vantage Storage.
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7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

8. Click OK to save this new Vantage folder address to the domain and close the Add 
New Folder dialog.

Modifying Vantage Folder Addresses
To modify a folder address, do the following:

1. Select the folder in the Vantage Folder Address Book.

2. If you want to change the folder name, enter a new name for the Vantage folder.

This name is displayed in copy and move action inspectors where you are specify-
ing the location in which to save a file.

3. If you want to enter a description, enter the description, purpose, or use of this 
folder address.

4. To change the folder storage location, click Modify and specify the new location as 
described in Adding Vantage Folder Addresses.

5. To define what action Vantage takes when it saves a file and a file with the same 
name exists in the Vantage folder, select an action from the Collision Resolution 
drop down list:

– Create Unique Name—Vantage creates the file with a unique name, leaving the 
other file intact.

– Overwrite—Vantage overwrites the old file.

– Set Failure State—Vantage does not save a new file and registers a failure with 
the action that attempted to create the file.

6. For instructions on using the Advanced features, see Setting the Block Size.

7. Click the Save button .

Identifying Workflows that Use a Vantage Folder
Vantage allows you to search all workflows in a domain to see which workflows are 
using a Vantage folder. This is very useful when you need to change or delete a store, 
and you want to know which workflows might be affected by the change.

To search workflows, do the following:

1. Select the Vantage folder for which you want to search.

2. Click the Search button  in the toolbar. 

If the folder is used by any workflows, Vantage displays a list of workflows that use 
the folder. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the folder is not used by any workflows, Vantage displays a message to that affect. 
Click OK to dismiss the message.
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Deleting a Vantage Folder Address
Click on the folder you want to delete, click the Delete button  in the toolbar, and click 
OK to confirm.

Note: Deleting a folder permanently removes the folder from the domain. It does not 
delete directories, shares, or any files in them.

Setting the Block Size
Vantage allows you to specify the block size used when writing data to and reading 
data from Vantage folders. You can also use Vantage to test the throughput of different 
settings. The default setting works best for most storage systems, but some fiber 
attached storage systems support higher throughput with larger block sizes.

CAUTION: This is an advanced system feature, and misconfiguration can disable your 
Vantage folder. Be sure you understand the block size requirements of the storage 
system before making changes, and consider making changes to a production system 
only when you know the system is idle.

To specify and test a new block size, do the following:

1. Click Advanced to display the Advanced Store Settings dialog (see Figure 27).

2. Check the Specify desired block size checkbox.

3. Use the up and down arrows to specify the new block size.

4. To test the new block size, do the following:

a. Click Test.
b. Use the file selection dialog that appears to select a typical media file, and then 

click Open.

Larger files will usually give a more accurate average throughput result.

c. Click OK.

Vantage displays the test results.

5. Click OK to keep the save the new setting and close the dialog.

6. Click the Save button .

Duplicating a Vantage Folder Address
Select the folder you want to duplicate, click the Duplicate button  in the toolbar. 
Select the duplicated folder, make the necessary changes and save it.
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Exporting and Importing Folder Addresses
Vantage allows you to export folder addresses to XML files, which you can then use to 
import the same addresses into another Vantage domain.

To export one or all folder addresses, do the following:

1. If you are exporting a single address, select the metadata label to export.

2. Click the Export button  to export a single address, or select Export all from the 
Export button drop down menu.

3. Use the file system dialog to save the exported folder addresses.

The default file name is the folder address name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the folder 
address in the XML file.

To import a folder address, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the folder address file to import, then 
click Open.

Note: If you try to import a folder address file that is already in this Vantage domain, 
Vantage prompts you to either overwrite the existing folder address (click Yes) or 
cancel the import (click No).

Services
Services, as used in Vantage, refers to Vantage running as Windows services, which are 
required to perform a given action in a workflow. The term service refers to the specific 
instance of the Windows service on a particular computer that is responsible for 
actually executing the actions specified in a workflow, when that workflow is executed 
as a result of a job submission to process a given media file.

Use the Services component of the Vantage Management Console to configure your 
Vantage services operating on various machines to function according to your 
requirements. 

You can configure each service’s program settings, storage requirements, variables, and 
qualification rules.

The following sections describe how to manage services:

 Using the Services Details Panel

 Adding a Service to the Domain

 Removing a Service from the Domain

 Entering and Exiting Service Maintenance Mode

 Entering and Exiting Server Maintenance Mode
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 Resetting the Service Metrics History

 Configuring Vantage Services

Using the Services Details Panel
You can use the services details panel to add services to the domain and configure 
them, and to remove them from the domain. To manage Vantage services, click 
Services in the component panel to display the Services detail panel shown in 
Figure 30.

Figure 30. The Vantage Services details panel.

Note: If duplicate entries appear for services on a specific Vantage server, it could be 
that the server has multiple network interface cards and one of them has been 
disabled. This does not affect Vantage operation.

Table 11 describes the columns in the Services panel.

Toolbar buttons:
Add Service | Remove | Enter Maint. Mode | Exit Maint. Mode | Clear
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Table 11. Services panel column descriptions.

Column Heading Description

Service Lists Vantage services by name.

Machine Displays the machine name that hosts the service.

State Displays the service state, which can be Online, 
Maintenance, Restarting, or Unreachable.

Active Sessions Displays the number of active sessions for the service. A 
service starts a session each time a workflow uses that 
service to process a job.

Queued Sessions Displays the number of sessions that have been assigned 
to a service and are waiting for the service to become 
available.

Failed Sessions Displays the number of sessions that did not complete 
successfully.

Total Sessions Displays the total number of jobs that have used the 
related service since the metrics were last reset.

Current Resource Usage In sessions mode (which is the default mode), this column 
displays the sum of all sessions that are currently being 
processed by the service.

When cost-based load balancing is enabled, this column 
displays the sum of the configured costs for all actions 
that are currently being processed by the service. For 
more information on cost-based load balancing, see 
Managing Load Balancing. For more information on 
action costs, see Action Defaults.

Target Resource Usage In sessions mode (which is the default mode), this column 
displays the configured maximum number of sessions for 
this service.

When cost-based load balancing is enabled, this column 
displays the target resource usage level configured for 
the service. For more information on cost-based load 
balancing, see Managing Load Balancing.

For more information on configuring the maximum 
number of sessions or the target resource usage level, see 
Configuring Vantage Services.

License Failures Displays the number of times users have requested a 
service and have been denied because no license was 
available for the session.
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Adding a Service to the Domain
To add a Vantage service to a domain, it must first have been installed and started on a 
computer on your network subnet.

Next, click the Add Service button  in the toolbar.

Management Console scans the network for available services and displays those that 
are not currently part of this domain.

Figure 31. Select Services Dialog

Select the service you want to add to the current domain and click OK.

Services are added to a domain by removing them from the domain they are currently 
in. Services can not be part of more than one domain at a time. Be sure that the other 
domain is prepared to lose the service you are adding to your domain.

Removing a Service from the Domain
To remove a Vantage service from a domain, select in and click the Delete button  in 
the toolbar.

Note: Removing a service does not stop or uninstall the service from any computer. It 
merely disengages it from the current domain.

Entering and Exiting Service Maintenance Mode
You can enter and exit maintenance mode by selecting a service and clicking the Enter 

 or Exit  button. When a service is in maintenance mode it will not process any 
transactions. Exit maintenance mode to re-activate the selected service and cause it to 
reload its resources from the database.
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Note: The Multiscreen service is supported only on Lightspeed servers. On all other 
Vantage servers, this service stays in Maintenance Mode.

Note: Placing a service in maintenance mode erases the metrics for that service, and 
this affects the Vantage Dashboard bar graphs for that service.

Entering and Exiting Server Maintenance Mode
To move all services on a server in and out of maintenance mode, do the following:

1. Display the Services detail panel.

2. Click the top service in the list.

3. Shift-click the bottom service in the list to select all items in the list.

4. Click the Enter button  to place all services in maintenance mode.

5. Click the Exit button  to restart all services and exit maintenance mode.

Note: Placing all services in maintenance mode erases the metrics for all services, and 
this affects the Vantage Dashboard bar graphs for those services.

Resetting the Service Metrics History
Click the Clear button  to reset the Service Metrics History. This also resets all failed 
service metrics for the selected services.

Configuring Vantage Services
Vantage services have a variety of configuration options; most of them with default 
settings. The following sections describe how to configure the settings on each tab:

 Setup

 Service Storage

 Service Variables

 Qualification Rules

Setup
The Setup tab includes Vantage domain database settings, service ports, 
instrumentation, time-out settings and log file options. 

Changing settings in the Setup tab requires that you restart the service before they 
take effect. You can make changes to settings in the other tabs without restarting the 
service—they take effect immediately. To modify the settings in the Setup tab, select 
the service you want to modify and click the Enter Maintenance mode button  in the 
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toolbar. After making the changes, click the Exit Maintenance mode button  in the 
toolbar. Exit maintenance mode to re-activate the selected service and cause it to 
reload its resources from the database so it can begin accepting jobs again.

Changes to these settings can only be made in maintenance mode.

Click on each category in the Setup tab to display its settings.
Table 12. Setup Tab

Vantage Domain Settings

Host Name of the computer on which this domain database is installed. 
Not changeable.

Failover Name of the optional failover database instance that serves as the 
failover database should the primary database fail. This is the 
name of the mirrored database server (i.e. “BackupServer”). 

Instance Name of the primary Vantage domain database instance.

Database Name of the database.

User Username of the MS SQL Server database user. Default: sa. 
Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.

Password Password of the database user. 
Default: vantage12!
Do not change the user name or password unless you have 
created a user with db_owner access for the Vantage instance in 
Microsoft SQL Server.

Service Limits

Session Limit In sessions mode (which is the default mode), this configures the 
maximum number of concurrent sessions for a service. For CPU-
intensive services—such the Transcode service—you should gate 
the maximum number of sessions to the power of the computer. 
For less demanding services, such as the Monitor service, a higher 
number is less likely to cause problems.

When cost-based load balancing is enabled, this setting is 
disabled. For more information on cost-based load balancing, see 
Managing Load Balancing.
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Target Resource 
Usage  

When cost-based load balancing is enabled, this setting configures 
the target resource usage level for this service. Each service has a 
default value for this setting. If server performance permits, raise 
this value to support simultaneous processing of additional 
workflow actions. If the server is having performance issues, lower 
this value to reduce the number of actions that run at the same 
time.

For more information on cost-based load balancing, see Managing 
Load Balancing.

Service Settings

TCP Port The TCP port is utilized for all intra-service traffic in the domain. If a 
certain port range is allowed by your IT infrastructure (given 
constraints such as routers and firewalls) an IT administrator can 
specify which port to use for intra-service communication to fit 
their environment.

HTTP Port The HTTP port is utilized for HTTP server traffic in the domain. An 
IT administrator can specify which port to use for intra-service 
communication to fit their environment.

Instrumentation Settings

Enable 
Instrumentation

Registers and reports certain internal events as Windows 
Management instrumentation events.

Service Timeout

Timeout The time (in minutes), that a non-responsive task will run before 
being terminated and failed.

Log File Settings

Log File Name The base name of the log file generated by this service. Log files 
are generated by service, and are stored in each service’s folder in 
<installdrive(C:)>\Program Files\Telestream\<Service Folder>.

Log File Size The maximum file size (in bytes) before the service creates an 
incrementally-numbered log file for continued logging.

Max Log File 
Count

The maximum number of log files for this service, before the oldest 
is deleted when a new one is written.

Table 12. Setup Tab (Continued)
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Service Storage
The Storage tab enables you to specify stores for a service to provide a repository so 
that their actions can obtain storage if they require it. Certain actions require storage 
where they can create temporary files or perform other operations that involve writing 
files to disk.

For example, the Transcode service requires access to a store in order to produce the 
files that it creates as part of the transcode process.

The process of assigning a specific store to a service is made with performance in mind. 
If you know you want a particular Transcode service to utilize a specific store, you can 
assign it here. In the absence of an assigned store for Transcode service, service will 
utilize any Vantage store it chooses to write temporary files to. This may not be optimal 
based upon your network topology.

Adding Stores

To add a store to the selected service, click the Add Store button , select the store 
from the Select Storage dialog and click OK.

Note: The Flip action can specify a store for output files. The selection of a store in a 
Flip action overrides the store defined for the host service.

Removing Stores

To remove a store from the selected service, select the store and click the Delete button 
 in the toolbar.

Service Variables
Use the Variables tab to attach variables to a service. Service variables perform two 
functions. First, they dictate which services can perform tasks as set up by the Run On 
Rules. Run On Rules allow you to target specific services to execute tasks, entirely based 
upon whether or not a variable is set for a Service. 

Note: Run on rules only look at Service variables, they do not look at variables in a job.

Second, service variables allow services to add variables to a workflow. Variables (such 
as job routing and action priority) can be passed to workflows to provide information 
about the service, and workflow actions can include this information in the output or 
make workflow processing decisions based on the variable values. 

When you add a variable to a service, you supply a constant value—one that does not 
change over time. The value of the variable is static for the service instance.

For example, you may want to implement email generation in the event of a transcode 
failure in a large domain with 20 separate transcode services, each running on separate 
machines. This allows a user to receive an email when a transcode fails that identifies 
the machine where the failure occurred.
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To implement this, create a text variable named EmailSubject as described in Creating 
Variables. Next, add the EmailSubject variable to each Transcode service as described in 
Adding Variables to a Service, and set the value of EmailSubject for each service to a 
combination of the respective machine name and the service name by typing it in 
manually in the Value field. For example, one might be named M-ORION-
VantageTranscodeService.

Now, in each workflow, you add a Message action and specify the email option, bind 
the Subject line with the EmailSubject variable, and set the Message action to only run 
on a Failure state.

Now, if a transcode failure occurs, the user receives an email indicating which system 
was transcoding the media when the failure occurred.

Adding Variables to a Service

To add a variable to the selected service, click the Add Variable button , select the 
variable from the Select Variable dialog and click OK. Next, enter the static value for this 
variable in the Value field. When you click away, the Save Variable dialog displays. Click 
Yes to save this variable and its value.

Note: If you are using a Lightspeed Server, then a read-only Lightspeed variable will 
be added to services on that server. This is used for automated load balancing and 
may be used for Run On rule configuration as well.

Removing Variables from a Service

To remove a variable from the selected service, select the variable and click the Delete 
button  in the toolbar.

CAUTION: Deleting a variable that is used in workflows may render the workflow 
inoperable.

Qualification Rules
Qualification rules give you control over which actions a service will process. 
Qualification rules enable a service to compare variable values set by the workflow 
against a baseline value, generate a merit value based on the comparison, and use the 
merit value in conjunction with other variables to determine if the service should 
process the job.

Note: Vantage also supports run on rules, which are defined in a workflow and allow 
a workflow designer to select a service based on Vantage variable values. Generally 
speaking, run on rules are easier to configure if you want to specify that parts of a 
workflow execute on specific services. For more information, see the Vantage User’s 
Guide.
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Qualification rules can be based on system variables (such as Priority) and user-defined 
variables (for example, File Size). You can create multiple qualification rules per service 
to fine-tune each service’s fitness to perform certain tasks and improve over-all domain 
workflow and performance.

For example, suppose you have a large domain with 20 transcoding services on 
different machines. Your goal is to divide the transcoding services in to groups: those 
that process the bulk of the jobs—those involving media of less than about 80MB in 
size. Another group is configured to optimally transcode media up to 2GB, another for 
long-form files, over 2GB.

To implement this, you create a variable named FileSize (Select Domain > Workflow 
Design Items > Variables). 

Next, you select the service that you want to run short jobs here, in Services > 
Qualification Rules, and create a qualification rule.

Select the FileSize variable and click OK. Configure the rule to specify operator = less 
than or equal, merit = 100 (an arbitrary value), qualifier = required, and value = 
80,000,000. This rule will pass the merit value of 100 to Vantage when a job being 
considered for execution has a FileSize variable with a value less than or equal 
80,000,000.

For each other transcode service, add a similar rule (or rules) to qualify it appropriately.

Now, in each workflow, add an identify action before each flip action and configure it to 
update the FileSize variable with the File Size metric.

When a job starts, the Identify action updates the FileSize variable, and each transcode 
service examines the variable against its comparison value to determine its fitness to 
process the flip action, and if true, submits its merit value, if false, submits merit value 0 
to Vantage for final arbitration on which transcode service is assigned the job.

Adding Qualification Rules

To add a qualification rule to the selected service, click the Add Qualification Rule 
button , select the variable from the Select Variable dialog and then configure the 
rule.
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Table 13. Qualification Rule Configuration Options

Option Description

Operator Select an operator from the dropdown list to qualify the 
workflow variable value being compared against the 
baseline value specified in the rule. 

For mathematical operators, if the equation is true, the 
merit value you supply is passed; if the equation is false, 0 
is passed. 

For the contains operator, the equation is true if the 
workflow variable contains the text specified in the 
baseline value. The merit value you supply is passed if the 
equation is true, and 0 is passed if the equation is false.

Merit When an action meets the qualification rule requirements 
for multiple service instances, the action is assigned to 
the service with the highest merit value. For example, if a 
Flip action meets the qualification rule requirements for 
the Transcode service on both Server A and Server B, 
Vantage assigns action processing to the server that 
hosts the service qualification rule with the highest merit 
value.

Merit values should be consistent with a predetermined 
plan of implementation, so that each service is 
responding appropriately to influence the distribution of 
tasks. If you have few services and rules, values from 1 to 
10 may provide enough granularity; for lots of services 
and/or rules, you may need values from 1 to 100 to 
provide enough granularity.

Qualifier Choose Optional when workflows may or may not 
provide a value for comparison. If no value is provided, 
the comparison always is false, and 0 merit is provided. 
Choose Required when workflows must provide a value 
for comparison. If no value is provided, the service rejects 
the request to process the job without further analysis.
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Removing Qualification Rules

To remove a qualification rule from the selected service, select the rule and click the 
Delete button  in the toolbar.

Licenses
Telestream provides Vantage licenses to enable a specific set of capabilities in a 
Vantage domain. A single license file activates capabilities for every server in the 
domain—functionality that was specified in your license request. Production licenses 
can only be used by one Vantage Domain at a time.

When you receive a license file from Telestream, you need to activate the license file. 
Activation locks the license in the Vantage domain database, and the license remains 
locked until deactivated. Once activated, the license file is no longer used by Vantage. 
However, you should keep the license file in case it needs to be reactivated later.

The following sections provide information on managing Vantage licenses:

 Viewing Vantage Licenses

 Adding a License

 Deactivating a License

 Viewing and Resetting Workflow Portal Licenses

Value Enter the baseline value against which the variable’s 
value is to be compared. (A null value is a valid value.)

Use Wildcards Enables or disables the use of wildcard characters in the 
Value field. When enabled (checked), you can use a 
question mark (?) to indicate a single character that can 
have any value, and you can use an asterisk (*) to indicate 
a variable number of characters that can have any value. 
For example, *.mov matches any value that ends in ‘.mov’.

When disabled (unchecked), the * and ? characters are 
regular characters, not wildcard characters.

Ignore Case Enables or disable case validation in the Value field. When 
enabled (checked), the case in the Value field is ignored 
when comparing the value to a value received from an 
action. For example, TEST1 and test1 are considered a 
match when the Ignore Case option is checked.

When disabled (unchecked), the case in the Value field 
must exactly match that received from an action to be 
considered a match. 

Table 13. Qualification Rule Configuration Options (Continued)

Option Description
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Viewing Vantage Licenses
To manage your Vantage licenses, click Licenses in the component panel, and click on 
the License tab. The Vantage Management Console displays the Licenses details panel:

Figure 32. The Licenses details Licenses panel.

You use the Licenses details panel to add a license to the domain and activate it. You 
also use the details panel to remove a license from the domain.

Select a license to open and view the policies in this license and the associated 
capabilities it enables.

Adding a License
Vantage licenses are normally installed when the domain is installed. For instructions 
on adding a license, see Enabling a Vantage License.

Deactivating a License

Note: Before deactivating a license, all jobs using the license should be stopped, and 
all services using the license should be put into Maintenance Mode. Otherwise, the 
license will report being in use.

To deactivate a license in a domain, select the license and click the Remove license 
button  in the toolbar. Click Yes in the warning dialog to confirm.

When you remove a license, Vantage attempts to deactivate it. A license should only be 
removed if you intend to install the same license on a different Vantage domain. In this 

Toolbar buttons:
Add License | Remove License
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case, the removal process also attempts to deactivate the license. The deactivation 
process will indicate that the license may be loaded on a different domain. If a license is 
not deactivated prior to adding it to another Vantage Domain, an error occurs—
indicating that the license is currently in use on a different Vantage domain and that it 
can not be activated a second time.

Viewing and Resetting Workflow Portal Licenses
Each active Workflow Portal session uses one Workflow Portal license. If all licenses are 
in use and someone needs to use Workflow Portal, you might need to do one or more 
of the following:

• Reset a license that is now idle due a lost network connection or sudden program 
termination.

• Reset a license for a lower priority user to make it available for a higher priority user.

• Buy more licenses.

To view the Workflow Portal license usage, select Licenses in the component panel, and 
click on the Portal Sessions tab. The Vantage Management Console displays the Portal 
Sessions details panel (Figure 33).

Figure 33. The Licenses details License Sessions panel.

To reset a license session for Workflow Portal, select the session and click the Stop  
button. 

Refresh List

Toolbar buttons:

Release Session
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Status
To monitor the real-time state of services in a domain, select Status in the component 
panel. You can view all jobs in the domain, or you can view them by service or by 
machine.

Figure 34. The Status details table‘.

The following sections describe different ways to view Vantage status:

 Viewing Actions by Service

 Viewing Actions by Machine

 Viewing Active Workflows in Domain

Viewing Actions by Service
To view all jobs executing in the domain, filtered by a specific service type (the 
transcode service, for example), open Actions by Service and select the service type in 
the list to display the actions table with entries for this service’s actions.

The action table displays a list of all actions for the selected service or machine, or 
active/failed workflows in the domain. Each entry contains the action, state, machine, 
workflow, job, created timestamp, updated timestamp, and description.

You can sort all table entries in ascending or descending order by column: machine, or 
state, for example.
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Viewing Actions by Machine
To view all jobs executing on a specific machine within the domain, do the following:

1. Open the Status component in the component panel.

2. Double-click a machine name in the Actions by Machine list.

Viewing Active Workflows in Domain
To view all workflows executing in the domain, plus all jobs that have failed, select 
Active Workflows in Domain in the component panel.

Figure 35. The Active Workflows In Domain Panel.

Workflow Design Items
Use the Workflow Design Items component to create, configure, and manage resources 
that you want to make available to all workflows in the domain. These resources 
include:

 Workflow Categories

 Media Nicknames

 Metadata Labels

 Attachment Nicknames

 Variables

 Style Sheets

 Action Defaults
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Workflow Categories
Workflow categories are folders that contain workflows. These folders can be created or 
deleted in the Workflow Designer or in the Management Console. The Management 
Console, additionally, enables you to duplicate, import, or export category folders.

Figure 36. Workflow Categories panel

Table 14. Workflow Categories Toolbar Buttons

Button Description

Create Click the Create button to create a new category (folder). 
Categories can also be created in the Workflow Designer.

Delete Click the Delete button to delete a category (folder). A 
warning about loosing all workflows in this category is 
displayed to prevent accidental removal of workflows.

Save Click the Save button to save changes made in user 
permissions. If changes are not saved, you will be 
prompted to save upon leaving that category.

Toolbar buttons:
Create Category | Delete | Save | Duplicate | Import | Export | Refresh
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 Media Nicknames
Media nicknames are generally managed in Vantage Workflow Designer; but the 
Management Console allows media nicknames to be fully defined, including a 
definition.

Nicknames enable you to tag a specific media file with a convenient name, which you 
can use to reference the file and use it in workflow actions.

In Vantage workflows, when you provide a media nickname, you can construct a 
workflow that allows the identification and manipulation of media files via the 
nickname you assign.

The following sections describe media nickname management tasks:

 Displaying the Media Nicknames Panel

 Creating Media Nicknames

 Deleting Media Nicknames

 Exporting and Importing Media Nicknames

 Searching for Media Nicknames in Workflows

Duplicate Click the Duplicate button to duplicate a selected 
category. Only the category (folder) is duplicated. None 
of the workflows in the folder are duplicated. However, all 
of the user permission are duplicated in the new folder.

Import Click the Import button to display a file system dialog, so 
you can select a category file. Navigate to the directory 
where the category XML file is stored, select the file (or 
files) you want to import, then click OK.

Note: If you attempt to import a category that is already 
present in the domain, Vantage prompts you to overwrite 
the category (click Yes) or cancel the import (click No).

Export Click the Export button to display a file system dialog to 
select the server and directory where you want to save 
the selected category as an XML file. The file by default is 
named the same as the category name, but can be 
changed before saving it.

Note: Changing the name of the XML file does not 
change the name of the category in the XML file.

Refresh Click the Refresh button to update the list of categories.

Table 14. Workflow Categories Toolbar Buttons (Continued)

Button Description
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Displaying the Media Nicknames Panel
To manage media nicknames in Vantage, click Media Nicknames in the component 
panel. The Vantage Management Console displays the Media Nicknames panel:

Figure 37. The Media Nicknames panel.

Creating Media Nicknames
To create a new nickname, click the Create Nickname button  in the toolbar. The 
Management Console displays a Create Media Nickname dialog. Enter the name of this 
nickname and click OK.

The Management Console adds this nickname to the table. Optionally, add a 
description and click the Save button .

Deleting Media Nicknames
To permanently remove a media nickname from the domain, select the nickname and 
click the Delete button  in the toolbar. Click OK to confirm the deletion.

Exporting and Importing Media Nicknames
Vantage allows you to export media nicknames to XML files, which you can then use to 
import the same media nicknames into another Vantage domain.

To export a media nickname, do the following:

1. Select the media nickname to export.

2. Click the Export button .

Toolbar buttons:
Create NIckname | Delete | Save | Search | Import | Export
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3. Use the file system dialog to save the exported media nickname.

The default file name is the media nickname, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the media 
nickname in the XML file.

To import a media nickname, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the media nickname to import, then 
click Open.

Note: If you try to import a media nickname that is already in this Vantage domain, 
Vantage warns you that you cannot overwrite an existing media nickname.

Searching for Media Nicknames in Workflows
Vantage allows you to search all workflows in a domain for a media nickname. This is 
very useful when you need to change or delete a nickname, and you want to know 
which workflows might be affected by the change.

To search for media nicknames, do the following:

1. Select the media nickname for which you want to search.

2. Click the Search button  in the toolbar. 

If the media nickname is used in any workflows, Vantage displays a list of workflows 
that use the nickname. Double-click any workflow in the list to open that list in Van-
tage Workflow Designer. Click Done to dismiss the list.

If the media nickname is not used in any workflows, Vantage displays a message to 
that affect. Click OK to dismiss the message.

Metadata Labels
Vantage supports metadata attachments and metadata labels. Metadata attachments 
are separate files that contain data about associated media. Metadata labels are used in 
some media files as containers to carry data about the media. In Vantage, metadata 
labels also contain data about media, but the labels are defined using the Management 
Console and can be used to manage media data within and between workflows.

Each metadata label has a name and is comprised of one or more parameters. Each 
parameter has a name and holds a data value that conforms to a data type, such as text, 
date, timecode, or integer.

Vantage provides a comprehensive list of industry-standard metadata labels with 
parameters for use in Vantage workflows. You can also define custom labels with 
custom parameters.
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During workflow processing, metadata labels can be populated with the following 
types of data:

• Data imported from metadata attachments

• Data from workflow analysis (Analysis Examine and Identify actions)

• Data from workflow variables (Metadata Populate action)

• Data entered by Workflow Portal operators

During workflow processing, metadata label content can be used to do the following:

• Provide media information to operators, who use the information to make media 
processing decisions

• Provide media information to workflow processes for automated decision process-
ing

• Output media information to metadata attachments for use after workflow pro-
cessing

• Add metadata labels to the output media (embedded in the media file)

The following sections describe Vantage metadata labels and label management tasks:

 Vantage Metadata Applications

 Displaying the Metadata Labels Panel

 Creating Metadata Labels

 Adding Metadata Label Parameters

 Duplicating a Parameter within a Metadata Label

 Adding a Copy of a Metadata Label Parameter to Another Metadata Label

 Deleting a Metadata Label Parameter

 Modifying Metadata Labels and Parameters

 Previewing Metadata Labels and Values

 Sorting Metadata Label Parameters

 Exporting and Importing Metadata Labels

 Searching for Metadata Labels in Workflows

Vantage Metadata Applications
The following are some examples of how metadata labels can be used with workflows:

• Operator selection of distribution channels—An ingest workflow can be used to 
collect data and populate metadata labels. When the ingest workflow completes, 
an operator examines the workflow output (media and metadata labels) and con-
figures metadata labels that are used by a target workflow to choose a distribution 
channel.

• Easier operator selection of trim points and thumbnails—An ingest workflow can 
be used to generate a proxy media file, which the operator can use to review 
media. During review, the operator can use hotkeys to instantly transfer timecodes 
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for the trim points and thumbnail to metadata labels, and the label timecode val-
ues can be used in the target workflow to trim the media and generate a thumb-
nail. Also, three timecode metadata parameters can be grouped together as a Trim 
Group, which automatically calculates and displays the difference between a Mark 
In and Mark Out point to show a duration.

• Metadata addition to media output files—For media formats that support meta-
data, a workflow can be configured to collect metadata from operators or populate 
the metadata with default values.

• Quicker location and evaluation of macroblocking—An ingest workflow can be 
configured to detect the worst macroblocking in input media and store the frame 
timecode in a metadata label. An operator can then use the label timecode value to 
quickly locate the issue and evaluate the severity.

• Flexible graphics and title insertion—With the addition of a template produced by 
GraphicsFactory software, the same workflow and template can be reused for mul-
tiple applications by using metadata labels to define a graphic file to insert, title 
text to insert, and timecodes for placement. 

• Operator specification for automatic commercial insertion—As with trim points 
and thumbnail selection, proxy media from an ingest workflow can be used with 
hotkeys and metadata labels to simplify operator specification for commercial 
insertion. After the metadata labels are populated, a target workflow can automati-
cally insert commercial media at the point specified by the metadata labels.
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Displaying the Metadata Labels Panel
To manage metadata labels in Vantage, click Metadata Labels in the component panel. 
The Vantage Management Console displays the Metadata Labels panel:

Figure 38. The Metadata Labels panel.

Creating Metadata Labels
To create a new metadata label, do the following:

1. Click the New Label button  to create a new metadata label (far left) in the 
toolbar. 

2. In the dialog that appears, enter a name for the new metadata label, and click OK.

Metadata label names are case-sensitive. For example, FrameHeight and frame-
height are different labels.

3. If desired, enter a description for the metadata label.

4. Add metadata label parameters as described in Adding Metadata Label Parameters.

5. Click the Save button .

Toolbar buttons:
Create | Delete | Save | Duplicate | Search | Binder label search | Import | Export

Design Panel—Parameters:
Displays parameters—add and 
configure new parameters, edit 
current ones.

Preview & Test:
Displays parameters in user-
form, enables testing.Move Item 

buttons
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Adding Metadata Label Parameters
To add a metadata label parameter, do the following:

1. Click an existing metadata label name, or create a new metadata label as described 
in Creating Metadata Labels.

2. Click the Create Parameter button  in the design toolbar.

3. Enter a name for the new parameter.

4. If desired, do the following to configure the optional parameter values:

a. Enter a description for the new parameter.
b. Enter a category name.

Categories can be used to group logically related parameters. Parameters with 
the same category name are grouped together in the parameter list. If no cate-
gory is specified, the parameter displays in the Misc category.

c. Select a parameter value type from the dropdown list of values.
d. Click the password option if you want the parameter value to be obscured by 

asterisk (*) characters.
e. To define a list of optional values for the parameter, click the Modify button, 

enter one value per line, and click OK.

This feature can be used to create a dropdown list to reduce the chance of data 
entry errors. For example, you might create a Ratings parameter and specify the 
terms G, PG, PG-1, TV-14, and R. Operators can they use a dropdown list in Work-
flow Portal to select one of these values, instead of typing the value.

f. To limit the parameter value to one of the values defined with the Modify button, 
check the Exclusive checkbox.

In the above example for a Ratings parameter, checking the Exclusive checkbox 
limits operators to selecting one of the specified ratings. Operators are not 
allowed to type in a rating.

g. To define a default value for the parameter, enter the default value in the Default 
Value text box, or select a default value from the dropdown list.

The entry options depend on the other parameter value option settings.

h. To change the displayed order of parameters, select a parameter in the 
parameter list and use the green up  and down arrow  buttons to move the 
variable in the list.

The parameter list order that you define configures the order of parameters dis-
played in Workflow Portal.

i. To view how parameters appear to Workflow Portal operators, click the 
Categorize button , which toggles the display between showing categories 
and showing a flat list with no category names.

Note: Operators can configure Workflow Portal to display or hide the category 
names.

5. Click the Save button .
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Duplicating a Parameter within a Metadata Label
To add a parameter that is a copy of another parameter in the same metadata label, do 
the following:

1. Select the parameter to copy.

2. Open the Copy button  dropdown list in the Design toolbar and select 
Duplicate selected.

3. Modify the parameter options and values as needed.

4. Click the Save button .

Adding a Copy of a Metadata Label Parameter to Another 
Metadata Label
To add a copy of one parameter to a different metadata label, do the following:

1. Select the parameter to copy.

2. Open the Copy button  dropdown list in the Design toolbar and select Copy 
selected.

3. Select the metadata label to which you want to copy the parameter.

4. Click the Paste button  in the Design toolbar.

5. Modify the new parameter options and values as needed.

6. Click the Save button .

Deleting a Metadata Label Parameter
To delete a parameter from a metadata label, do the following:

1. Select the parameter to delete.

2. Click the Delete button  in the design toolbar (a red X).

3. Click the Save button .

Modifying Metadata Labels and Parameters
To modify a metadata label, do the following:

1. Click an existing metadata label name.

2. Make changes to the metadata label description as needed.

3. To modify a parameter, select the parameter and change the parameter settings.

4. Click the Save button .
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Previewing Metadata Labels and Values
To preview a metadata label and its values, select the label. All parameters for that label 
appear in the Preview/Test panel.

To toggle the display of to include or exclude category names, click the Categorize 
button . One display state displays parameters with the category headings, and the 
other display state displays parameters without the category headings.

Sorting Metadata Label Parameters
To change the order of the label parameters in the list, select a parameter and click the 
green up  and down arrow  buttons on the right side of the label list. Categories 
will display according to the order of the first parameter in each category.

Deleting Metadata Labels
To permanently remove a metadata label from the domain, select the label and click 
the Delete button  in the toolbar. Click OK to confirm the deletion.

Note: When you delete a metadata label, the deletion can render services and 
workflows inoperable. Be sure to update all actions and services that used the deleted 
label. For information on locating workflows that contain a specific metadata label, see 
Searching for Metadata Labels in Workflows.

Duplicating a Metadata Label
It can be easier to duplicate and rename a metadata label than it is to make a new one. 
To duplicate a metadata label, do the following:

1. Select the metadata label.

2. Click the Duplicate button  in the toolbar. 

3. Enter a new metadata label name.

4. Change additional metadata label settings as needed.

5. Click the Save button .

Exporting and Importing Metadata Labels
Vantage allows you to export metadata labels to XML files, which you can then use to 
import the same labels into another Vantage domain.

To export one or all metadata labels, do the following:

1. If you are exporting a single label, select the metadata label to export.

2. Click the Export button  to export a single label, or select Export all from the 
Export button drop down menu.
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3. Use the file system dialog to save the exported metadata labels.

The default file name is the metadata label name, but you can change the file 
name.

Note: Changing the name of the XML file does not change the name of the metadata 
label in the XML file.

To import a metadata label, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the metadata label to import, then 
click Open.

Note: If you try to import a metadata label that is already in this Vantage domain, 
Vantage prompts you to either overwrite the existing label (click Yes) or cancel the 
import (click No).

Searching for Metadata Labels in Workflows
Vantage allows you to search all workflows in a domain for a metadata label. This is very 
useful when you need to change or delete a metadata label, and you want to know 
which workflows might be affected by the change.

To search for metadata labels, do the following:

1. Select the metadata label for which you want to search.

2. Click the Search button  in the toolbar. 

If the metadata label name is used in any workflows, Vantage displays a list of work-
flows that use the label. Double-click any workflow in the list to open that workflow 
in Vantage Workflow Designer. Click Done to dismiss the list.

If the metadata label name is not used in any workflows, Vantage displays a mes-
sage to that affect. Click OK to dismiss the message.

Attachment Nicknames
Like media nicknames, nicknames are managed in the Management Console. You can 
also create attachment nicknames in Vantage Workflow Designer; but the 
Management Console allows media nicknames to be fully defined, including a 
definition.

Nicknames enable you to tag a specific attachment version with a convenient name, 
which you can use to reference the content and use it in workflow actions. In Vantage 
workflows, when you provide an attachment nickname, you can construct a workflow 
that allows the identification and manipulation of attachment files via the nickname 
you assign.
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The following sections describe attachment nickname management tasks:

 Using the Attachment Nicknames Details Panel

 Creating Attachment Nicknames

 Deleting Attachment Nicknames

 Exporting and Importing Attachment Nicknames

Using the Attachment Nicknames Details Panel
To manage nicknames in Vantage, select Workflow Design Items > Attachment 
Nicknames in the component panel. The Vantage Management Console displays the 
Attachment Nicknames details panel:

Figure 39. The Attachment Nicknames details panel.

Creating Attachment Nicknames
To create a new nickname, click the Create Nickname button  in the toolbar. The 
Management Console displays a Create Attachment Nickname dialog. Enter the name 
of this nickname and click OK.

The Management Console adds this nickname to the table. Optionally, add a 
description and click the Save button .

Deleting Attachment Nicknames
To permanently delete a nickname from the domain, click the Delete button  in the 
toolbar. Click Yes in the warning to confirm.

Toolbar buttons:
Create NIckname | Delete NIckname | Save | Import | Export
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Note: When you delete a nickname, it will render services and workflows inoperable if 
the nickname was used in it. Be sure to modify all actions and services that used the 
nickname you just deleted.

Exporting and Importing Attachment Nicknames
Vantage allows you to export attachment nicknames to XML files, which you can then 
use to import the same nicknames into another Vantage domain.

To export one or all attachment nicknames, do the following:

1. If you are exporting a single attachment nickname, select the attachment 
nickname to export.

2. Click the Export button  to export a single attachment nickname, or select Export 
all from the Export button drop down menu.

3. Use the file system dialog to save the exported attachment nicknames.

The default file name is the attachment nickname, but you can change the file 
name.

Note: Changing the name of the XML file does not change the name of the 
attachment nickname in the XML file.

To import an attachment nickname, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the attachment nickname file to 
import, then click Open.

Note: If you try to import an attachment nickname that is already in this Vantage 
domain, Vantage prompts you to either overwrite the existing label (click Yes) or 
cancel the import (click No).

Variables
Variables in Vantage are similar to variables in programming languages. You can create 
a variable, name it, assign and change its value, and use the variable in workflow 
actions and services to automate decisions.
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The following sections describe variable management tasks:

 Understanding Variables

 Displaying the Variables Details Panel

 Creating Variables

 Modifying Variables

 Deleting Variables

 Duplicating a Variable

 Exporting and Importing Variables

 Searching for Variables in Workflows

Understanding Variables
You can create variables with Vantage Management Console and with Vantage 
Workflow Designer, and you can assign default values. After you create a variable, the 
variable can be changed in Vantage Management Console, Vantage Workflow 
Designer, by an action in Vantage workflow, and by a Vantage operator using Vantage 
Workflow Portal. 

The default value is only used by a workflow action when the variable has not been 
assigned a value earlier in the workflow.

For example, suppose you want a variable named Email that you can use to specify an 
email address for use in a Message action within a workflow. Also suppose that you 
want to send the email to a single address most of the time, but you want the option to 
override the email address in a workflow. To do this, create an Email variable in Vantage 
Workflow Designer or the Vantage Management Console, and set the default value to 
the email address you want to use most of the time.

During workflow execution, the Message action operates as follows:

• If no other instance of the Email variable is created earlier in the workflow, the email 
is sent to the address specified by the default value in the email variable.

• If the Email variable is set earlier in the workflow, before the message action, the 
email is sent to the address specified by the earlier workflow action.
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Displaying the Variables Details Panel
To manage variables using Vantage Management Console, click Variables in the 
component panel. The Vantage Management Console displays the Variables panel:

Figure 40. The Variables panel.

Creating Variables
Variables are typically created in Vantage Workflow Designer, but you can create 
variables in Vantage Management Console as follows:

1. Click the Create Variable button  in the toolbar.

2. Provide a name for the variable. 

Variable names are case-sensitive. For example, FrameHeight and frameheight are 
different variables.

3. Select a variable type from the Value Type dropdown menu.

4. Enter a default value for the variable.

5. If needed, enter a description for the variable.

6. Click the Save button .

Toolbar buttons:
Create Variable | Delete Variable | Save | Duplicate | Search | Import | Export
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Modifying Variables
To modify a variable, select the variable, make your changes, and click the Save button 

.

Note: When you modify a variable, the change can render a service or workflow 
inoperable. Be sure to modify all services/actions that use the modified variable. For 
information on locating workflows that contain a specific variable, see Searching for 
Variables in Workflows.

Deleting Variables
To permanently remove a variable from the domain, select the variable and click the 
Delete button  in the toolbar. Click OK to confirm the deletion.

Note: When you delete a variable, the deletion can render services and workflows 
inoperable. Be sure to update all actions and services that used the deleted variable. 
For information on locating workflows that contain a specific variable, see Searching 
for Variables in Workflows.

Duplicating a Variable
It can be easier to duplicate and rename a variable than it is to make a new one. To 
duplicate a variable, do the following:

1. Select the variable.

2. Click the Duplicate button  in the toolbar. 

3. Enter a new variable name.

4. Change additional variable settings as needed.

5. Click the Save button .

Exporting and Importing Variables
Vantage allows you to export variables to XML files, which you can then use to import 
the same variables into another Vantage domain.

To export a variable, do the following:

1. Select the variable to export.

2. Click the Export button .

3. Use the file system dialog to save the exported variable.

The default file name is the variable name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the variable in 
the XML file.
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To import a variable, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the variable to import, then click 
Open.

Note: If you try to import a variable that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

Searching for Variables in Workflows
Vantage allows you to search all workflows in a domain for a variable. This is very useful 
when you need to change or delete a variable, and you want to know which workflows 
might be affected by the change.

To search for variables, do the following:

1. Select the variable for which you want to search.

2. Click the Search button  in the toolbar. 

If the variable is used in any workflows, Vantage displays a list of workflows that use 
the variable. Double-click any workflow in the list to open that list in Vantage Work-
flow Designer. Click Done to dismiss the list.

If the variable is not used in any workflows, Vantage displays a message to that 
affect. Click OK to dismiss the message.

Style Sheets
A style sheet can be used to transform an input metadata format to an output 
metadata format. A style sheet does not change the metadata values; it changes the 
presentation of the metadata.

You can use the Vantage Management Console to load and manage the style sheets 
that are available for use in Vantage workflows. Each style sheet has a nickname to 
make it easy to assign style sheets to a specific workflow.

The following sections describe style sheet management tasks:

 Understanding Style Sheets

 Using the Style Sheets Details Panel

 Adding and Modifying Style Sheets

 Deleting Style Sheets

 Exporting and Importing Style Sheets
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Understanding Style Sheets
Style sheets (XSL files) are the keystone of the Transform action. Style sheets enable you 
to convert one attachment file (XML) into a different attachment (XML file) or to 
convert the contents of an attachment into a custom label schema and vice-versa.

When you are processing media with metadata in a specific XML format and you are 
creating a workflow to convert the XML file into a different format or into a specific 
contextual metadata structure (for example, a label); you will need to provide a style 
sheet to perform the transformation.

When you add a new style sheet to your Vantage domain, the style sheet itself is 
wrapped in an XML file, providing a structure for the Vantage metadata: the name, 
description and identifying GUID. 

When you export style sheets, the entire XML file (the wrapper and the actual style 
sheet inside it) is saved. When you import a previously exported style sheet, you are 
importing an entire wrapper back into the domain. 

To replace the actual style sheet inside a style sheet already registered in the domain, 
click Change Style Sheet Definition.

Note: Style sheets and metadata transformation are advanced concepts. If you 
require assistance in implementing specific metadata transformations, please contact 
your customer service representative at Telestream to discuss custom style sheets for 
your specific workflow requirements.
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Using the Style Sheets Details Panel
To manage your style sheets in Vantage, click Style Sheets in the component panel. The 
Vantage Management Console displays the Style Sheets details panel:

Figure 41. The Style Sheets details panel.

Adding and Modifying Style Sheets

Adding a Style Sheet

To add a new style sheet to the domain, click the Add Style Sheet button  in the 
toolbar. The Vantage Management Console displays a file system dialog, so you can 
select a style sheet (XSL) file. Navigate to the directory where the file is stored. Select 
the file you want to import and click OK.

The Management Console adds the new style sheet to the table.

Next, name the style sheet and enter a description.

Saving the Style Sheet

When you’re done, click Save.

Renaming a Style Sheet

To rename a style sheet definition, select it in the table and edit the name to meet your 
requirements. Then, click the Save button  in the toolbar.

Toolbar buttons:
Create Style Sheet | Delete Style Sheet | Save | Import | Export

Style sheet 
table:
Displays all style 
sheets in the 
domain.

Edit & Test
Click Change to edit; Test to 
test your style sheet.
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Modifying a Style Sheet

To modify a style sheet definition, copy the original XSL file and edit it to meet your 
requirements in a suitable XML editor. Then, save the file.

Click on Change Style Sheet Definition. The Vantage Management Console displays a 
file system dialog, so you can select the style sheet (XSL) file. Navigate to the directory 
where the file is stored. Select the file you want to replace the current file with, and click 
OK.

The Management Console updates the style sheet with the new file reference.

Deleting Style Sheets
To permanently remove a style sheet from the domain, click the Delete button  in the 
toolbar. Click Yes in the warning to confirm.

Note: When you remove a style sheet from the domain, the XSL file is not erased—its 
reference is removed from the Vantage domain database. Removing a style sheet will 
render services and workflows inoperable if the style sheet was used in it. Be sure to 
modify all actions and services that used the style sheet you just deleted.

Exporting and Importing Style Sheets
Vantage allows you to export style sheets to XML files, which you can then use to 
import the same style sheets into another Vantage domain.

To export one or all style sheets, do the following:

1. If you are exporting a style sheet, select the style sheet to export.

2. Click the Export button  to export a single style sheet, or select Export all from the 
Export button drop down menu.

3. Use the file system dialog to save the exported style sheet.

The default file name is the style sheet name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the style 
sheet in the XML file.

To import a style sheet, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the style sheet to import, then click 
Open.

You cannot import XSL files—only style sheets that have been previously exported 
as XML files.

Note: If you try to import a style sheet that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Action Defaults
Action Defaults provide a way to set default Resource Cost and Retry settings for 
Vantage workflow actions. To adjust the action defaults, open the Action Defaults panel 
by selecting Workflow Design Items > Action Defaults, and selecting an action (see 
Figure 42).

Figure 42. Action Defaults

The following sections describe action management tasks:

 Understanding Resource Cost

 Configuring Retry Settings

 Exporting and Importing Action Defaults

Select Action 
Defaults

Select an 
action

Set Resource Cost

Retry Settings
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Understanding Resource Cost
 

When cost‐based load balancing is enabled, the resource cost is a value that you can set 
to establish a default cost for an action. A higher resource cost means that fewer actions 
can run at the same time, which reduces demand on server resources. A lower resource 
cost allows more actions to run simultaneously. For information on enabling cost‐based 
load balancing, see Managing Load Balancing.

Note: When cost‐based load balancing is disabled (which is the default setting), the 
resource cost for every action is 1 and any other setting is ignored.

Configuring Retry Settings
For some actions, Vantage allows you to configure a retry rule that defines how and 
when Vantage tries to execute an action that failed. Retry rules can be configured for an 
action type in the Vantage Management Console, and rules can be configured for 
specific actions in a workflow using Vantage Workflow Designer. When a retry rule is 
defined in a workflow for an action, that rule overrides any rule for that action type that 
is defined in Vantage Management Console.

The default retry rule for all action types defined in Vantage Management Console is No 
Retry. When an action type supports retry rules, you can specify a limited retry rule or a 
recurring retry rule.

A limited retry rule can specify up to 3 retries, each with a defined delay period and a 
priority. For example, you can specify (in the Vantage Management Console) that all 
Flip actions retry the first time after five minutes at priority 10, and that Flip actions 
retry a second time after 10 minutes at priority 20.

A recurring retry rule specifies that Vantage retry all failed actions of the specified type 
indefinitely until the action executes. You can specify a retry interval and priority for a 
recurring retry rule. For example, you can specify that Vantage retry failed Copy actions 
every 2 minutes at priority 30 until the Copy action executes successfully.

It is important to keep in mind that individual action retry rules specified in Vantage 
Workflow Designer override the default retry rules specified in the Vantage 
Management Console. For example, if a workflow is configured to retry a message 
action twice after failure and the Vantage Management console is configure for No 
Retry for message actions, Vantage will retry the failed message action twice, as 
specified in the workflow.

The following sections describe retry rule management:

 Viewing Action Retry Rules

 Configuring Action Retry Rules
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Viewing Action Retry Rules

To view the retry configuration for any action, do the following:

1. In the Vantage Management Console component panel, open Workflow Design 
Items > Action Defaults.

2. Select an action in the Action Defaults details panel.

3. View the configuration in the Action panel.

Not all actions support action retry rules.

Configuring Action Retry Rules

To configure a retry rule for any action, do the following:

1. In the Vantage Management Console component panel, open Workflow Design 
Items > Action Defaults.

2. Select an action in the Action Defaults details panel.

3. To disable retries, click No Retry.

4. To define a limited retry rule, click Limited Retry and complete the rule as follows:

a. For the first retry, specify the delay period number and units and execution 
priority.

b. For a second or third retry, check the appropriate checkbox and complete the 
rule configuration.

5. To define a recurring retry rule, click Recurring Retry and specify the delay period 
number and units and execution priority.

6. Click the Save button .

Exporting and Importing Action Defaults
Vantage allows you to export action defaults to XML files, which you can then use to 
import the same action defaults into another Vantage domain.

To export one or all action defaults, do the following:

1. If you are exporting a single action default, select the action default to export.

2. Click the Export button  to export a single action default, or select Export all from 
the Export button drop down menu.

3. Use the file system dialog to save the exported action default.

The default file name is the action default name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the action 
default in the XML file.

To import an action default, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the action default file to import, then 
click Open.
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Note: If you try to import an action default that is already in this Vantage domain, 
Vantage prompts you to cancel or confirm replacement.

Domain Workflow Analytics
Workflow Analytics is a Vantage Enterprise Control and Master Control feature which 
enables you to visually analyze workflows and job history to identify problems and 
improve overall system performance.

 

In Workflow Designer, Workflow Analytics enables you to view jobs (based on the job 
history currently in the domain database) on a case-by-case basis to:

• Identify performance bottlenecks by action in a workflow

• Analyze workflow execution by action in a workflow

Note: For details on how to use Workflow Analytics in the Vantage Designer, click the 
Help button  in the toolbar to display the Designer help system.

In the Management Console, Workflow Analytics enables you to view all actions and 
workflows (based on the job history currently in the domain database) to stack-rank 
workflows and actions to identify primary CPU resource consumers within a domain. 
You can use this information to modify workflow design and improve Vantage domain 
performance and efficiency.

To view the Domain Workflow Analytics expand the Vantage Domain node, click 
Domain Workflow Analytics, and select either Action or Workflow analytics (see 
Figure 43).
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Figure 43. Domain Workflow Analytics Window

The following sections describe the two kinds of analytics available in the Management 
Console:

 Action Analytics

 Workflow Analytics

Action Analytics
Action Analytics presents average execution times of all actions in selected workflows. 
Actions are identified by name, description, and associated workflow.

Expand Vantage Domain node

Click Domain Workflow Analytics

Select Analytic Type
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Figure 44. Action Analytics Window.

Table 15. Action Analytics Buttons and Configuration Options

Button or Option Description

Workflow Designer 
button

Click the Workflow Designer button to open the 
Workflow Designer.

Note: If Workflow Designer is already open and 
positioned behind the Management Console window, 
the Management Console remains in front of the 
Workflow Designer window and the Workflow Designer 
button flashes in the task bar. Click the Workflow 
Designer button in the task bar to display the Workflow 
Designer window in front of the Management Console.

Refresh button Click the Refresh button to update the list of actions.

Action Name This column displays all of the actions in the workflows.

Action Description This column displays the descriptions that are associated 
with each action.

Average Execution Time This is the average execution time of the named action 
for all workflows.

Workflow The name of the workflow that contains the named 
action.

The set of workflows to be analyzed can be selected by 
checking the Only analyze jobs checkbox, checking other 
checkboxes that apply, and changing dates and times.

Workflow Designer button

Refresh button
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Workflow Analytics
Workflow Analytics presents information about workflow job history. A list of workflows 
is displayed along with statistical information about each workflow (total number of 
jobs, execution time, etc.) based on the job history of each workflow. You can right-click 
on any workflow and select Open Workflow to launch (or display, if already running) the 
Workflow designer, showing the selected workflow. 

Note: If the Workflow Designer is already running and is hidden behind another 
window when a workflow is requested, the Windows task bar button will flash, 
indicating that the Workflow Designer has something new to display.

Figure 45. Workflow Analytics Panel.

Newer than and Older 
than

Workflows within a range of dates and times can be 
selected by checking Newer than and Older than 
checkboxes and setting the dates and times accordingly.

That ran between Workflows between a beginning and end time can be 
selected by checking the That ran between checkbox and 
setting the times.

That ran after the last 
workflow layout change

Check the That ran after the last workflow layout change 
check box to select all workflows that ran after the last 
workflow layout change.

Table 15. Action Analytics Buttons and Configuration Options (Continued)

Button or Option Description
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The set of workflows to be analyzed can be selected by checking the Only analyze jobs 
checkbox, checking other checkboxes that apply, and changing dates and times.

Figure 46. Workflow Analytics Selection Panel

Table 16. Column Descriptions, Workflow Analytics Panel

Column Description

Workflow The name of the workflow as it was defined in the 
Workflow Designer.

Total Jobs The total number of jobs (in a selected group) that have 
run using the named workflow.

Cumulative Workflow 
Processing Time

The total execution time for all selected workflows.

Average Completion 
Time

Total Completion Time divided by Total Jobs.

Cumulative Action 
Execution Time

The total execution time of all actions in a workflow.

Average Action Execution 
Time

Total Action Execution Time divided by the number of 
actions in the workflow.

Bottleneck Action 
Average Execution Time

The longest action execution time in the workflow.

Bottleneck Action The name of the bottleneck action. If there is no apparent 
bottleneck, no action is listed (blank).

Bottleneck Action 
Description

Description associated with the bottleneck action.
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Support Utilities
Vantage provides utilities to import and export workflows, collect important 
information about your domain, and send this data to Telestream Customer Service to 
help diagnose and solve a problem. Utilities also perform other important tasks to help 
you manage your domain effectively.

Figure 47. Support Utilities Panel

Table 17. Workflow Analytics Configuration Options

Option Description

Only analyze jobs Enables filtering of the job list based on the other options 
specified.

Newer than and Older 
than

Workflows within a range of dates and times can be 
selected by checking Newer than and Older than 
checkboxes and setting the dates and times accordingly.

That ran between Workflows between a beginning and end time can be 
selected by checking the That ran between checkbox and 
setting the times.

That ran after the last 
workflow layout change

Check the That ran after the last workflow layout change 
check box to select all workflows that ran after the last 
workflow layout change.

Whose state is Check any combination of the four provided state 
checkboxes to select a set of workflows. (See the Vantage 
Workflow Designer User Guide for the definitions of these 
states).
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To copy selected log entries to the clipboard first select the log entries to copy. Then, 
click the Copy button in the toolbar, select Copy from the context menu, or use the 
control-C keyboard command.

Plug-in Versions. Displays the list of plugins in the domain by service, including their 
version number. 

The following sections describe the Support Utilities:

 Vantage Workflows

 Data Collection

 Change Log

 Error Log

 Actions

 Plug-in Versions

Vantage Workflows
Use the Vantage Workflows utility to display, import, and export your workflows. You 
can also open a workflow in Workflow Designer.

When exporting workflows, workflows are saved as XML files—there is one workflow 
per file. You might want to export some workflows to send to a colleague at another 
station to replicate the same workflow. Or, you might want to export a workflow to 
import it into another domain. During a troubleshooting session with Telestream 
customer service, you might be asked to send the workflow in question to Telestream 
for clarity and review.
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Click Vantage Workflows in the component panel to display its details panel: 

Figure 48. The Vantage Workflows details panel.

The following topics describe how to manage workflows:

 Opening a Workflow in Vantage Workflow Designer

 Exporting Workflows

 Importing Workflows

 Refreshing the Workflow Display

Opening a Workflow in Vantage Workflow Designer
To launch Vantage Workflow Designer from Vantage Management Console and 
manage a workflow, select the workflow in Vantage Management Console and click the 
Workflow Designer button .

Note: If Vantage Workflow Designer is already open and positioned behind the 
Vantage Management Console window, the Management Console remains in front of 
the Workflow Designer window and the Workflow Designer button flashes in the task 
bar. Click the Workflow Designer button in the task bar to display the Workflow 
Designer window in front of the Management Console.

Toolbar buttons:
Import Button | Export Button | Workflow Designer | Refresh Button
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Exporting Workflows
To export a one or more workflows, do the following:

1. If you are exporting a single workflow, select a workflow to export.

2. Click the Export button  to export a single file, or click the export button drop 
down list and select Export All to export all workflows.

3. When the file system dialog appears, select the folder where you want to store the 
exported workflows.

The exported workflows are stored in a folder that is named for the workflow category 
that contains the workflow. For example, if you have four workflows in a category 
named Production, exporting all four workflows stores four XML files in a folder named 
Production. Each exported file is named the same as the workflow name. 

Note: Telestream recommends that you do not change the exported file name during 
or after the export.

Importing Workflows
To import a one or more workflows, do the following:

1. Click the Import button  in the toolbar to display a file system dialog, which you 
can use to select a workflow file to import. 

2. Navigate to the directory where the workflow XML file is stored, select the file or 
files you want to import, and click OK.

3. When prompted to select a workflow category, select a category from the drop 
down list or type a new category name, then click OK. (The default category name 
is Imported.)

Note: You cannot import two copies of the same workflow, regardless of whether the 
XML filenames are the same or different. To duplicate a workflow, perform the task in 
Vantage Workflow Designer.

Refreshing the Workflow Display
To refresh the display of Vantage workflows, click the Refresh button .
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Data Collection
The Data collection utility enables you to collect relevant information about selected 
services for transmission to Telestream during a troubleshooting session. You can also 
log point-in-time details about a selected service into a log file for diagnostics 
purposes. 

Click Data Collection in the component panel to display its details panel:

Figure 49. The Data Collection details panel.

To collect data for one or more services, select the service (option-click to select 
multiple) and click Collect data. Files named for each service are saved in the specified 
directory.

Vantage writes the files out as <ServiceType>.txt and displays a dialog to notify you of 
the location of the file so that you can open and read the file or send it to others for 
analysis.

You can email these files to Telestream for assistance in solving problems during 
troubleshooting sessions.

Change Log
The Change Log utility enables you to track changes to the domain by time, user, and 
host—for example, adding or removing services, or changing, starting, or stopping 
workflows. 

Click Change Log in the component panel to display its details panel (Figure 50).
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Figure 50. The Change Log details panel.

Table 18. Change Log Toolbar Buttons and Configuration Options

Button or Option Description

Delete button Select one or more change log records, and click Delete 
to remove them from the database.

Copy button Select one or more change log records, and click Copy to 
place these records on the clipboard as text, so that they 
can be pasted into other applications—for example, a 
spreadsheet.

Refresh button Click to update the table from the database.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to 
specify the maximum number of log items.

User contains Specifies change log entries that contain the specified 
text in the User field.

Host contains Specifies change log entries that contain the specified 
text in the Host field.
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Error Log
The Error Log utility Enables you to track errors that occur in the domain by time, 
source, and host. 

Click the Error Log button in the component panel to display its details panel 
(Figure 50).

Figure 51. The Error Log details panel.

Message contains Specifies change log entries that contain the specified 
text in the Message field.

Newer than Displays change log entries that are new than the 
specified date.

Older than Displays change log entries that are older than the 
specified date.

Table 18. Change Log Toolbar Buttons and Configuration Options (Continued)

Button or Option Description
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Actions
Use the Actions import/export utility to import and export your actions. Actions are 
saved as XML files—one action per file. The following sections describe export and 
import tasks:

 Displaying Actions for Export and Import

 Exporting Actions

 Importing Actions

Displaying Actions for Export and Import
The Management Console sorts the actions by service. To display the actions for a 
service, do the following:

1. Open Support Utilities > Actions > By Service in the component panel.

2. Select the service for which you want to display actions (Figure 52).

Table 19. Change Log Toolbar Buttons and Configuration Options

Button or Option Description

Delete button Select one or more error log records, and click Delete to 
remove them from the database.

Copy button Select one or more error log records, and click Copy to 
place these records on the clipboard as text, so that they 
can be pasted into other applications—for example, a 
spreadsheet.

Refresh button Click to update the table from the database.

Filter By Check Filter by to enable the filtering controls.

Modify Click Modify to display a dialog that enables you to 
specify the maximum number of log items.

User contains Specifies change log entries that contain the specified 
text in the User field.

Host contains Specifies change log entries that contain the specified 
text in the Host field.

Message contains Specifies change log entries that contain the specified 
text in the Message field.

Newer than Displays change log entries that are new than the 
specified date.

Older than Displays change log entries that are older than the 
specified date.
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Figure 52. The Actions details panel.

Exporting Actions
To export one or more actions, do the following:

1. Select the actions to export.

2. Click the Export button .

3. Use the file system dialog to save the exported actions.

The default file name is the action default name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the action in 
the XML file.

Importing Actions
When you import an action into a domain, it is not associated with a workflow. Instead, 
the imported action displays in the appropriate actions list in Vantage Workflow 
Designer. When you add this action to a workflow, it has all of the settings of the 
original action.

To import an action, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the action file to import, then click 
Open.

Toolbar buttons:
Import Button | Export Button | Refresh Button
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Plug-in Versions
Use the Plug-in Versions utility to display the components that are running in the 
domain, filtered by service.

Select Plug-in Versions > By Service in the component panel and then click a given 
service to display its details panel:

Figure 53. The Plug-In Versions > Services details panel.

The Plug-In Versions component enables you to determine which components are 
installed and determine their version number.

Application Configurations
The Application Configurations component lists client applications that the 
Management Console can manage. 

To display the client programs that you can manage, select Application Configurations 
in the component panel.

Refer to the following sections for more information on these applications:

 Job Status Views

 Configuring Workflow Portal Operation
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Job Status Views

Job Status Views is a Web application that provides operators and managers with job 
status information that focuses on jobs, rather than the comprehensive system point of 
view offered by Web Dashboard. Using the Management Console, you can configure 
views, which define what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows. 
You can create additional views that represent a single workflow, and those views can 
be configured as public or private. Public views are available to all Vantage users, and 
private views are available only to approved users.

Note: For a comprehensive overview of the Job Status Views Web application 
program, see the Vantage User’s Guide.

The following sections provide information on view configuration tasks:

 Displaying the View Configuration Panel

 Enabling and Disabling the All Workflows View

 Creating a New View

 Renaming a View

 Duplicating a View

 Deleting a View

 Selecting and Changing the Workflow for a View

 Displaying All Jobs or All Jobs in Process

 Selecting Full or Read-Only Access

 Choosing the Display Columns

 Configuring User or Public Access

 Refreshing the View List

 Exporting and Importing Views

Displaying the View Configuration Panel
To view the view configuration window, open Application Configurations in the 
component panel and select Job Status Views. The Management Console displays the 
Job Status Views detail panel shown in Figure 54.
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Figure 54. The Job Status View Configuration Window.

Enabling and Disabling the All Workflows View
When you enable the All Workflows view, any Vantage user with access to this view sees 
information on all workflows in the domain. When this view is disabled, no user can 
view information on all workflows.

To enable or disable the All Workflows view, do the following:

1. Display the Job Status Views details view.

2. Select the All Workflows view.

3. Check (enable) or clear (disable) the Enable checkbox.

4. Click the Save button .

Create Configuration
 Delete

Save
Duplicate Import 

Export 

Refresh
Vantage Domain Management Guide



Using the Vantage Management Console
Application Configurations

203
Creating a New View
To create a new view, do the following:

1. Display the Job Status Views details view.

2. Click the Create Configuration button .

3. When the Select Workflow dialog appears, select a workflow for the view and click 
OK.

4. If you want, enter a description of the view in the Description text box (this is 
optional).

5. Click the Save button .

Renaming a View
To rename a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to rename.

Note: You cannot rename the All Workflows view.

3. In the Name text box, enter a new name for the view.

4. Click the Save button .

Duplicating a View
To duplicate a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to duplicate.

Note: You cannot duplicate the All Workflows view.

3. Click the Duplicate button .

4. In the Name text box, enter a name for the duplicate view.

5. In the Description text box, enter a description for the duplicate view.

6. Click the Save button .

Deleting a View
To delete a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to delete.

Note: You cannot delete the All Workflows view.
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3. Click the Delete button .

4. When the confirmation dialog appears, click OK.

Selecting and Changing the Workflow for a View
To change the workflow for a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

Note: You cannot change the workflow displayed in the All Workflows view.

3. Click the Select.

4. When the Select Workflow dialog appears, select a workflow for the view and click 
OK.

5. Click the Save button .

Displaying All Jobs or All Jobs in Process
You can configure each view to display all jobs or only the jobs that are currently in 
process. When configured to display only in process jobs, jobs that are in any other state 
(completed, failed, stopped by user, etc.) do not display. Some people might prefer to 
view all jobs, while others prefer to view the shorter list of in process jobs.

To configure the scope of jobs for a view, do the following:

1. Display the Job Status Views details view.

2. To display in process jobs only, check the Show Only “In Process” Jobs checkbox.

3. To display all jobs, clear the Show Only “In Process” Jobs checkbox.

4. Click the Save button .

Selecting Full or Read-Only Access
You can configure each view to support full access or read-only access. Full access 
permits operators to use Job Status Views to control jobs with the Stop, Restart, and 
Delete actions. Read-Only access allows operators to view job status and disallows the 
control functions.

To configure the scope of access for jobs in a view, do the following:

1. Display the Job Status Views details view.

2. Check (read-only access) or clear (full access) the Read Only Access checkbox.

3. Click the Save button .
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Choosing the Display Columns
Every view displays the Job and State columns. You can configure views for individual 
workflows to include or exclude the following columns:

• Total Progress

• Started

• Updated

• Expires

• Additional columns for workflow actions

When you choose to display a column for a workflow action, the column displays the 
state of that action. This can help you use Job Status Views to view the state of actions 
during workflow processing.

To define which columns appear in a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

3. In the Columns row, check (display) or clear (hide) the checkboxes for the columns 
you want to display.

Figure 55. Single Workflow Configuration

Description
Select
Options
Columns

Selected Workflow

Permitted Users

Actions
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4. If you are modifying a view for a single workflow, you can add or delete columns for 
actions as follows:

a. Select the Actions tab.
b. In the Available pane, select the actions you want to display in the view, and click 

Add.
c. In the Visible to user pane, select the actions you want to hide, and click Remove.
d. To change the display order in the view, select an Action in the Visible to user 

pane, and use the green up  and down arrow  buttons to arrange the 
viewing order.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other action columns. The last item in the list 
becomes the last column on the right.

5. Click the Save button .

Configuring User or Public Access
You can configure a view to be available to all users (public) or to individual Vantage 
users.

Note: Users with administrative privileges will have full access whether or not they 
are given permission.

To define which Vantage users can access a view, do the following:

1. Display the Job Status Views details view.

2. Select the view to modify.

3. Select the Permitted Users tab.

Figure 56. All Workflows Configuration

4. To make the view available to all Vantage users, do the following:

a. Check the Everyone (Public View) check box.
b. Click the Save button .

Default description
Enable
Options
Columns

Permitted Users
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5. To make the view available to select Vantage users, do the following:

a. Clear the Everyone (Public View) check box.
b. In the Available pane, select the users who should have access, and click Add.
c. In the Visible to user pane, select the users who should not have access, and click 

Remove.
d. Click the Save button .

Refreshing the View List
When you open the Job Status Views detail panel, the Management console displays 
the current view configuration. If another administrator is making changes (such as 
adding Vantage users), you must refresh the display to see those changes. To refresh 
the display, click the Refresh button .

Exporting and Importing Views
Vantage allows you to export views to XML files, which you can then use to import the 
same views into another Vantage domain.

To export one or all views, do the following:

1. If you are exporting a single view, select the view to export.

2. Click the Export button  to export a single view, or select Export all from the 
Export button drop down menu.

3. Use the file system dialog to save the exported views.

The default file name is the view name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the view in 
the XML file.

To import a view, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the view file to import, then click 
Open.

Note: If you try to import a view that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

Workflow Portal
The Workflow Portal panel defines Workflow Portal configurations that specify the 
display items and controls available to operators when they run Workflow Portal. For 
more information, see Configuring Workflow Portal Operation.
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Report Configurations

Report configurations allow you to generate custom Vantage report formats that 
operators can use to produce reports on jobs that they view with Workflow Designer. 
Vantage supports the following report configurations:

 Job Reports

Job Reports
Use the Job Reports details panel to manage job report formats. Job report formats are 
saved to files using the comma separated value (CSV) format, which can be read by 
other programs. The following sections describe tasks for managing job report formats:

 Displaying the Job Reports Details Panel

 Creating a New Job Report Format

 Including and Excluding the Header Row

 Choosing the Report Columns

 Duplicating a Job Report

 Deleting a Job Report

 Refreshing the Report List

 Exporting and Importing Job Reports

Displaying the Job Reports Details Panel
To view the Job Reports details panel, open Report Configurations in the component 
panel and select Job Reports. The Management Console displays the Job Reports detail 
panel shown in Figure 57.
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Figure 57. Job Reports Panel

Creating a New Job Report Format
You can create job report formats in the Management Console and in Workflow 
Designer.

To create a new report format in the Management Console, do the following:

1. Display the Job Reports details view.

2. Click the Create report button .

The Management console adds a new report to the report list.

Toolbar buttons:
Create | Delete | Save | Duplicate | Import | Export | Refresh
Vantage Domain Management Guide



Using the Vantage Management Console
Report Configurations

210
3. Select the new report in the list.

4. Enter a new name in the Name text box.

5. If you want, enter a report description in the Description text box (the description is 
optional).

6. Click the Save button .

Including and Excluding the Header Row
To include or exclude a header row in the job report, do the following:

1. Display the Job Reports details view.

2. Select the report to modify.

3. Check the Add Header Row check box to include the header row, or clear the 
checkbox to exclude the header row.

4. Click the Save button .

Choosing the Report Columns
You can configure reports to include or exclude the following columns:

• Job ID

• Job Name

• State

• Progress

• Started

• Updated

• Expires

• Workflow Name

• Additional columns for metadata label parameters

When you choose to display a column for a metadata label, the column displays the 
label value.

To define which columns appear in a report, do the following:

1. Display the Job Reports details view.

2. Select the report to modify.

3. In the Columns row (see Figure 57), check (display) or clear (hide) the checkboxes 
for the columns you want to display.
Vantage Domain Management Guide



Using the Vantage Management Console
Report Configurations

211
4. To add or delete columns for metadata labels, do the following:

a. Click the Column button .
b. In the Labels pane, select a label for which you want to display parameters.
c. In the Parameters pane, check the checkbox for any parameter you want to 

display, and clear the checkbox for any parameter you do not want to display.
d. To toggle the display to include or exclude category names, click the Categorize 

button . One display state displays parameters with the category headings, 
and the other display state displays parameters without the category headings.

e. Repeat parameter label selection until all labels are properly selected.
f. Click OK.

5. To change the displayed order of parameter labels, select a label in the list and use 
the green up  and down arrow  buttons to move the label in the list.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other label columns. The last item in the list becomes 
the last column on the right.

6. Click the Save button .

Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All other configuration settings in the duplicate report match those in the original 
report.

To duplicate a job report, do the following:

1. Display the Job Reports details view.

2. Select the report to duplicate.

Note: You duplicate one report at a time.

3. Click the Duplicate button .

4. In the Name text box, enter a name for the duplicate report.

5. In the Description text box, enter a description for the duplicate report.

6. Click the Save button .

Deleting a Job Report
To delete a job report, do the following:

1. Display the Job Reports details view.

2. Select the report or reports to delete.

3. Click the Delete button .

4. When the confirmation dialog appears, click OK.
Vantage Domain Management Guide



Using the Vantage Management Console
User Management

212
Refreshing the Report List
When you open the Job Reports detail panel, the Management console displays the 
current job reports configuration. If another administrator adds or changes reports, you 
must refresh the display to see those changes. To refresh the display, click the Refresh 
button .

Exporting and Importing Job Reports
Vantage allows you to export job reports to XML files, which you can then use to import 
the same reports into another Vantage domain.

To export one or all reports, do the following:

1. If you are exporting a single report, select the report to export.

2. Click the Export button  to export a single view, or select Export all from the 
Export button drop down menu.

3. Use the file system dialog to save the exported reports.

The default file name is the report name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the report in 
the XML file.

To import a report, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the report file to import, then click 
Open.

Note: If you try to import a report that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.

User Management

User management requires Vantage users to log in using a Vantage user—a username 
and password assigned to them by the Vantage system administrator. The Vantage 
system administrator uses the Management Console to create, remove, and edit user 
profiles. Users, however, are allowed to change their own password.
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The user management feature enables the administrator to control which users have 
access to the following:

• Vantage Web applications

• Vantage Workflow Portal client application

• Workflow categories in the Vantage Workflow Designer client application

• Vantage Management Console

For instructions on enabling and disabling user management, see Enabling and 
Disabling User Administration. The following sections describe how to manage users 
when user management is enabled:

 Adding Users

 Setting Passwords

 Removing Users

 Importing and Exporting Users

Adding Users
To add a new user, click the New User button . When the dialog box displays, enter the 
username and password (and confirm the password) of the new user. If the new user is 
to have administrator privileges, check the Administrator checkbox. Click OK to close 
the dialog box, then click the Save button  to save your changes.
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Figure 58. User Management Panel

Users can also be given or denied administrator privileges by checking (or unchecking) 
the Administrator checkbox located at the bottom of the User Management panel. The 
target user must be selected when this action is taken. After checking or unchecking 
the Administrator checkbox, click on the Users list to prompt a dialog box to confirm 
this change.

Setting Passwords
To set the password of a user, click the Set Password button. When the dialog box 
displays, enter the password (and confirm the password) of the user. Click OK to close 
the dialog box, then click the Save button  to save your changes.

Removing Users
Users can be removed by selecting the user in the Users list and clicking the Delete 
button  at the top of the User Management panel. When requesting the removal of a 
user, a dialog box will display asking you to confirm this action. You cannot undo the 
removal of a user, thus to restore a user you must add him again as a new user.

New User button

Remove User button

Set Password button

Administrator checkbox

Save button

Import Users button
Export Users button
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Importing and Exporting Users
User lists can be imported and exported. To import a list of users, click the Import 
button , navigate to the XML file containing a list of users, and click the Open button. 
To export a list of users, click the Export button , enter an XML filename for the list of 
users, and click the Save button.

Domain Backup/Restore
Use Domain Backup/Restore to save archival copies of the Vantage domain database in 
a separate file, and to replace your current domain database with the contents of a 
previously-saved archive.

The following sections describe domain backup and restore:

 Understanding Domain Backup and Restore

 Using Backup and Restore Utilities

Note: You cannot use Domain Backup/Restore to move a Vantage domain database 
of one version to a later version of Vantage. To upgrade Vantage, only use Vantage 
installers, as described in the upgrade instructions (Preparing to Upgrade to Vantage 
4.0).

Understanding Domain Backup and Restore
It is important to understand that the Vantage domain database contains all workflows, 
all services, and all jobs registered to the domain. In particular, the services identified in 
the domain are those registered upon installation, plus changes you have made after 
installing (or removing) other services.

CAUTION: Restoring a Vantage domain should be performed on the same machine it 
was backed up from—or if to another machine, the services defined in the database 
must match the services installed. Alternatively, you can remove all licenses and 
services from the domain if you are moving it to another computer. Restoring a 
domain does not install (or recreate the actual domain—only its definition).

For example: you back up a domain, then operate it for several hours, make changes to 
a few workflows (or add new ones), and add or remove some services after installing 
them or uninstalling them. 

Next, you restore the domain using the backup from a few hours ago. Now, you have 
the domain as it existed when the backup was created—intervening job records are 
lost, workflows you added or changed are gone, and the registered services do not 
reflect the actual services you may have installed or uninstalled.
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Using Backup and Restore Utilities
Click Domain Backup/Restore in the component panel to display its details panel:

Figure 59. Domain Backup/Restore panel.

The Active Services table enables you to determine that all services are acquiesced 
prior to performing a backup or a restore of the Vantage domain database. If you 
perform a backup while services are executing workflow tasks, although all records will 
have integrity (be complete), some job records may be lost.

Likewise, before restoring a Vantage domain database, review the Active Services table 
to determine that all sessions display 0, indicating no jobs are being processed. When 
you restore a system, all services are stopped, the current database contents are 
irretrievably destroyed and the archive database is restored, and the services are 
restarted with the Vantage domain database repopulated with the backup database 
values.

Be certain to back up the current database prior to restoring the database from a 
previous backup, so that in case of failure, you can reload the current database.

Backup Button | Restore Button
Vantage Domain Management Guide



Using the Vantage Management Console
Using the Help System

217
CAUTION: Always back up your current database before restoring it to an earlier 
backup. Restoring your Vantage domain database overwrites the entire contents of 
the current database with the contents of the backup file selected.

Using the Help System
The Vantage Online Help system consists of two panels: The left panel has three 
selection tabs and the right panel is the topic display area.

The three tabs are: 

• The Contents tab displays a hierarchically organized set of chapters and pages. This 
list provides a wide range of overview and how-to topics that explain how to add, 
configure, and manage Vantage components.

• The Search tab enables you to look for specific words or phrases. The Online Help 
System displays a list of topics that match your search criteria. 

• The Favorites tab provides a list of user selected topics. Click the Add button to add 
the current topic to the favorites list. Click Remove to remove a selected topic and 
click Display to display the topic in the panel on the right side of the help window.

Table 20. Domain Backup/Restore Controls

Control Description

Backup Click Backup to display a file system dialog, so you can 
create an SQL backup file. Navigate to the directory 
where you want to save the backup file, name it (for 
example, Vantage_12_07_09.bak) and click Save to back 
up your Vantage domain database and save it in the 
specified folder.

Restore Click Restore to display a file system dialog, so you can 
select a SQL backup file you created earlier and restore 
your Vantage domain database. Navigate to the directory 
where you saved the backup file and select it. Click Open 
to restore your Vantage domain database with the 
information in your backup (archive) file.
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Renaming a Vantage Domain
Each Vantage domain uses the name assigned to the Windows server that hosts the 
Vantage domain database. To rename a Vantage domain, you must complete the 
following tasks (which are described in more detail later in this topic):

• Remove all Vantage services from the Vantage domain.

• Rename the Windows server that hosts the Vantage domain database.

• Restart the renamed server and add all Vantage services to the renamed domain.

Note: If the Vantage domain database is a mirrored database, you must remove any 
Vantage licenses prior to renaming the Vantage domain. If you do not remove the 
licenses first, your licenses will become invalid after the rename is complete.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the Vantage domain 
configuration is retained. After the Vantage domain is renamed, all Vantage users and 
administrators will need to specify the new Vantage domain name when connecting to 
the domain with Vantage client or web applications.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage domain interrupts all Vantage services in the domain and all 
Windows services on the server to be renamed.

Use the following procedure to rename a Vantage domain:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

2. Select Services in the component panel.

3. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Click Start > Administrative Tools > Server Manager.

7. Click Server Manager in the left pane.

8. Click Change System Properties in the right pane.

9. Select the Computer Name tab and click Change.

10. Edit the computer name in the Computer Name text box and click OK.

11. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.
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Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

12. Restart the server.

13. Start the Vantage Management Console, select the new domain to manage, and 
log on.

14. Select Services in the Component panel.

15. Click the Add Service button  in the toolbar.

16. When the Select Service dialog appears, click Machine to sort the services by 
machine name.

17. To add Vantage services for a specific machine, select the services you want and 
click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.

19. Send the new Vantage domain name to all Vantage users and administrators so 
they can reconnect to the Vantage domain.

Renaming a Vantage Server
To rename a Vantage server, you must complete the following tasks (which are 
described in more detail later in this topic):

• Remove all Vantage services for the server to be renamed from the Vantage 
domain.

• Rename the Windows server.

• Restart the renamed server and add all Vantage services on the renamed server to 
the Vantage domain.

Note: Do not use this procedure to rename a server that hosts the Vantage domain 
database. Instead, see Renaming a Vantage Domain.

When you remove Vantage services from the domain, the Storage, Variable, and 
Qualification rule configuration for each service is lost. The rest of the server 
configuration is retained.

Note: To complete this procedure, you must have permission in your Windows 
domain to rename the computer, or you must get assistance from your Windows 
domain administrator. Be sure to schedule the rename during a maintenance window, 
as renaming the Vantage server interrupts all Vantage services and Windows services 
on the server to be renamed.
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Use the following procedure to rename a Vantage server:

1. Start the Vantage Management Console, select the domain to manage, and log on 
as described in Starting the Vantage Management Console.

2. Select Services in the component panel.

3. Take note of any Storage, Variables, and/or Qualification Rules settings for each 
service.

Write down any Storage, Variable, and/or Qualification Rule settings that you want 
to reconfigure after the Vantage domain is renamed.

4. Click a service in the Services details panel, and enter Ctrl-A to select all services.

5. Click the Remove Service button  in the toolbar.

6. Click Start > Administrative Tools > Server Manager.

7. Click Server Manager in the left pane.

8. Click Change System Properties in the right pane.

9. Select the Computer Name tab and click Change.

10. Edit the computer name in the Computer Name text box and click OK.

11. If prompted to do so, enter a Windows user name and password for an account that 
has permission to rename this computer in the Windows domain.

Note: If you do not have the appropriate permissions, contact the administrator for 
your Windows domain.

12. Restart the server.

13. Start the Vantage Management Console, select the domain to manage, and log on.

14. Select Services in the Component panel.

15. Click the Add Service button  in the toolbar.

16. When the Select Service dialog appears, click Machine to sort the services by 
machine name.

17. To add Vantage services for the renamed server, select the services you want and 
click OK.

18. If any Storage, Variables, and/or Qualification Rules settings were configured for 
services, add them now.
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Configuring Workflow
Portal Operation
Use this chapter to learn how to set up and configure Workflow Portal configurations 
that control how Workflow Portal operators use the Workflow Portal application. This 
chapter includes the following topics:

 Introduction to Workflow Portal

 Introduction to Workflow Portal Configurations

 Managing Workflow Portal Configurations

 Workflow Portal Deployment Tips

 Vantage Workflow Portal Tours

Note: Vantage Workflow Portal requires a Vantage Workflow Portal license for each 
active Workflow Portal session. To determine how many Workflow Portal licenses are 
supported in your domain, count the number of Vantage Workflow policies displayed 
in the Management Console (see Viewing Vantage Licenses). For information on 
managing the active Workflow Portal sessions, see Viewing and Resetting Workflow 
Portal Licenses.

Introduction to Workflow Portal
Vantage includes two Workflow Portal applications, a client application and a web 
application, that allow operators to do some or all of the following:

• View binder information created by a workflow

• View proxy media generated by a workflow

• View metadata provided by the source media or generated by a workflow

• View variables generated by a workflow

• Make changes to metadata labels and variables in preparation for submission to a 
target workflow

• Submit media to a target workflow for processing
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Note: Each Workflow Portal license supports one operator at a time. Two operators 
can share a license if they do not need to simultaneously use Workflow Portal. If 
multiple operators need simultaneously use Workflow Portal, you must purchase and 
install an additional license for each operator.

With proper configuration, Workflow Portal allows operators to perform tasks such as:

• Review and approve workflow output prior to production

• Enter and review metadata for controlling multi-channel distribution in a target 
workflow

• Forward media to specific distribution channels or audience targets

• Extraction of sub-clips from media

• Assemble (stitch) multiple assets into a single output file

• Automate tag & bag editing for promo and highlights production

Note: For more information on Workflow Portal, see the Vantage User’s Guide.

Introduction to Workflow Portal Configurations
As a Vantage domain administrator, you can create and configure Workflow Portal 
configurations, which control which Workflow Portal features an operator can use. 
While Workflow Portal operators do have some control over the application display, 
most features are controlled by the Vantage domain administrator using the 
Management Console.

Vantage administrators must create and configure at least one Workflow Portal 
configuration before operators can access binders using Workflow Portal.

When a workflow requires operator involvement, workflow support requires some or all 
of the following tasks:

• Preparation of an ingest workflow, which can analyze source media and produce 
media for evaluation. The ingest workflow is optional for some applications.

• Preparation of at least one Workflow Portal configuration, which enables and sup-
ports the tasks you want operators to do when working with workflows.

• Installation of Workflow Portal to test Workflow Portal configurations.

• Preparation of a target workflow to process the media submitted by operators.

Workflow Portal installation is described in the Vantage Installation Guide, and the rest 
of this chapter describes how to create and configure Workflow Portal configurations 
with the Management Console. The following sections provide additional information 
on ingest and target workflows.
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Ingest Workflow Guidelines
While you can create a single workflow that produces and distributes media, there are 
some significant advantages to dividing the media processing into ingest and target 
workflows. For example, an ingest workflows can automatically analyze source media 
and detect media attributes and characteristics such as frame rate, dimensions, 
letterboxing, and macroblocking. The ingest workflow can do this while an operator is 
performing other tasks, which improves operator efficiency.

Ingest workflows can also produce proxy media that operators can view with Workflow 
Portal to evaluate quality issues and quickly define timecodes for trim points or 
commercial insertion. Using one tool (Workflow Portal) for media evaluation and 
submission also improves operator efficiency.

When you use an ingest workflow, the results of that workflow are stored in the binder, 
along with the paths of the source media and all attachments. When operators view job 
status in Workflow Portal, the jobs are listed as binders, giving the operator access to all 
resources defined in the binder.

As a Vantage domain administrator, you can define catalogs in which to store binders. A 
catalog serves the same purpose as a folder in a file system. After you associate a binder 
with a catalog, you can configure which operators can access the catalog and the 
binders inside.

When you configure ingest workflows, consider the following guidelines:

• To support operator preview of media, use a Flip action and specify the QuickTime 
encoder with H.264 video to create a QuickTime movie that uses the Vantage Proxy 
file nickname. The Vantage Workflow Portal Web application can also display WMV 
movies, but QuickTime movies are preferred.

• To support operator viewing of binders by thumbnail (instead of by name), config-
ure the workflow to create a thumbnail that uses the Vantage Thumbnail file nick-
name.

• If you want the workflow to make media information available to operators, config-
ure Identify and Examine actions to collect that information, and use metadata 
labels to store that information in the binder.

• To make binders available to operators, use a Register action to associate the binder 
with the appropriate catalog.

Note: If you are using the Safari 5 browser, the Silverlight viewer in the Vantage 
Workflow Portal Web application is supported only on Mac OS X. For more information 
on supported browsers, see Vantage Web Applications Browser Requirements.

Target Workflow Guidelines
The target workflow is the workflow that produces and distributes the finished media. 
When your application calls for an ingest workflow, operators evaluate the ingest 
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workflow results, take any action required, and then submit the job to a target 
workflow. 

If your process does not require an ingest workflow, you might still prefer that 
operators submit jobs to a target workflow, rather than just placing media files in a 
watch file for automated processing. The advantage to operator submission is that 
operators can adjust metadata labels and variables during submission, providing more 
control over target workflow processing.

When you configure target workflows, consider the following guidelines:

• If the operator will be submitting a job after processing an ingest workflow, the tar-
get workflow must have a Receive action to receive the ingest workflow binder.

• To support operator control of target workflow processing, the target workflow 
must be configured to accept and process any metadata labels and variables that 
an operator enters.

Managing Workflow Portal Configurations
Here you can create, configure, import, export, delete, and manage configurations for 
use by your operators.

Note: If you are creating a store to hold proxy files viewed in the Vantage Workflow 
Portal, Telestream recommends that you reference the store with a UNC path. Some 
SAN clients do not allow frame-accurate representation of proxies when using shared 
drives.

The following sections describe configuration tasks for Workflow Portal configurations:

 Creating and Editing Workflow Portal Configurations

 Selecting a Configuration Mode for Response to Ingest Workflows

 Selecting the Configuration Mode to Forward Network Files to a Workflow

 Specifying Catalog Access for a Configuration

 Hiding and Displaying the Media List

 Enabling and Disabling Binder Deletions

 Enabling and Disabling Binder Filtering

 Defining the Controls and Display Items in Binder View

 Managing Metadata Label Configuration Options for Operators

 Managing Variable Configuration Options for Operators

 Controlling Operator Workflow Forwarding

 Defining EDL Storage

 Managing User Access to Workflow Portal Configurations

 Deleting a Configuration

 Saving a Configuration
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 Duplicating a Configuration

 Exporting and Importing Configurations

 Refreshing the Configuration List

Creating and Editing Workflow Portal Configurations
To start or access a Workflow Portal configuration, do the following:

1. Start the Vantage Management Console.

2. In the left pane, open the Vantage domain you want to manage to display the 
configuration options for the domain.

If the options are not visible, double-click the domain name to display the options.

3. Select Application Configurations > Workflow Portal. 

As shown in Figure 60, the Workflow Portal pane displays the options for Workflow 
Portal configurations.

Figure 60. The Workflow Portal configuration pane.

4. To create a new configuration, click the Create configuration button  in the tool 
bar and name the new configuration.
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5. To make changes to an existing configuration, select the configuration in the 
Configuration list.

6. If you have created a new configuration, or if you have made changes to an existing 
configuration, click the Save button  to save your changes.

Selecting a Configuration Mode for Response to Ingest 
Workflows

Some projects require operators to evaluate ingest workflows and take actions such as 
the following:

• Forward media to a target workflow for further processing and distribution

• Quarantine media that does not meet specifications

• Edit metadata and then forward to a target workflow

Configurations that support the evaluation of ingest workflows are called catalog-
based configurations. Catalog-based configurations present jobs to operators based on 
the catalog to which the binder is assigned. In a simple configuration, all workflows 
assign binders to the same catalog, and operators can view all binders. Workflows in a 
more complex configuration might assign binders to different catalogs, and each 
operator might be permitted to view only the binders for which he is responsible.

To select a catalog-based configuration mode, do the following:

1. Display the Workflow Portal configuration pane as described in Creating and Editing 
Workflow Portal Configurations.

2. Click the radio button that corresponds to the mode you want to use.

3. Click the Save button  to save your changes.

The following sections describe topics that apply to each of the three catalog-based 
configuration modes:

 Browse Catalogs (Copy Binder) Mode

 Browse Catalogs (Forward Binder) Mode

 Create EDLs from Catalogs (Create Binder) Mode

 Ingest Workflow Considerations

Browse Catalogs (Copy Binder) Mode
This configuration mode enables an operator to browse the selected Vantage catalog 
for binders. They can then select one binder, and submit it to one or more workflows. 
When the submission occurs, the original binder is copied, and the copy is submitted to 
the workflow—the original binder remains in the catalog and remains unchanged.

Note: A binder contains metadata labels, and references to media files and 
attachments. When a binder is copied, the metadata labels are also copied and thus 
may be different than the original. Any media files or attachments that exist in the 
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original binder are not copied, and are referenced by both the original and the new 
copy.

The Browse Catalogs configuration mode is ideal when:

1. You want the original binder to remain in the catalog

2. You do not want to change the original binder's metadata

3. The original media files are not affected by the target workflow, and

4. You want operators to be able to submit the same asset multiple times.

Target Workflow Considerations

The target workflow should include a Receive action. Remember that any media files or 
attachments present in the original binder will also be referenced in the copy. As a 
result, the target workflow should not delete any of those original files; the original 
binder would then have missing files.

Example Workflows
• Operator marks an in point, and an out point for a highlight; multiple highlights can 

be extracted from the same input.

• Operator marks trim points around a promo from a captured satellite feed, and 
marks a branding entry point on the timeline; the target workflow then trims the 
promo and applies graphics for multiple distribution channels.

Browse Catalogs (Forward Binder) Mode
This configuration mode enables an operator to browse the selected Vantage catalog 
for binders. They can select a binder, and either edit its metadata, or submit it to one or 
more workflows. When the submission occurs, the original binder is forwarded to the 
workflow (and optionally removed from the catalog, if configured that way by the 
administrator).

Note: Because the binder is directly affected by the target workflow, if the binder 
remains in the catalog, any changes to the binder will appear in the catalog as the 
workflow runs.

The Browse Catalogs (Forward Binder) configuration mode is ideal when:

• You want to use the catalog as a task list for the operator, automatically removing 
binders from the catalog when they are forwarded

• You want the workflows to update binders that remain in-place in the catalog, or 

• You want operators to edit metadata in-place.

Target Workflow Considerations

The target workflow should include a Receive action. Remember that if the binder is 
not removed from the catalog, any changes made during the target workflow will be 
apparent in the catalog.
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Example Workflows
• Operator reviews an asset, marks it as approved/rejected, and forwards to a work-

flow that responds to that metadata. The asset is removed from the catalog.

• An ingest workflow detects quality issues and places an asset in a catalog for 
review. An operator reviews the asset, using a proxy to review the video at error 
timecodes published by the ingest workflow. If the asset is unacceptable, the oper-
ator forwards to a workflow for quarantine; otherwise the operator forwards to the 
appropriate next step for the asset.

• Operator edits asset metadata in-place in the catalog. When the asset is ready for 
distribution, the operator chooses distribution channels and forwards to the target 
workflow. The target workflow responds to the operator choices and forwards for 
distribution.

• Operator reviews black segments detected by Vantage, and confirms black removal 
points. The target workflow uses those timecode parameters to remove black from 
the original media.

Create EDLs from Catalogs (Create Binder) Mode
This configuration mode changes Workflow Portal operation to include a tab that 
enables an operator to create an EDL (edit decision list). An operator can use the EDL to 
stitch multiple assets in the catalog together or to trim a clip. 

The EDL is stored in a .tsedl file, which can be stored with other media files in a Vantage 
store or folder, or it can be stored in a special Vantage store or folder, designated for 
EDL files. (For more information, see Defining EDL Storage.)

After an operator has created an EDL, the operator can forward that EDL to a target 
workflow to create the output defined by the EDL. To support EDL processing, you must 
modify the configuration to support forwarding to a workflow that contains a Receive 
action. (For more information, see Controlling Operator Workflow Forwarding.)

The following sections provide additional information on supporting EDL creation in 
Workflow Portal:

 Target Workflow Considerations

 Example Workflows

Target Workflow Considerations

The target workflow should include a Receive action. It will receive a .tsedl file with the 
nickname Original and can then transcode—or direct convert—this list into an output 
file (or multiple output files). 

Note: If MPEG-2 is the EDL source format, a Direct Convert mode can be used to avoid 
a full transcode. Any timeline cut that breaks GOP structures is replaced with I-Frame 
material, otherwise original GOPs are preserved. If the output file is not MPEG-2, a full 
transcode can be performed. In either case, the VANC, captions, and audio are 
correctly stitched during the processing of the EDL.
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Example Workflows
• Operator creates a list of syndication segments that are stitched together into a sin-

gle program.

• Operator selects a bumper, a clip, and a trailer, enters metadata, chooses distribu-
tion channels, and submits the package for distribution. The target Vantage work-
flow uses distribution channel choices and metadata to generate the correct 
formats and deploy to the chosen distribution channels.

Ingest Workflow Considerations
In order for assets to appear in a Vantage catalog, they must be registered as part of an 
ingest workflow. A thumbnail should also be added to the binder and given the 
nickname Vantage Thumbnail; a QuickTime H.264 MOV proxy can also be added and 
given the nickname Vantage Proxy.

Note: If you are using the Safari 5 browser, the Silverlight viewer in the Vantage 
Workflow Portal Web application is supported only on Mac OS X. For more information 
on supported browsers, see Vantage Web Applications Browser Requirements.

For Create EDL from Catalogs mode, EDL processing requires Program Stream or 
Transport Stream MPEG-2 video, and such a file should be provided in the binder with 
the nickname Vantage EDL. Vantage provides support for MXF DV, IMX, and XDCAM HD 
video formats as well.

Note: All assets in the EDL list must have the same frame size and frame rate; 
operators are not allowed to combine mixed media.

Selecting the Configuration Mode to Forward Network Files 
to a Workflow

Some projects require operators to browse network locations to locate files to submit 
to workflows. The configuration mode that supports this is called Browse Windows 
Network mode, and this mode allows multiple files to be submitted simultaneously. 
Each submitted file becomes a separate job with its own binder. During submission, the 
operator can add metadata labels (as permitted by the Workflow Portal configuration). 
For a batch submission (of multiple media files), each media file receives a copy of the 
same metadata label in its binder.

The Browse Windows Network (create binder) configuration mode is appropriate when:

• You expect operators to manually search for and submit files, rather than copy 
those files to a hot folder.

• No ingest workflow is required before operator involvement.
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To select the Browse Windows Network configuration mode, do the following:

1. Display the Workflow Portal configuration pane as described in Creating and Editing 
Workflow Portal Configurations.

2. Click the Browse Windows Network (create binder) radio button.

3. Click the Save button  to save your changes.

Media files are submitted directly, so there is no ingest workflow. However, operators 
should ensure that any media files submitted are in locations that are accessible to the 
Vantage services. For example, files on a local drive (for example, 
C:\media\myvideo.mpg) are not accessible to a remote Vantage server.

The target workflow should include a Receive action. Each media file is assigned the 
nickname Original when it is submitted.

Specifying Catalog Access for a Configuration
For catalog-based configurations, Vantage allows you to specify how operators access 
those catalogs and the binders they contain. The following sections describe how to 
control access to the optional Workflow Portal features that operators might use:

 Enabling and Disabling Operator Access to Catalogs

 Hiding and Displaying the Operator Catalog List

Enabling and Disabling Operator Access to Catalogs
The Browse Catalogs configurations and the Create EDL from Catalogs configuration 
support catalog access control. If you enable access to a catalog, all users who can use 
the configuration can access that catalog and view all binders in that catalog. Likewise, 
if you disable access to a catalog, the catalog is hidden from and not accessible to 
configuration users.

To enable or disable operator access to a catalog, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab (see Figure 61).

3. To enable access to a catalog, select the catalog in the Available list and click Add.

4. To disable access to a catalog, select the catalog in the Visible to user list and click 
Remove.

5. Click the Save button  to save your changes.
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Figure 61. Selecting which catalogs to display to the user.

Hiding and Displaying the Operator Catalog List
If your domain uses only one catalog, you can simplify the Workflow Portal operator 
interface by hiding the list of catalogs, which is also called the catalogs browser. If 
operators need access to multiple catalogs using a single Workflow Portal 
configuration, you should display the catalogs browser so that operators can select a 
catalog to work with.

The design and choice of catalogs has an impact on how easily operators can perform 
their tasks. For example:

• In Forward mode, bear in mind that the configuration can be set to automatically 
remove the binder from the catalog when it is forwarded. When using this mode, 
the catalog can serve as a task list for operators to work from.

• In Copy mode, the binders are not removed from the catalog by the operators. As a 
result, you might want to set appropriate expiration times on the catalogs.

• In all cases, you can use folders to structure how operators see assets. For example, 
bumpers assets may be kept in a Bumpers folder, separate from Primary Assets, in a 
Primary Assets folder.

• You might have multiple ingest workflows all providing binders to a target catalog.
Vantage Domain Management Guide



Configuring Workflow Portal Operation
Managing Workflow Portal Configurations

232
To hide or display the catalogs browser, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the catalogs browser, clear the Show Catalogs browser checkbox (see 
Figure 61).

4. To display the catalogs browser, check the Show Catalogs browser checkbox.

5. Click the Save button  to save your changes.

Hiding and Displaying the Media List
The media list displays the media files for a binder/job that you select in the binder list. 
For example, the media list might include the original media submitted to a workflow 
and the output media from that workflow. When the media list is visible, operators can 
play the media or view the contents of the folder that contains the media.

To hide or display the media list, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the media list, clear the Show media nickname list checkbox (see Figure 61).

4. To display the media list, check the Show media nickname list checkbox.

5. Click the Save button  to save your changes.

Enabling and Disabling Binder Deletions
When configuring a Workflow Portal catalog-based configuration, you can enable or 
disable the manual binder deletion capability for operators. For Browse Catalogs 
(forward binder) mode, you also have the option to enable or disable the automatic 
deletion of binders. The following sections provide more information on binder 
deletion:

 Configuring Operator Binder Deletions

 Configuring Automatic Binder Deletions

Configuring Operator Binder Deletions
If you want operators to have the option to delete binders, enable operator binder 
deletion. Operator binder deletion allows operators to remove binders from the binder 
list when a job is complete, which effectively makes the binder list a manual task list. 
After an operator processes a job in the binder list, she can delete the job so that the list 
only shows jobs that need attention.

If you prefer to save binders and do not want operators to delete them, disable 
operator binder deletions. 
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Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action.

To enable or disable operator binder deletions, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder deletions, check the Allow Binder Delete checkbox (see Figure 61).

4. To disable binder deletions, clear the Allow Binder Delete checkbox.

5. Click the Save button  to save your changes.

Configuring Automatic Binder Deletions
In Browse Catalogs (forward binder) mode, you can enable or disable the automatic 
deletion of binders. When automatic binder deletion is enabled, the binder from the 
source workflow is deleted when the operator forwards a job to a target workflow. This 
effectively makes the binder list an automatic task list, automatically removing each 
binder when the operator takes action on that binder.

Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action.

To enable or disable automatic binder deletions, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable automatic binder deletions, check the Auto Delete Binder checkbox (see 
Figure 61).

4. To disable automatic binder deletions, clear the Auto Delete Binder checkbox.

5. Click the Save button  to save your changes.

Enabling and Disabling Binder Filtering
Binder filtering is a Workflow Portal feature that allows operators to limit the binder list 
to binders for which the binder name contains a text phrase. When the binder list is 
long, this feature allows operators to shorten the list. This feature can also hide priority 
jobs when the operator is using a filter.

To enable or disable binder filtering, do the following:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder filtering, check the Allow Binder Filtering checkbox (see Figure 61).

4. To disable binder filtering, clear the Allow Binder Filtering checkbox.

5. Click the Save button  to save your changes.
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Defining the Controls and Display Items in Binder View
Vantage allows you to control what Operators see in the Workflow Portal binder list. 
The standard features that you can display for each binder are:

• Binder name

• Binder creation date

• Binder expiration date

• Play button

• Submit button

You can also display parameters for any of the metadata label parameters that are 
defined in the domain.

Note: Vantage allows you to hide all columns and controls in the binder list, which 
means that no items appear in the binder list. At least one display or control item 
should be configured to display so that binders appear in the binder list.

The following sections describe how to configure what appears in the binder list:

 Defining the Standard Feature Settings

 Adding and Deleting Columns for Metadata Parameters

Defining the Standard Feature Settings
To enable or disable the standard binder display components, do the following:

1. Select the configuration to change.

2. Select the Binder Details View tab shown in Figure 62.

Figure 62. Binder Details View.
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3. Check each feature checkbox to display the information or control, or clear the 
checkbox to hide the feature. The following are standard features:

– Binder name. Displays the name assigned to the binder when it was created.

– Created. Displays the date and time the binder was created.

– Expiration. Displays the date and time the binder expires.

– Play button. Displays a button that the operator can use to play or pause the 
selected job.

– Submit button. Displays a button that the operator can use to submit a job to 
another workflow.

Note: The play button operates only when the workflow has generated and 
registered a proxy file (see Ingest Workflow Guidelines). The Submit button appears 
only when target workflows are selected on the Forward to Workflows tab.

4. Click the Save button  to save your changes.

Adding and Deleting Columns for Metadata Parameters
To add or delete metadata parameter columns for the binder list, do the following:

1. Select the configuration to change.

2. Select the Binder Details View tab (see Figure 62).

3. Click the Column button .

4. Do the following for each metadata label parameter for which you want to display a 
column:

a. Select a metadata label in the Labels pane.
b. In the Parameters pane, check the checkbox for the metadata label parameter 

you want to display.
c. When you are done making changes, click OK.

5. For each metadata label parameter column that you want to remove from the 
binder view, do the following:

a. Select the parameter in the parameter list.
b. Click the Delete button  to delete a parameter from the parameter list, and 

then confirm the delete.

6. To change the displayed order of parameters, select a parameter in the parameter 
list and use the green up  and down arrow  buttons to move the variable in 
the list.

7. Click the Save button  to save your changes.
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Managing Metadata Label Configuration Options for 
Operators

Vantage allows operators to view and set metadata labels when they submit jobs to a 
workflow. These labels can be used by the workflow to customize job processing or to 
add data to media.

Note: Before a metadata label can be made available to an operator, it must be 
defined using the Management Console as described in Creating Metadata Labels.

If you are testing your Workflow Portal configuration, the metadata label display is 
different for the different configuration modes. For the Browse Windows Network 
mode, labels are only visible to operators after they select a media file and target 
workflow and click Submit. For Browse Catalogs (copy binder) mode, labels are only 
visible to operators after they select a binder and target workflow and click Submit. 
For Browse Catalogs (forward binder) mode and Create EDL from Catalogs mode, 
labels are visible to operators as soon as they select a binder.

When an operator views metadata labels in Workflow Portal, the labels that appear in 
the binder are only those labels that are set in the workflow and configured to be 
visible for the Workflow Portal configuration. If the Workflow Portal configuration 
supports it, operators can add and delete labels in the binder for the target workflow. 
The labels that operators can add and delete are limited to those that are defined to be 
visible in the Workflow Portal configuration.

Vantage also allows you to configure hotkeys for use with metadata labels. When you 
configure metadata label parameters with the Management Console, you can 
configure hotkeys for any time code value. The hotkeys function during proxy viewing 
in Workflow Portal. When an operator locates a frame and wants to set a label 
parameter to the time code for the specified frame, the operator simply presses the 
appropriate hotkey and the timecode is recorded in the label parameter.

To configure metadata label usage for operators, do the following:

1. Select the configuration to change.

2. Select the Labels tab (see Figure 63).
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Figure 63. Labels tab.

3. To enable or disable operator viewing of metadata labels, check (enable) or clear 
(disable) the Show Metadata Labels checkbox.

Note: If you disable operator viewing of metadata labels, you also disable operator 
management of metadata labels. Operators cannot manage labels that they cannot 
see.

4. To allow or disallow operators to add and delete metadata labels to binders, check 
(allow) or clear (disallow) the Allow Add checkbox.

Note: The Allow Add checkbox is not provided in Browse Windows Network mode 
because you are viewing files, not binders. You must run a job in a workflow to create a 
binder before you can add labels to the binder.

5. To make a metadata label available to operators, do the following:

a. Select one or more label names in the in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

b. Click Add.
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6. To define hotkeys for label parameters, do the following:

a. Select the metadata label in the Visible to user pane.
b. Click the Hotkeys button.

The Management Console displays the Timecode Mark Hotkeys dialog.

c. For each timecode related parameter, click the button to the right of the 
parameter name and select a key from the dropdown list.

d. To clear all hotkeys, click the Clear button and then click OK to confirm the clear.
e. When all timecode hotkeys are defined, click OK. 

7. To hide metadata labels from operators, do the following:

a. Select one or more labels in the in the Visible to user pane.

You can use the Control and Shift keys to select multiple users as described in the 
previous step.

b. Click Remove.

8. Click the Save button  to save your changes.

Managing Variable Configuration Options for Operators
Vantage allows operators to set variables when they submit jobs to a workflow. These 
variables can be used by the workflow to customize job processing.

Note: Before a variable can be made available to an operator, it must be defined 
using the Management Console as described in Creating Variables.

If you are testing your Workflow Portal configuration, variables are only visible to 
operators after they select a binder and target workflow and click Submit.

To enable or disable operator use of variables, do the following:

1. Select the configuration to change.

2. Select the Variables tab (see Figure 64).
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Figure 64. Variables tab.

3. To make a variable available to operators, do the following:

a. Select one or more variable names in the in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

b. Click Add.

4. To hide variables from operators, do the following:

a. Select one or more labels in the in the Visible to user pane.

You can use the Control and Shift keys to select multiple users as described ear-
lier.

b. Click Remove.

Note: When all variables are hidden from operators, the Variables tab does not show 
in Workflow Portal.

5. To change the displayed order of variables, select a variable in the Visible to user 
pane and use the green up  and down arrow  buttons to move the variable in 
the list.

6. Click the Save button  to save your changes.
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Controlling Operator Workflow Forwarding
With the appropriate permissions, Vantage operators can forward binders to one or 
more target workflows for further processing. As a Vantage administrator, you can 
control the following:

• Whether operators can view the Forward to Workflows tab in Workflow Portal.

• The target workflows to which operators can forward binders.

• Whether operators are required to forward to a target workflow.

When workflow forwarding is enabled in a Workflow Portal configuration, operators 
can forward to any visible target workflow by selecting the workflow on the Forward to 
Workflows tab and clicking Submit. If a target workflow is required, it is automatically 
selected on the Forward to Workflows tab and the binder is forwarded to the required 
workflow when the operator clicks Submit.

To enable or disable binder forwarding to other workflows, configure a Workflow Portal 
configuration as follows:

1. Select the configuration to change.

2. Select the Forward to Workflows tab (see Figure 65).

Figure 65. Forward to Workflows tab.

3. To enable or disable operator viewing of target workflows, check (enable) or clear 
(disable) the Show Forward to Workflows checkbox.

Note: If you disable operator viewing of target workflows, you also disable operator 
forwarding to target workflows. Operators cannot forward binders to workflows that 
they cannot see.
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4. To make target workflows available to operators, do the following:

a. Select one or more workflow names in the in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

b. Click Add.

Note: To accept forwarded binders, the target workflow must contain at least one 
Receive action. The Available pane only displays workflows that contain a Receive 
action.

5. To specify whether a target workflow is required for forwarding or optional, check 
(required) or clear (optional) the Req’d checkbox next to the workflow in the 
Visible to user pane.

6. To hide workflows from operators, do the following:

a. Select one or more users in the in the Visible to user pane.

You can use the Control and Shift keys to select multiple users as described ear-
lier.

b. Click Remove.

7. Click the Save button  to save your changes.

Defining EDL Storage
EDL files can be stored in any Vantage store or folder, or they can be stored in a special 
Vantage store or folder, designated for EDL files. To specify a storage location for EDL 
files, do the following:

1. Select an EDL configuration to change.

2. Select the Storage tab.

3. To store EDL files in any available Vantage store, click the Available Vantage Store 
radio button.

4. To store EDL files in a specific Vantage store or folder, click the Vantage Store/Folder 
radio button, then select a Vantage store or folder in the drop down list adjacent to 
this radio button.

5. Click the Save button  to save your changes.
Vantage Domain Management Guide



Configuring Workflow Portal Operation
Managing Workflow Portal Configurations

242
Managing User Access to Workflow Portal Configurations
When the User Management feature is enabled, you can use the Management Console 
to define which Vantage users can access each Workflow Portal configuration. You can 
enable access for one, some, or all users.

Note: For more information on the user management feature, see User Management.

To define which users can access a Workflow Portal configuration, do the following:

1. Select the configuration to change.

2. Select the Permitted Users tab (see Figure 66).

Figure 66. Permitted Users tab.

3. To grant access to all users, check the Everyone checkbox.

4. To grant access to one or more Vantage users, do the following:

a. If the Everyone checkbox is checked, clear the checkbox.
b. Select one or more users in the in the Available pane.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

c. Click Add.
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5. To remove access for one or more Vantage users, do the following:

a. Select one or more users in the in the Permitted users pane.

You can use the Control and Shift keys to select multiple users as described in the 
previous step.

b. Click Remove.

6. Click the Save button  to save your changes.

Deleting a Configuration
To delete a Workflow Portal configuration, do the following:

1. Select the configuration to delete.

2. Click the Delete button  in the tool bar.

3. Click OK to confirm the delete or click Cancel to abort the delete.

Saving a Configuration
Changes that you make to a Workflow Portal configuration are not applied or saved 
until you save the configuration as follows:

1. Select the configuration to save.

2. Click the Save button  in the tool bar.

Duplicating a Configuration
If you need a new configuration that is similar to an existing configuration, it might be 
easier to duplicate the configuration and modify the duplicate, instead of creating a 
new configuration. When you duplicate a configuration, the console creates a new 
configuration with Copy of prepended to the source configuration name.

To duplicate a Workflow Portal configuration, do the following:

1. Select the configuration to duplicate.

2. Click the Duplicate button  in the tool bar.

Exporting and Importing Configurations
Vantage allows you to export one or all Workflow Portal configurations to XML files, 
which you can then use to import the same configurations into another Vantage 
domain.

To export one or all configurations, do the following:

1. If you are exporting a single configuration, select the configuration to export.

2. Click the Export button  to export a single configuration, or select Export all from 
the Export button drop down menu.
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3. Use the file system dialog to save the exported configurations.

The default file name for each configuration is the configuration name, but you can 
change the file name.

Note: Changing the name of the XML file does not change the name of the 
configuration in the XML file.

To import a configuration, do the following:

1. Click the Import button .

2. Use the file system dialog to locate and select the configuration to import, then 
click Open.

Note: If you try to import a configuration that is already in this Vantage domain, 
Vantage prompts you to overwrite the record (click Yes) or cancel the import (click No).

Refreshing the Configuration List
The configuration list is a static display that is automatically updated when you add or 
delete configurations. However, if other administrators add or delete configurations, 
you must refresh the configuration list to display the changes.

To refresh the configuration list, click the Refresh button  in the tool bar.

Workflow Portal Deployment Tips
As a Vantage domain administrator, you can make it easier for operators to start using 
Workflow Portal by doing the following:

• Install the Workflow Portal program on the operator’s computer.

• Launch Workflow Portal for the first time and pre-select the following:

– Vantage domain

– Workflow Portal configuration

– Binder catalog

Vantage Workflow Portal Tours
This section contains examples of how to set up portals allowing operators to perform 
certain tasks. These tours assume that you are familiar with Vantage; they provide high-
level design guidelines only.
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Workflow Portal Tour: Operators Submit an EDL
This tour describes how to configure the ingest workflow, target workflow, and Portal 
configuration, to allow operators to stitch assets together by specifying an EDL, and 
create an MPEG-2 Transport Stream output file.

Step 1: The Ingest Workflow
This workflow watches a hot folder for incoming media files. 

Figure 67. Typical EDL ingest workflow.

When new files are detected, the workflow will: 

1. Generate a proxy at 29.97 fps, with the nickname Vantage Proxy.

2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.

3. Create a Transport Stream MPEG-2 file to be used for stitching, with the nickname 
Vantage EDL.

4. Register the binder in the catalog named Assets.

Step 2: The Target Workflow
The desired output format is MPEG-2 Transport Stream. Because the EDL inputs are also 
MPEG-2 Transport Stream, the Direct Convert container type is implemented. 
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Figure 68. Typical EDL processing workflow.

Video from the input files is re-wrapped without transcoding, and I-Frames will be 
inserted at any GOP breaks. 

This workflow:

1. Receives the .tsedl file from Workflow Portal with the nickname Original.

2. Uses the .tsedl file to stitch MPEG-2 from the source assets using Direct Convert to 
MPEG-2 Transport Stream

3. Uses the .tsedl file to transcode a Windows Media output.

Step 3: Workflow Portal Configuration
The Workflow Portal configuration is set up as follows:

1. The Create EDL from Catalogs configuration mode is selected

2. The Assets catalog is selected

3. The target workflow is made available to the operator.
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Figure 69. Typical EDL configuration.

Workflow Portal Tour: Extracting Highlights
This tour describes how to configure the label design, ingest workflow, target workflow, 
and Portal configuration, to allow operators to mark in/out points on a master asset for 
highlight extraction, and also choose distribution channels and enter metadata.

Step 1: Label Design
In this workflow, the operator provides the following information:

• What timecodes should be used for the highlight start, end, and keyframe

• A description and title for the highlight

• To which distribution channels the highlight should be sent

The label is designed accordingly, as illustrated here:

Figure 70. Typical extracting highlights label design.
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Step 2: The Ingest Workflow
This workflow watches a hot folder for incoming media files. 

Figure 71. Typical extracting highlights ingest workflow.

When new files are detected, the workflow will: 

1. Generate a QuickTime H.264 MOV proxy at 29.97fps, with the nickname Vantage 
Proxy.

2. Generate a JPEG thumbnail at 5 seconds, with the nickname Vantage Thumbnail.

3. Populate the Highlight label in the binder, with the default values.

4. Register the binder in the catalog named Assets.
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Step 3: The Target Workflow
The target workflow uses the metadata provided by the operator as follows:

Figure 72. Typical extracting highlights target workflow.

1. Receives from the Portal, and expects the Original asset to be available.

2. Uses the Populate action to extract the timecodes and metadata from the label, as 
variables.

3. Trims the original to a short, mezzanine format that can be used for multi-channel 
transcoding, using the Start/End timecodes specified by the operator.

4. Creates a JPEG keyframe at the time specified by the operator.

5. Uses the Populate action to extract the true/false values specified by the operator 
checkboxes for distribution channels.

6. Uses those true/false values to determine whether each branch of the workflow 
should execute.

7. Encodes the appropriate output formats, embedding the metadata information 
provided by the operator into the output files, and deploying to the target.

Step 4: The Portal Configuration
The Portal configuration is set up as follows:

1. The Browse Assets (Copy Binder) configuration mode is chosen.

2. The Assets catalog is selected.

3. The Highlights metadata label is made available to the operator.
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Figure 73. Typical extracting highlights portal configuration.

4. The target workflow is made available to the operator.
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Monitoring the
Domain with Vantage

Dashboard
Vantage Dashboard is a Web application that you can use to monitor and manage your 
domain from any computer, anywhere on your network, as long as that computer has a 
compatible browser. 

Note: Vantage Dashboard is only available with the Vantage Master Control license, 
and Vantage Dashboard access requires that you enable the user management feature 
(see User Management).

The following topics describe how to use the Vantage Dashboard:

 Overview

 Managing Vantage Dashboard Sessions

 Monitoring a Domain

 Managing Servers

 Managing Services

 Managing Jobs

Note: For instructions on how to install the Vantage Dashboard on your IIS server, see 
Installing and Upgrading Vantage Web Applications.

Overview
Vantage Dashboard is designed to help domain administrators manage the entire 
Vantage domain, as opposed to other tools which allow management of domain 
components, such as jobs.

The Vantage Dashboard pages are designed to help you quickly assess the health of the 
domain and progressively dig into deeper detail as needed. For example, the Summary 
Status page allows you to quickly see the workflow completion success rate and the 
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error rate on domain servers. The information on the Summary Status page can help 
you determine if it is more appropriate to troubleshoot a problem or evaluate system 
performance.

Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

Managing Vantage Dashboard Sessions
When you start Vantage Dashboard in a Web browser, you establish a session with the 
Vantage domain. The following topics describe how to manage a Vantage Dashboard 
session:

 Vantage Web Applications Browser Requirements

 Starting the Vantage Dashboard

 Understanding the Vantage Dashboard Display

 Hiding and Displaying the Header Pane

 Managing the Menu Pane

 Sorting Lists in the Status Pane

 Logging Out

 Changing Your Vantage User Password

 Changing Vantage Domains

 Displaying Product Version Information

 Displaying Online Help

 Returning to the Welcome Page

Vantage Web Applications Browser Requirements
Telestream recommends the following Web Browsers for use with the Vantage 
Dashboard: 

• Internet Explorer 9 64-bit (Windows only)

• Internet Explorer 9 32-bit (Windows only)

• Current version of Chrome (Mac OS X & Windows)

• Current version of Firefox (Mac OS X & Windows)

• Safari 5 (Mac OS X only)

Note: To use Vantage Dashboard with Internet Explorer 9, you must configure 
Internet Explorer as described below.
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To configure Internet Explorer for use with Vantage Dashboard, do the following:

• Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click the Active 
scripting Enable radio button, click OK, and click OK.

• Disable Compatibility View in Internet Explorer at the following locations:

– Tools > Compatibility View

– Tools > Compatibility View Settings > Display intranet sites in Compatibility View

– Tools > Compatibility View Settings > Display all Web sites in Compatibility View

• If you are using Internet Explorer on a Windows Server operating system, disable 
Enhanced Security Configuration (ESC) using the Windows Server Manager (Server 
Manager > Security Information > Configure Internet Explorer ESC).

Starting the Vantage Dashboard
To start the Vantage Dashboard, open your web browser and navigate to the location 
of the Vantage Dashboard on an IIS server. There are 2 URLs that you can use to access 
the Vantage Dashboard:

• http://<ServerName>/Vantage

• http://<ServerName>/Vantage/Dashboard

The first URL displays links for all Vantage Web applications (including the Vantage 
Dashboard), and the second URL directly starts the Vantage Dashboard. Replace 
<ServerName> with the name of the Vantage Dashboard host server (or its IP address). 
If you don’t know the URL of the Vantage Dashboard, obtain it from your Vantage 
administrator or IT department.

The following sections describe how to connect to the Vantage domain after you enter 
the URL:

 Connecting for the First Time

 Reconnecting to Vantage Dashboard
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Connecting for the First Time
The first time you connect to the Vantage Dashboard, you are asked to select a domain 
to which the Vantage Dashboard should attach (see Figure 74). Select the domain and 
click OK.

Figure 74. Selecting a Vantage Domain

If the Vantage domain database does not have a default password, click Advanced and 
enter Connection Settings (see Figure 75).

Figure 75. Connection Settings
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Vantage Dashboard logs onto the selected domain, and prompts you for your Vantage 
user login information. When the login dialog box displays (see Figure 76), enter the 
User Name and Password assigned by your Vantage Administrator, then click Log In.

Figure 76. Vantage Dashboard Log In

The default user name and password, which remain the same until changed, are:

• User Name: Administrator

• Password: <none> (no characters entered)

Note: All user passwords are encrypted in the Vantage domain database. All users 
have the option of changing their password (see Changing Your Vantage User 
Password).

Check Remember me next time to store the authentication token in a persistent cookie 
in the browser. This keeps you authenticated if you close your browser and reopen it 
again.

Reconnecting to Vantage Dashboard
After you connect to the Vantage Dashboard for the first time, the Vantage Dashboard 
remembers the domain to which you connected and displays the Dashboard Login 
prompt (see Figure 76). Enter the User Name and Password assigned by your Vantage 
Administrator, then click Log In.

User Name

Password

Log In 
button
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Understanding the Vantage Dashboard Display
Upon successful login, Vantage Dashboard displays the welcome screen shown in 
Figure 77.

Figure 77. Welcome Window and Dashboard Header Controls

Vantage Dashboard displays information and controls in three panes: header, menu, 
and status. The header pane displays controls for session management, and the left 
menu pane displays menu selections, which are described in the Welcome page in the 
status pane when Vantage Dashboard starts. The status pane displays information 
about your domain, based on the selection you make in the menu pane.

Hiding and Displaying the Header Pane
To hide or display the header pane, click the display/hide button shown in Figure 77.

Menu
Pane

Status
Pane

HeaderDisplay/Hide 
Header Button

Display/Hide 
Menu Button

Collapse/
Expand Button
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Managing the Menu Pane
You can collapse or expand the items in the menu pane, and you can hide or display the 
menu pane.

You can collapse menus by clicking the up arrow to the right of the menu name 
(Figure 77), and you can expand menus by clicking the down arrow, which displays for 
collapsed menus.

To hide or display the menu pane, click the display/hide button shown in Figure 77.

Sorting Lists in the Status Pane
Most pages that appear in the status pane contain lists, which can be sorted based on 
the content of any of the columns. To do this, click on any column heading. The first 
click sorts the list rows in ascending order of the information in the selected column. 
The second click sorts them in descending order. A third click removes sorting and 
displays the default sort order.

Logging Out
When you are logged in to the Vantage Dashboard, anyone with access to your 
computer has access to the Vantage Dashboard reports and controls. To prevent 
unauthorized access to Vantage Dashboard when your computer is unattended, log 
out by clicking Logout in the Vantage Dashboard header.

After log out, the log in window displays again (See Figure 76).

Changing Your Vantage User Password
To change your Vantage password, do the following:

1. Click Change Password in the Vantage Dashboard header.

Vantage Dashboard displays the dialog to change your password (Figure 78).

Figure 78. Change Password

2. Enter your current password in the Password field. 
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3. Enter your new password in the New Password field, and confirm it by re-entering it 
in the Confirm Password field. 

4. Click Save when finished. 

Changing Vantage Domains
Vantage Dashboard can monitor just one domain at a time. To change the domain you 
are monitoring, do the following:

1. Click Change Domain in the Vantage Dashboard header.

2. If you are logged into Vantage Dashboard, you are prompted to log out. Click OK to 
log out.

3. Select a domain name in the domain list that displays (Figure 74), and click OK.

4. When the Vantage Login dialog appears, enter a user name and password, and click 
Log In.

Displaying Product Version Information
To display the Vantage Dashboard version number, click Help > About in the menu 
pane. Vantage Dashboard displays the version information as shown in Figure 79.

Figure 79. About Dialog Box

Displaying Online Help
Vantage Dashboard provides help (the user's guide you are reading) in two different 
formats: PDF format and HTML.

To display this user guide in PDF format, click Help > User Guide in the menu pane.

To display this user guide in HTML format, click Help > Web Help in the menu pane.

Version 
Information
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This HTML online help system consists of two panels:

• The left panel displays the following tabs: 

– Contents tab—This tab displays a hierarchically organized set of chapters and 
pages. This list provides a wide range of overview and how-to topics that explain 
how to add, configure, and manage Vantage components.

– Index tab—This tab provides a list of keywords you can click to display its 
associated page.

– Search tab—Looks for specific words or phrases, resulting in a display of topics 
that match your search criteria. 

– Favorites tab—lists favorite topic that have been saved by adding them to the 
list. Topics are added by clicking the Add button.

• The right panel displays the page you have selected from one of the tabs on the 
left.

Returning to the Welcome Page
Click Help > Welcome Page in the menu pane to display the welcome page that is 
presented when the Vantage Dashboard is first started up. This page displays 
descriptions of all the menu items for the Vantage Dashboard.

Monitoring a Domain
The following topics provide information on monitoring a domain:

 Displaying Domain Status

 Displaying Domain License Status

 Displaying Vantage Release and Patch Status
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Displaying Domain Status
The Summary Status page shown in Figure 80 provides a high-level status of the 
Vantage domain to which you have connected. To display the Summary Status page, 
select Monitoring > Summary Status in the menu pane.

Figure 80. Domain Summary Status

The pie chart displays the status of workflow operation in the domain. You can hover 
the cursor over the pie chart segments to display exact percentages for completed 
failed, and stopped workflows. This chart automatically updates over time.

If the pie chart shows that all jobs are completing, you might want to use other Vantage 
Dashboard pages to determine the domain performance level. If the pie chart indicates 
that there are failed jobs, you might want to use a time filter to define the period for 
which you want summary status. For example, if you recently fixed a problem in the 
domain, you might want to use a time filter to limit the display to workflow operation 
since the fix was applied.
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Note: The upper and lower panels in the Summary Status pane are separate reports 
for different views of the Vantage domain. In Figure 80, the pie chart displays statistics 
from Job Status, and the bar graph displays statistics based on service metrics. Be 
aware that certain events can change the reports to appear inconsistent. For example, 
once all failed jobs have expired or been deleted, the pie chart might show 100% 
success, while the bar graph still reports errors. Likewise, if a service is brought in and 
out of maintenance mode, which resets service statistics, the pie chart can show a 
larger percentage of errors than indicated by the bar graph.

To specify a time filter, do the following:

1. Click the Time Filter button above the pie chart.

Vantage Dashboard displays the dialog shown in Figure 81.

Figure 81. Time Filter Dialog Box

2. Type a date and time in each text box, or use the calendar and clock tools in the 
window to select the date and time.

3. Click Apply to close the filter dialog and display the pie chart for the filter period.

Displaying Domain License Status
To display the domain license status, select Administration > License Status in the 
menu pane. Vantage displays the status as shown in Figure 82.

Start Date/Time

End Date/Time

Calendar button

Clock button
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Figure 82. License Status

To update the License Status page, click Refresh. Table 21 describes the information on 
this page.

Note: To view which features are supported by a license, use the Vantage 
Management Console as described in Viewing Vantage Licenses.

Displaying Vantage Release and Patch Status
The Release and Patch Status page shows information about the software plug-in 
modules used by each Vantage service. If you are troubleshooting a problem with 
Telestream Technical Support, you might be asked to use this page to collect 
information about your domain software.

To display the Vantage release and patch status, select Administration > Vantage 
Release & Patch Status. Vantage displays the page shown in Figure 83.

Table 21. License Status Column Descriptions

Column Description

Name The name of the license.

Activated The state of license activation (true or false).

In Use The state of license utilization (true or false).

Expired The state of license expiration (true or false).

Maintenance Expires Date and time that the maintenance expires.

Refresh
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Figure 83. Release and Patch Status

The default page shows the plug-in modules for the Monitor service. To show the 
modules for a different service, select a service from the View By Service dropdown list. 
To refresh the list, click Refresh. Table 22 describes the information on this page.

Managing Servers
The following topics describe how you can use Vantage Dashboard to monitor servers 
in your domain:

 Displaying Vantage Server Status

 Enabling and Disabling Vantage Server Maintenance Mode

 Managing Agility Servers

Table 22. Vantage Release and Patch Status Information

Column Description

Name The name of the plug-in.

Created The date and time the plug-in was installed.

Version The plug-in version.

Refresh

View By Service
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Displaying Vantage Server Status
Vantage Dashboard provides two pages for viewing server status:

• The Summary Status page, which displays server health information, as well as 
domain status.

• The Array Statistics page, which displays status and statistics for all servers in an 
array, as well as service statistics.

The following topics describe the server status information available:

 Vantage Server Health

 Array Statistics

Vantage Server Health
The Vantage Server Health panel (Figure 84) on the Summary Status page displays the 
percentage of errors for each Vantage server in your domain. To display this panel, 
select Monitoring > Summary Status.

Figure 84. Vantage Server Health

The bar chart displays the error rate for all servers in the domain. You can hover over a 
bar in the bar chart to display an exact percentage, and you can use the Chart Type 
dropdown list to display the services that experienced the errors.
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Array Statistics
The Array Statistics panel (Figure 85) on the Array Statistics page displays the 
percentage of errors for each Vantage server in your domain, as well as the current 
input queue length and CPU utilization level. To display this panel, select Health > Array 
Statistics.

Figure 85. Array Statistics

The upper panel on the Array Statistics page displays server statistics. If you select a 
Vantage server in the upper panel, Vantage Dashboard displays service statistics in the 
lower panel.

Enabling and Disabling Vantage Server Maintenance Mode
Vantage server maintenance mode places all Vantage services on the selected server in 
maintenance mode. Place a server in maintenance mode when you want to reconfigure 
services, delete a license, or make other changes that require Vantage services to be 
offline.
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Note: Server maintenance puts all services in maintenance mode. If you want to shut 
down individual services, see Entering and Exiting Service Maintenance Mode.

Note: Placing all services in maintenance mode erases the metrics for all services, and 
this affects the bar graphs for those services.

To enable or disable server maintenance mode, do the following:

1. Select Health > Array Statistics.

2. Select a server in the upper panel.

3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

Managing Agility Servers
Vantage Dashboard provides a limited control set for monitoring and managing Agility 
servers. To display the page for managing Agility servers (Figure 86), do the following:

1. Use the Vantage Management Console to select an Agility server as described in 
Configuring an Agility ECS Server.

2. Select Health > 3rd Party Devices.

Figure 86. Managing Agility Servers

To update Agility server status, click Refresh. 

Options Refresh
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To reset the Agility server statistics counters for a single worker, select an Agility server, 
click Options, and select Reset Counter, or right-click an Agility server and select Reset 
Counter.

To reset the Agility server statistics counters for all servers, click Options, and select 
Reset All Counters, or right-click an Agility server and select Reset All Counters.

Managing Services
The following sections describe how you can use Vantage Dashboard to manage 
services:

 Displaying Service Information

 Entering and Exiting Service Maintenance Mode

 Resetting Service Statistics

Displaying Service Information
Vantage Dashboard provides three pages for viewing service status:

• The Service Statistics page, which displays statistics for all services in a domain and 
also displays individual service statistics for a selected server.

• The Array Statistics page, which displays statistics for all services on a single server.

• The Summary Status page, which displays a pie chart of queued and running 
actions for individual services, as well as a bar chart of services with errors.

Queued actions are actions that are waiting to be processed. Each Vantage service can 
be configured to support a maximum number of actions (see Using the Services Details 
Panel). If multiple servers support a service, actions for that service are distributed 
between servers using the load balancing feature (see Managing Load Balancing). 
When workflow demand exceeds the configured limits for a service, service actions are 
queued until the demand for that service drops below the configured limits.

The following topics describe the service status information available:

 Service Statistics

 Array Statistics

 Summary Status
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Service Statistics
The Service Statistics page (Figure 87) displays two panels. The upper panel displays 
cumulative statistics for all services in the domain, and after you select a service in the 
upper panel, the lower panel displays statistics for that service for all servers in the 
domain.

To display the Service Statistics page, select Health > Service Statistics.

Figure 87. Service Statistics

Table 23 describes the columns in Cumulative Statistics and Individual Statistics lists.
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Table 23. Column Descriptions for Service Statistics Page

Column Description

Avg. Queue Displays the average number of actions in the service 
action queue. Queued actions are actions that are waiting 
to be processed. 

Cur. Queue Displays the current number of actions in the service 
action queue.

Load/Target Load Displays load balancing status.

For session-based load balancing, this displays the 
current number of sessions for this service (Load) and the 
configured session limit for this service.

For cost-based load balancing, this displays the current 
cost of all active sessions for this service (Load) and the 
target cost (Target Load) configured for this service.

For more information on load balancing, see Managing 
Load Balancing. 

Machine Lists the servers in the domain that support the selected 
service.

Passed/Failed Displays the number of actions that have successfully 
completed (passed) and failed.

Service Displays the name of a service that is supported in the 
domain.

Sessions Displays the current number of active sessions.

State Displays the current state of each service, which is either 
Online or Not all Online. When a service is in maintenance 
mode, this column displays Not all Online for that service. 
Note that a service can be in maintenance mode on one 
server and online on other servers.
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Array Statistics
The Array Statistics page (Figure 88) displays two panels. The upper panel displays 
statistics for all servers in the domain, and after you select a server in the upper panel, 
the lower panel displays statistics for all the services on the selected server.

To display the Array Statistics page, select Health > Array Statistics.

Figure 88. Array Statistics

Table 24 describes the columns in Array Statistics and Service Statistics lists.

Table 24. Column Descriptions for Array Statistics Page

Column Description

% of Failures Displays the error rate for each server in the domain.

Avg. Queue Displays the average number of actions in the service 
action queue.

CPU Utilization Displays the percentage of CPU resources that are 
currently being used by Vantage services on a server.
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Cur. Queue Displays the current number of actions in the service 
action queue.

Input Queue Length Displays the number of queued actions for all services on 
a Vantage server.

Load/Target Load Displays load balancing status.

For session-based load balancing, this displays the 
current number of sessions for this service (Load) and the 
configured session limit for this service.

For cost-based load balancing, this displays the current 
cost of all active sessions for this service (Load) and the 
target cost (Target Load) configured for this service.

For more information on load balancing, see Managing 
Load Balancing. 

Server Lists the servers in the domain that support the selected 
service.

Passed/Failed Displays the number of actions that have successfully 
completed (passed) and failed.

Service Displays the name of a service that is supported in the 
domain.

Sessions Displays the current number of active sessions.

State Displays the current state of each service, which is either 
Online or Maintenance.

Table 24. Column Descriptions for Array Statistics Page (Continued)

Column Description
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Summary Status
The Summary Statistics page (Figure 89) displays two panels. When an appropriate 
chart type is selected, the upper panel displays a pie chart that shows the relationship 
between queued and running actions for one or all services. When an appropriate chart 
type is selected in the lower panel, this panel displays a bar chart showing the error rate 
for services with errors.

Figure 89. Summary Status

The following topics describe how to display service status using the Summary Status 
page:

 Displaying Action Allocation Across Services

 Displaying the Queue and Run Status for a Service

 Displaying the Error Rate for all Services
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Displaying Action Allocation Across Services

When the Action Allocation chart type is selected, the Summary Status page shows a 
pie chart that shows the relative use of all active services (see Figure 89). You can hover 
the cursor over any chart segment to see the numerical value for that segment.

To display the Action Allocation chart, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 80.

2. Click Chart Type in the upper pane and select Action Allocation.

Displaying the Queue and Run Status for a Service

The upper pane of the Summary Status page supports pie chart views for Vantage 
services. When you select a chart type for a specific service, the Summary Status page 
displays a pie chart that shows the percentage of running and queued actions for a 
service (see Figure 90). You can hover the cursor over any chart segment to see the 
numerical value for that segment. If no chart appears, there are no active or queued 
actions for that service.

Figure 90. Monitor Service Chart

To display a chart for any service, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 80.

2. Click Chart Type in the upper pane and select a service from the list.
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Displaying the Error Rate for all Services

The Vantage Service Health chart (Figure 90) displays the percentage of errors for any 
domain services that have errors. This display is refreshed when services are restarted.

Figure 91. Service Health

To display the Services Health chart, do the following:

1. Select Monitoring > Summary Status.

Vantage Dashboard displays the default Summary Statistics page shown in 
Figure 80.

2. Click Chart Type in the lower pane and select Service Health.

Entering and Exiting Service Maintenance Mode
You might want to enter maintenance mode for an individual service to make a 
configuration change to that service, or to stop using that service on a domain server. 
After you complete a configuration change, you will need to exit maintenance mode to 
return the service to operation.

Note: Some configuration changes require that you move all Vantage services in and 
out of maintenance mode. For instructions on how to do this, see Enabling and 
Disabling Vantage Server Maintenance Mode.

Note: Placing a service in maintenance mode erases the metrics for that service, and 
this affects the bar graphs for that service.

You can control maintenance mode for a service on the Service Statistics and Array 
Statistics pages.
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To enter or exit a service using the Service Statistics page, do the following:

1. Select Health > Service Statistics.

2. Select the service to manage in the upper panel.

3. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

To enter or exit a service using the Array Statistics page, do the following:

1. Select Health > Array Statistics.

2. Select a server to manage in the upper panel.

3. Select a service to manage in the lower panel.

4. Click Options and select either Enter Maintenance Mode or Exit Maintenance Mode.

Resetting Service Statistics
You might want to reset service statistics after making a configuration change to your 
Vantage Domain. When you reset statistics, all cumulative values are reset to zero, 
which allows you to establish a new baseline for the domain.

You can reset statistics on the Array Statistics and Service Statistics pages.

To reset statistics for one or all services using the Array Statistics page, do the following:

1. Select Health > Array Statistics.

2. Select a server to manage in the upper panel.

3. If you want to reset statistics for a single service, select the service to manage in the 
lower panel.

4. Click Options in the lower panel and select either of the following:

– Clear (Reset) Selected Service Metrics History—Clears only the metrics history of 
the service selected.

– Clear (Reset) All Service Metrics History—Clears the metrics history of all the 
services. 

To reset statistics for one or all services using the Service Statistics page, do the 
following:

1. Select Health > Service Statistics.

2. Select a service to manage in the upper panel.

3. Select a server to manage in the lower panel.

4. If you want to reset statistics for a single service, select the service to manage in the 
lower panel.

5. Click Options in the lower panel and select either of the following:

– Clear (Reset) Selected Service Metrics History—Clears only the metrics history of 
the service selected.

– Clear (Reset) All Service Metrics History—Clears the metrics history of all the 
services. 
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Managing Jobs
The Domain Job Status page (Figure 92) in Vantage Dashboard allows you to manage 
jobs throughout the domain.

Figure 92. Domain Job Status

The Domain Job Status page provides a real time view of Vantage workflow jobs, and it 
provides controls that you can use to manage job processing. The Domain Job Status 
page displays two lists: the Job Status list and the Actions list.

The Job Status list presents workflow jobs, the state of each job (complete, failed, 
stopped), and timestamps for job events. Whenever a job is selected, the actions 
associated with that job are listed in the Actions list at the bottom of the window. The 
Actions list presents status information for each action and controls for managing the 
actions.

Job Status list Actions list
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The following topics describe how to manage the jobs and actions listed on the 
Domain Job Status page:

 Paging Through the Job List

 Filtering Jobs or Actions

 Highlighting Failed and Stopped Jobs or Actions

 Stopping Jobs

 Restarting Jobs

 Deleting Jobs

 Displaying Action Error Details

 Changing Action Priority

 Restarting Actions

Paging Through the Job List
You can navigate to any page by clicking the page number or by clicking the forward 
(right arrow) and previous (left arrow) buttons (see Figure 93). The arrow buttons with 
the vertical bars navigate to the first and last pages.

You can also enter the number of jobs to be listed on each page using the page size 
control shown in Figure 93.

Page adjustments are useful when adjusting performance with large amounts of data. 
A smaller page size results in less data sent to the browser, but also displays a smaller 
amount of all the available data.
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Figure 93. Job Status List Controls

Filtering Jobs or Actions
The filter feature allows you to selectively limit the row entries in the Job Status list or 
the Actions list based on the contents displayed in one or more columns. After you 
apply each filter, the list displays only those rows in which the column entries conform 
to the filter settings. To remove filters and display more entries, you must change the 
filter settings to display all items.

To display the filters for the Job Status list or the Actions list, click Show Filters (see 
Figure 93 or Figure 94). Click Show Filters again to hide the filters.

Options
Highlight State Rows

Show Filters

Page control

Page size
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Figure 94. Actions Panel

The filter settings fall into three groups, which are listed in Table 25 and described in 
the following sections:

 Setting Text Filters

 Setting State Filters

 Setting Period Filters

Table 25. Filter Types and Descriptions

Filter Type Description

Action Text The name of a workflow action.

Category Text The category to which the workflow is assigned.

Created Period The date and time that an action was created for job 
processing.

Expires Period The date and time that a job expires.

Job Text The name of a job, which is usually the ingress filename.

Machine Text The name of the domain server that is processing the 
action.

Progress Text The completion percentage for the action.

Resource Cost Text The resource cost assigned to the action.

Started Period The date and time that a job is started.

Options
Highlight State Rows

Show Error Details

Show Filters
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Setting Text Filters

Text filters allow you to enter text and define a method that defines how the text is 
applied. For example, you can specify “.wmv” in a Job filter and then select a method to 
display only rows with that extension or to exclude all jobs with that extension. 
Table 26 lists the methods you can use to control text filters.

To set a text filter, display the filters, type text in the text box above the column you 
want, click the funnel button to the right of the text box, and select the method for the 
text filter (Figure 95).

Note: When you apply a text filter, be sure to enter a value that actually appears in 
that column. If the filter text does not match any values in the column, the filter might 
not exclude any rows, or it might exclude all rows, depending on the method selected.

State State The current state of the job or action.

Updated Period The date and time of the last status update for the job or 
action.

Workflow Text The workflow that is processing a job.

Table 26. Filter Methods for Text Filters

Method Description

Contains Displays only rows in which the column entry contains 
the specified text.

DoesNotContain Displays only rows in which the column entry does not 
contain the specified text.

EqualTo Displays only rows in which the column entry exactly 
matches the specified text.

NoFilter Removes any existing filter entry for this column.

NotEqualTo Displays only rows in which the column entry does not 
match the specified text.

Table 25. Filter Types and Descriptions (Continued)

Filter Type Description
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Figure 95. Filter Methods

Setting State Filters

State filters limit the list items to those rows that display a state that is selected in the 
state list. The default filter selects rows in all states, and displays as All States. If you set 
the filter to display a subset of all states, the filter displays Custom.

To set a state filter, display the filters, click the down arrow in the State filter column for 
the appropriate list, and check or clear the checkboxes for each state (Figure 96).

Figure 96. States Filter Options

Setting Period Filters

Period filters define start and end times for a period of time for which you want to 
display rows. When a period filter is applied to a column, Vantage Dashboard only 
displays rows for which the selected column value falls within the defined period.

To specify a period filter, do the following:

1. Display the filters.

2. Select the period filter you want to set.

Vantage Dashboard displays the dialog shown in Figure 97.

Enter a filter criteria string

Select a filter method
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Figure 97. Period Filter Dialog

3. Type a date and time in each text box, or use the calendar and clock tools in the 
window to select the date and time.

4. Click Apply to set the filter, or click Clear to remove the filter.

Highlighting Failed and Stopped Jobs or Actions
Vantage Dashboard provides an option to highlight failed and stopped job or action 
rows using the color representing its state (red for failed and magenta for stopped). 
Highlighting can make these jobs more visible in a long list of jobs.

To change the highlighting for the Job Status list or the Actions list, click Highlight State 
Rows above the appropriate list. Each time you click this control, the highlighting 
toggles on or off, to the opposite of the previous state.

Stopping Jobs
To stop a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Stop, or right-click on the job and select Stop.

Restarting Jobs
To restart a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Restart, or right-click on the job and select Restart.

Deleting Jobs
To delete a job, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. Click Options and select Delete, or right-click on the job and select Delete.

Start Date/Time

End Date/Time

Calendar button

Clock button
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Displaying Action Error Details
To display error details for an action listed in the Actions list, select a failed action and 
click Show Error Details. 

Changing Action Priority
Vantage evaluates action priority when multiple actions of the same type are ready for 
processing. Vantage processes actions with the highest numerical priority value first, 
and in some cases, Vantage pauses lower priority jobs, processes higher priority jobs, 
and then finishes processing of the lower priority jobs.

You can change action priority to change the processing order of queued actions. To 
change the priority of an action, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. In the Actions list, select an action.

4. Select Options > Change Priority, or right-click the action and select Change 
Priority.

5. Specify a new priority value and click OK.

Restarting Actions
To restart an action, do the following:

1. Select Monitoring > Domain Job Status.

2. In the Job Status list, select a job.

3. In the Actions list, select an action.

4. Click Options and select Restart, or right-click on the action and select Restart.
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Removing Vantage
Software
The following topics describe how to remove some or all of the Vantage software:

 Uninstalling Vantage from a Server

 Uninstalling Vantage from a Workstation

 Removing Individual Vantage Software Components

Uninstalling Vantage from a Server
Each Vantage server may host some or all of the software components that are 
removed in the following procedure. If a procedure step removes a software 
component that is not installed, skip that step.

To completely uninstall Vantage, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs > Programs and Features.

3. Select Vantage Workflow Portal and click Remove or Uninstall.

4. Select Vantage Web Applications and click Remove or Uninstall.

5. To uninstall any Vantage update packs that are installed, select each Vantage 
update pack in reverse sequential order, and click Remove or Uninstall. Perform this 
step for all installed update packs.

6. To uninstall the Telestream Media Transcode and Analysis engine, follow these 
steps:

a. Select Start > Administrative Tools > Services to display the Services window.
b. Right-click and select Stop for the following services: Vantage Analysis service 

and the Vantage Transcode service.
c. In the Control Panel tool to remove programs (see Step 2), select Telestream 

Media Transcoding & Analysis and click Remove or Uninstall.

7. In the Control Panel tool to remove programs (see Step 2), select Vantage and click 
Remove or Uninstall.
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Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created is 
not removed.

8. In the Control Panel tool to remove programs (see Step 2), select Vantage Domain 
Database and click Remove or Uninstall.

Note: If your domain has a mirrored database server, be sure to disable mirroring, and 
stop the SQL Server Agent service before proceeding.

9. If Microsoft SQL Server 2008 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2008 and click Remove or Uninstall.
b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.
j. Optional step—Click the refresh button in the Control Panel to update the 

display, which will clear some of the SQL Server components from the display.

10. If Microsoft SQL Server 2005 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2005 and click Remove or Uninstall.
b. In the Component Selection dialog, check Remove SQL Server 2005 instance 

components, select VANTAGE: Database Engine, check Workstation Components, 
and click Next.

c. Click Finish.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLEXPRESS and VANTAGE for example), 
remove them both.

11. In the Control Panel tool to remove programs (see Step 2), select Microsoft SQL 
Server Native Client and click Remove or Uninstall.

Note: Uninstalling the database does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. This allows you to re-attach a Vantage domain 
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database and return Vantage to a previous state when re-installing Vantage or 
upgrading Vantage.

12. To permanently delete all Vantage files, use Windows Explorer to delete the 
following directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage

For more information on removing Vantage files, see Removing Vantage Domain 
Database Files.

CAUTION: Deleting these files permanently destroys the Vantage domain 
configuration, workflows, and history. Make a backup of these files first if you want to 
preserve this domain.

Uninstalling Vantage from a Workstation
Each Vantage workstation may host some or all of the software components that are 
removed in the following procedure. If a procedure step removes a software 
component that is not installed, skip that step.

To completely uninstall Vantage, follow these steps:

1. Open the control panel tool to remove programs in your operating system:

– Windows XP: Control Panel > Add/Remove Programs.

– Windows 7: Control Panel > Programs and Features > Uninstall Programs.

2. Select Vantage Client and click Remove or Uninstall.

3. Select Vantage Workflow Portal and click Remove or Uninstall.

Removing Individual Vantage Software 
Components

The following sections describe how to uninstall individual Vantage software 
components:

 Uninstalling Vantage Web Applications

 Uninstalling Workflow Portal

 Uninstalling Update Packs

 Uninstalling the Telestream Media Transcode and Analysis Engine

 Uninstalling Vantage Services and Clients from a Server

 Uninstalling Vantage Clients from Workstations

 Uninstalling the Vantage Domain Database

 Removing Vantage Domain Database Files
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Uninstalling Vantage Web Applications
To uninstall the Web applications from an IIS server, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Web Applications and click Remove or Uninstall.

Uninstalling Workflow Portal

Note: Perform these steps on all servers and workstations where Workflow Portal is 
installed.

To uninstall the Vantage Workflow Portal, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Workflow Portal and click Remove or Uninstall.

Uninstalling Update Packs
To uninstall any Vantage update packs that are installed, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select each Vantage update pack in reverse sequential order and click Remove or 
Uninstall. Perform this step for all installed update packs.

4. When the update packs have been removed, close the window.
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Uninstalling the Telestream Media Transcode and Analysis 
Engine

To uninstall the Telestream Media Transcode and Analysis engine from a computer, or 
from each computer in a distributed Vantage domain where the Telestream Media 
Transcode and Analysis engine was installed, follow these steps:

1. Log on to the server with a local administrator account.

2. Select Start > Administrative Tools > Services to display the Services window.

3. Right-click and select Stop for the following services: Vantage Analysis service and 
the Vantage Transcode service.

4. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

5. Select Telestream Media Transcoding & Analysis and click Remove or Uninstall.

Uninstalling Vantage Services and Clients from a Server
To uninstall Vantage services and client programs, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage and click Remove or Uninstall.

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created is 
not removed.
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Uninstalling Vantage Clients from Workstations
On workstations, the Vantage client programs are the Vantage Management Console 
and Vantage Workflow Designer.

Note: Although Vantage Workflow Portal is also a workstation client program, you 
must use a separate uninstall procedure to remove it (see Uninstalling Workflow 
Portal). 

To uninstall Vantage client programs, follow these steps:

1. Log onto the target computer.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP: Control Panel > Add/Remove Programs.

– Windows 7: Control Panel > Programs and Features > Uninstall Programs.

3. Select Vantage Client and click Remove or Uninstall.

Uninstalling the Vantage Domain Database

Note: If your domain has a mirrored database server, be sure to disable mirroring, and 
stop the SQL Server Agent service before proceeding.

To remove the Vantage domain database, follow these steps:

1. Log on to the server with a local administrator account.

2. Open the control panel tool to remove programs in your operating system:

– Windows XP and Windows Server 2003: Control Panel > Add/Remove Programs.

– Windows Server 2008: Control Panel > Programs and Features > Uninstall 
Programs.

3. Select Vantage Domain Database and click Remove or Uninstall.

4. If Microsoft SQL Server 2008 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2008 and click Remove or Uninstall.
b. Click Remove.
c. Click OK.
d. Select the Vantage instance, and click Next.
e. Click Select All, and click Next.
f. Click Next.
g. Click Remove.
h. Click Next.
i. Click Close.
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5. If Microsoft SQL Server 2005 Express or Standard is installed, do the following:

a. Select Microsoft SQL Server 2005 and click Remove or Uninstall.
b. In the Component Selection dialog, check Remove SQL Server 2005 instance 

components, select VANTAGE: Database Engine, check Workstation Components, 
and click Next.

c. Click Finish.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, be sure to do so 
in the Services control panel, before proceeding by pressing Retry.

Note: If you have multiple instances (SQLEXPRESS and VANTAGE for example), you 
will need to remove them both.

6. Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the database does not delete your Vantage workflows, resources, 
or transaction history. It leaves your database files intact in [Install_Drive]:\Program 
Files\Telestream\Vantage\Database. This allows you to re-attach a Vantage domain 
database and return Vantage to a previous state when re-installing Vantage or 
upgrading Vantage.

Removing Vantage Domain Database Files
You should remove the database files only if you plan to perform a clean Vantage 
installation or if you never want to use this Vantage domain data again and want to 
destroy it.

To permanently delete the database files, which include all data associated with this 
Vantage domain, use Windows Explorer to delete the following directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage\Database

To permanently delete all Vantage files, use Windows Explorer to delete the following 
directory:

[Install_Drive]:\Program Files (x86)\Telestream\Vantage

If Vantage is the only Telestream product on the server, use Windows Explorer to delete 
the following directory:

[Install_Drive]:\Program Files (x86)\Telestream

CAUTION: Deleting these files permanently destroys user-created Vantage domain 
configuration, workflows, and history. Make a backup of these files first if you want to 
preserve this domain.
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action

An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its task in the context of the workflow, using an action 
inspector. Action inspectors are specific to each type of action.

Actions are grouped by functional categories: communication, transcoding, file 
operations, metadata processing, etc. Each action is defined by the specific task they 
perform. For example, an email action, or a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose 
limitations on actions in a workflow. For example, you might require action B to depend 
on action A in a Vantage workflow.

Actions—during execution—operate on binders, variables, and states, and they 
generate an action state when they complete. Actions are executed by Vantage 
services, which perform the requirements of the action.

action state

The action state describes the condition of an action execution in process and after 
completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After 
execution, an action's final state may be Success | Ignore | Fail. Certain actions (Decide/
Examine/Compare/Identify, for example) allow the use to specify the post-execution 
state, including Ignore. For all other actions, the post-execution state is set by the 
service, and is either Success or Fail. These states display in the Workflow Designer Job 
Status panel.

Action states are always passed to subsequent actions. The incoming state is tested by 
the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state 
(right-click the action, and select Perform On > Success | Fail | Ignore | Any).

If an action fails, then the next action will inherit the Fail state and (in most cases) will 
not execute. If one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the 
Ignore state and will also likely not execute. Certain special actions, such as Message, 
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can be configured to perform on any state (Fail, for example)—this allows workflows to 
send an email if they detect a failure.

Action states have precedence when an action receives states from multiple incoming 
actions (a merge of multiple branches):

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state—Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state- Success has precedence over Ignore states.

• If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has 
lowest precedence of the three states. If an action receives an Ignore state and does 
not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state unless 
it is an action which can emit Ignore, and you have configured it to do so.

Agility service

The Agility service is the Vantage component (operating as a Windows service) which 
executes the actions relating to Agility job submission and interaction with Agility: Job 
Profile, and Job XML. Agility features are enabled in Vantage Enterprise Master Control.

All-in-one domain

An All-in-One (single-server) Vantage domain is one in which ALL components of 
Vantage—the Microsoft SQL Server Express database, all Vantage services, and client 
programs—are installed and operate on a single computer.

Analysis service

The Analysis service is the Vantage component (operating as a Windows service) which 
executes the actions relating to the analysis of content: Examine, Compare, and 
Identify.

Archive action

An Archive action, which is executed by the Staging service, uses the selected archiver 
(TAR, for example) to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements.

Multiscreen Flip action

Multiscreen Flip actions are an optional, license feature. Multiscreen Flip actions are 
executed by the Multiscreen service which only runs on a Lightspeed sever, and 
implement the specified codec, which is used to encode and package decoded digital 
baseband media into adaptive rate streaming formats, including Adobe HDS, Apple 
HLS, Microsoft HSS, and others. Transcoding is performed by the Telestream Media 
Transcode and Analysis engine on behalf of Vantage.

Associate action

An Associate action uses the Monitor service to continually (and at regular periods) poll 
a target location (a directory, for example) on a device or file system (FTP, network 
folder, etc.) to discover new files, based on some permutation of the name of the file 
being processed.
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Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files. For example, if media file 
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be configured in the Associate action's inspector.

Associate actions begin executing when a job is submitted, and execute until a new file 
is discovered—subsequent actions do not execute until the file is found. When the new 
file is discovered, the Associate action makes the file available to the other actions in 
the workflow.

Configuration is accomplished in the inspector, and is based on the target device/file 
system being monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of a 
workflow. For example, an attachment may be an XML file that contains metadata, an 
SCC caption file, an STL or PAC subtitle file. Attachments may also be a PDF file, Excel 
spreadsheet, or Word document, for example. Attachments are identified and 
processed using nicknames for simplicity. Processing is optional—attachments may be 
simply passed through a workflow for storage with the processed media and registered 
in a Vantage catalog.

attachment nickname

See nickname.

binder

A binder is a collection of media files, attachment files, and metadata labels. A binder 
allows a workflow to keep track of all working files while the workflow executes.

Files within binders are referenced by nickname—that is, a binder is not a physical 
location, rather a collection of references. The underlying files may be moved around 
without changing the nickname of the file. This allows a binder to be submitted to, or 
passed between, workflows without requiring that the files be in specific locations.

Binders are referenced by jobs, and by the catalog. If a binder is not in the catalog, and 
not associated with a job, then the binder will be deleted. When a binder is deleted, any 
temporary files (such as media files in Vantage Stores) will also be deleted.

catalog

See Vantage catalog.

Catalog service

The Catalog service is the Vantage component (operating as a Windows service) that 
executes actions utilizing the Vantage catalog.

See Register action.
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common actions

Common actions are actions that are implemented in—and can be executed by every 
Vantage service; they are not implemented in a single service.

See Receive action, Forward action, Decide action, Compute action, Construct action, 
Synchronize action

Communicate service

The Communicate service is the Vantage component (operating as a Windows service) 
that executes the actions relating to electronic messaging.

See Message action, Notify action.

Compare action

A Compare action uses the Analysis service to compare media files based on certain 
metrics (for example, PSNR). These metrics can generally be published as variables or as 
a label.

Compute action

A Compute action, which is implemented in every service, performs various arithmetic 
and string manipulation functions, permitting you to create and modify values in 
variables, for use in downstream actions.

console

The term console is an informal name for the Vantage Management Console. 

See Vantage Management Console.

Construct action

A Construct action, which is implemented in every service, enables you to construct 
complex strings, paths, and math expressions from literals, variables, and tokens, for 
use in downstream actions.

Copy action

A Copy action is executed by the Transport service, and is used to replicate a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination.

Copy actions can be executed on any action state.

database

The term database is the common term used to refer to the Vantage domain database, 
where all specifications for the domain are stored, along with workflows and job 
history.

Decide action

A Decide action, which is implemented in every service, is an action which allows you to 
explicitly set the action state based upon analysis of variable values at runtime. It is 
most commonly used to determine whether or not subsequent actions (or actions in a 
given branch) in a workflow should execute.
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When the Decide action is used, the state set by the analysis is passed to the next 
action; as a result, for decision branches more than one Decide action will usually be 
used. For example, if one branch is for HD media, it will start with a Decide action that 
will set the state to Success for HD content, or set it to Ignore otherwise; if another 
branch is for all other media, it will start with a Decide action that performs the 
opposite behavior.

See variable, action state.

Delete action

A Delete action is executed by the Transport service, and is used to permanently remove 
a file from a source target (file system/device and directory). Delete actions can be 
executed on any action state.

Deploy action

A Deploy action is executed by the Transport service, and is used to save the specified 
files to a destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, 
Deploy actions allow multiple files to be operated on simultaneously, and do not 
maintain a reference to those files in the binder after it completes.

domain 

See Vantage domain.

Flip action

Flip actions are executed by the Transcode service, and implement the specified codec, 
which is used to transcode decoded digital baseband media into another media 
encoding format. Transcoding is performed by the Telestream Media Transcode and 
Analysis engine on behalf of Vantage.

Enterprise Edition

Vantage Enterprise is a special edition of Vantage, which adds system management 
features which enable a high level of visibility and a deep level of control for large-scale 
or mission-critical workflows. Vantage Enterprise is offered in two licenses: Enterprise 
Control, and Master Control.

Examine action

An Examine action uses the Analysis service to evaluate the video and audio of a media 
file to measure certain characteristics, such as audio loudness, or to detect 
characteristics, such as the presence and size of curtains. You can configure it to publish 
metadata or variables containing the results of analysis.

Exist action

An Exist action uses the Catalog service, and allows you to determine if a binder of a 
given name (or name fragment) is present in a specified catalog.

failover database

The term failover database is the term used to refer to the optional mirrored database, 
which the Vantage domain will automatically be transitioned to in the event of a failure 
of the primary database.
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Forward action

A Forward action, which is implemented in every service, forwards a binder and all 
current variables to another workflow, starting a new job with the target workflow. A 
Forward action may be added to the end of a workflow, and requires that the target 
workflow has a Receive action as its first action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create comprehensive, intelligent run-time switching 
workflows consisting of smaller workflows used as building blocks.

See Receive action.

Gather action

A Gather action is implemented by the Staging service, and collects one or more files 
from a specified server and directory (and optionally, its subfolders), and bring them 
into the workflow as attachments. Use of a file matching pattern allows you to select 
only certain types of files.

hot folder

A hot folder is a slang term for a directory on a server that has been identified as a 
directory for storing media to be processed by a workflow in Vantage. When the 
workflow monitor identifies new media in this folder, it is submitted for processing.

inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that 
facilitate the setup and configuration of a given action. Inspectors are unique to each 
action—for example, configuring a Watch action is very different than configuring a 
Flip action.

Identify action

An Identify action uses the Analysis service to determine certain properties of a media 
file, such as codec type, video bitrate, or file size. This information can then be 
published as a metadata label, or as variables.

job

A job is an execution of a Vantage workflow. Jobs have a state (separate from action 
states), and jobs are comprised of actions that are executing. Jobs, like actions, may be 
in-process or they may be complete. 

As a job executes, each action may be performed by any service (on any computer) in 
the Vantage domain that is capable of performing it. The capability of a service to 
perform a specific job depends on its current operating state, its workload, and its 
suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Workflow Designer by selecting the 
workflow in the Workflow Designer panel and displaying the Job Status panel. 
Alternatively, all in-process and failed jobs within a Vantage Domain may be viewed in 
the Status section of the Management Console.
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Job Profile action

Use the Job Profile action (which is executed by the Agility service) to submit jobs to 
Agility for processing; definition of the job is provided directly in Vantage by 
configuring the action.

Job XML action

Use the Job XML action (which is executed by the Agility service) to submit jobs to 
Agility for processing; definition of the job is provided in an XML file.

job routing

See qualification rule.

job state

A job state is the current condition of a job. Keyword values are Start | Pause | Success | 
Fail | In Process.

Job Status Web App

The Job Status Web App enables you to view real-time information about jobs in the 
domain from anywhere on your network with a Web browser. The Job Status Web App 
is installed on the IIS server on your Vantage domain database server. This Web app is 
available in all Vantage Enterprise licenses.

label

A label or metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, Author, ISCI, 
and other metadata values; this set of metadata is collectively called a Spot metadata 
label. Metadata labels are stored in binders with the associated media and attachment 
files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you 
can create and modify labels for your use using the Management Console (Workflow 
Design Items > Metadata Labels).

license

A license is stored in the Vantage database. Generally, licenses are imported as XML files 
into the database through the Management Console.

MediaMate action

A MediaMate action is used to provide screen subtitling, by utilizing various subtitling 
systems from Screen.

media nickname

See nickname.

Message action

A Message action is implemented in the Communicate service, and is an action which 
enables you to generate and transmit an electronic Message—an email, for example. 
You must configure Vantage to use an SMTP server (Management Console: Vantage 
Domain > Settings & Options > Email) before email can be utilized.
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Metadata service

The Metadata service is the Vantage component (operating as a Windows service) that 
executes the actions relating to the transformation of metadata between labels, 
variables, and XML files.

See also Populate action, Transform action.

Monitor service

The Monitor service is the Vantage component (operating as a Windows service) that 
executes the actions relating to the discovery of files and starting jobs.

See also Watch action, Associate action.

Move action

A Move action is executed by the Transport service, and is used to move a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination, then deleting the source.

Move actions can be executed on any action state.

nickname

Nicknames are user-defined strings that are used to reference files within a Vantage 
workflow. Nicknames allow users a convenient way to design workflows independent 
of the actual file locations or underlying file names. As a workflow executes, it maintains 
a collection of underlying files called a binder; nicknames allow the workflow to access 
files within the binder.

Nicknames may refer to either media files, or attachment files. Certain actions will only 
allow the use of certain nickname types; for example, a Flip action only allows media 
file nicknames to be used as the inputs and outputs. However, other actions (such as 
Move and Copy actions) operate on any type of file, and allow the use of any nickname.

The use of a nickname does not affect the actual name of the underlying file, nor do 
nicknames have any special meaning. For example, providing a media file the 
nickname Flash does not necessarily mean that the media file is in fact a Flash file.

Nicknames can be managed in the Management Console under Workflow Design 
Items > Media Nicknames. Nicknames can also be entered manually, directly in the 
Workflow Designer.

The word Original is a reserved nickname specific to media files.

Notify action

A Notify action is implemented in the Communicate service, and is an action which 
saves job information to a file, or which interfaces with an external system. You can 
configure a Notify action to produce an XML file, and you can also use it to invoke a 
Web service.

origin action

An origin action is a specific type of action, which must be used to start a workflow. A 
workflow without an origin action as its first action is not properly designed, and can’t 
be activated. The origin actions are Watch and Receive.
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Populate action

A Populate action uses the Metadata service to transform data between variables and 
metadata labels, and publish variable values from the label for use in downstream 
actions.

Process MMF action

A Process MMF action (which is executed by the Agility service) processes an 
attachment as an MMF file and generate variables from it.

qualification rule

A qualification rule influences or controls the routing and execution of actions among 
Vantage services of the same type in a distributed Vantage domain. Qualification rules 
can be used to ensure that jobs are routed to services that are best suited for the task. 
Vantage uses values contained in variables to determine the suitability of a given 
service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any actual 
machine analysis. As a result, it is up to the system administrator to correctly set up 
variables and qualification rules, and apply variables to the appropriate actions to 
ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: 
Vantage Domain > Services.

See also run on rules.

Receive action

A Receive action is an origin action which is implemented in every service, to provide a 
starting point for new jobs in Vantage workflows that are not started by a Watch or 
other starting action. 

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create comprehensive, intelligent run-time switching 
workflows consisting of smaller workflows used as building blocks.

Only workflows that end with a Forward action are used to start Receive-based 
workflows. When you chain workflows, you can pass binders and variables between 
them.

See Forward action.

Register action

A Register action uses the Catalog service to place a binder into a Vantage catalog. 
Register actions can be executed on any action state.

See also Vantage catalog.

resource unit

A resource unit is an integer value, implemented in the Vantage Management Console 
on each action type to specify a relative computer resource consumption value in 
relation to all other action types. This value enables Vantage to maximize resources and 
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optimize transactions, so that you can tune your Vantage system for the highest 
possible throughput on your particular hardware.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have 
the characteristics that enable them to execute this action. Rules are set up by 
specifying variables which have been bound to a given Vantage service and values set. 
Now, the action can test each rule by comparing its run time value to the value in the 
service’s copy and determine if there is a match before attempting to execute it. 

See also qualification rule.

Staging service

The Staging service is the Vantage component (operating as a Windows service) which 
executes Archive actions and Gather actions.

service

See Vantage service.

single-server domain 

See All-in-one domain.

Synchronize action

A Synchronize action, which is implemented in every service, is a connector action, for 
the sole purpose of uncluttering workflow connectors. In workflows where there is a 
many-to-many relationship (for example, 6 Flip actions connect to 6 Deploy actions, 
which connect to 6 deletes), instead of drawing all six connects from each action, you 
can simply connect them to a common Synchronize action. There is no inspector for 
the Synchronize action, because no configuration is required.

Team Management

Team Management is a licensed feature in a distributed Vantage domain, which adds 
user access control. By creating specific Vantage users (and optional passwords) in the 
Vantage domain console, Vantage administrators can control access to workflows in 
Workflow Designer and Workflow Portal. You can also control access to the Vantage 
Console, thus limiting who can configure and control the domain itself.

transcode 

Transcode means the process of decoding media in one format (MPEG2, for example) 
down to digital baseband and then encoding it in another media format (MPEG4, for 
example). 

Transcode service

The Transcode service is the Vantage component (operating as a Windows service) that 
executes Flip actions—transforming media from one format to another. 

See Flip action.

Transform action

A Transform action uses the Metadata service to transform metadata between XML files 
(attachments) and labels. XSL style sheets are used to perform these transformations; 
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style sheets can be managed in the Vantage Management Console: Vantage Domain > 
Catalogs.

Transport service

The Transport service is the Vantage component (operating as a Windows service) that 
executes the actions relating to file operations.

See also Move action, Delete action, Copy action, and Deploy action.

Vantage catalog

The Vantage catalog (or simply catalog) allows the management of binders that you 
want to exist past the life of an individual job. Folders can be created in the catalog with 
individual expiration rules.

The catalog and its folders are not a physical location; rather they are a way of 
organizing binders and controlling when the binders—and the underlying files—are 
deleted.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all 
workflows, actions, jobs, binders, licenses, and configuration information for a Vantage 
domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage 
services, jobs, binders, and configuration settings, all known to and interacting with 
each other, stored in a Vantage database. This collection constitutes a Vantage domain. 
Vantage domains may exist on a single computer or they may be distributed across 
many computers for durability and scalability.

The name of a vantage domain is generally the same as the name of the server that 
hosts the Vantage database.

Multiple Vantage domains may exist on a network, but they are independent entities 
that do not communicate with each other. They are not bound together and do not 
share resources or work. The purpose of storing an entire domain in a database is to 
provide an easy way to create and manage the domain and to provide access to all the 
details about each resource in the domain to any other resource that needs it.

Vantage folder address

A Vantage folder address is a named directory on a supported file system that is stored 
in the Vantage database, which is used in Move and Copy actions. Unlike Vantage 
stores, actions that use Vantage folder addresses write files to external file systems so 
these files are not deleted when a binder is deleted. 

You can create and manage Vantage folder addresses in the Vantage Folder Address 
Book dialog, in Copy and Move actions in Workflow Designer, and in the Vantage 
Management Console. Once created, you can specify the destination directory in a 
Copy or Move action simply by supplying the name of the folder address. Changes to a 
Vantage folder address—such as updating an IP address or a password—immediately 
affect all workflows.
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Vantage Management Console

The Vantage Management Console (usually referred to informally as the console, for 
short) is a Windows MMC program that enables Vantage system administrators to 
effectively configure Vantage domains, and scale domains across multiple servers to 
meet their operating requirements and perform effectively in their environment.

Vantage service

The term Vantage service refers to the collection of software components (operating as 
Windows services) in a Vantage domain that implement and execute the actions in a 
workflow as it executes.

Vantage store

A Vantage store is a directory on a Windows file system that used for storing temporary 
files. Stores are managed by the Vantage domain for the purpose of centralizing large 
directories for reading and writing files. Unlike a Vantage folder, files placed in a 
Vantage store are deleted when the binder is deleted. Vantage stores are generally 
used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Vantage Domain > 
Storage. Services that create temporary files, such as the Transcode service, can be 
configured to use specific stores.

Vantage Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit 
workflows, activate and deactivate them, and monitor their status and review jobs in 
process and jobs that have completed.

Vantage Workflow Portal

Vantage Workflow Portal is a client program that features a customizable set of 
functionality to support various operator-related tasks: Selecting media and submitting 
jobs, updating variables and metadata and forwarding jobs, creating EDL-base jobs, 
etc.

Customization is implemented in the Vantage Management Console, when Vantage 
administrators construct the user interface and functionality they want for a given task, 
then save it. When operators launch Portal, they select the configuration appropriate to 
the task at hand, and Portal dynamically implements the appropriate user interface 
from the configuration file.

variable

A variable identifies temporary job metadata. Variables have a name (such as Number of 
Audio Channels), a type (such as Integer Number) and a default value. Variables values 
can be set inside a job in a variety of ways: Through analysis, through metadata 
population, in the Watch and Associate actions, as a property of an action, or by a 
service as it executes an action.

Variables are used by Vantage services and actions to control their behavior and 
workflow logic. The majority of parameters in Vantage can be bound (or attached) to 
variables, allowing the workflow to dynamically update on a job-by-job basis. 
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For example, a variable may be assigned a value by an analysis action to determine how 
many lines of black are at the top of a video frame; a crop filter later in the workflow can 
bind to that variable, ensuring that every crop in every job is appropriate to the 
workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a 
FibreRequired=TRUE variable must pass this condition to a service which evaluates the 
condition to determine if it can successfully perform the action.

Variables can be created in the Management Console (Vantage Domain > Workflow 
Design Items > Variables) or in Workflow Designer, and assigned for use in workflows 
and services.

Watch action

A Watch action is an origin action; it uses the Monitor service to continually (and at 
regular periods) poll a target location (a directory, for example) on a device or file 
system (FTP, Windows network folder, etc.) to discover new files.

When a new file is discovered, the Watch action submits a job for the workflow which it 
is part of, for processing the file—typically, a media file.

Web Dashboard

The Web Dashboard enables you to important domain information from anywhere on 
your network with a Web browser. The Web Dashboard is installed on the IIS server on 
your Vantage domain database server. The Web Dashboard is available in Vantage 
Enterprise Master Control.

workflow

A workflow in Vantage is a set of actions designed to perform an automated process. 
Vantage workflows are created using the Vantage Workflow Designer by adding and 
configuring actions and connecting them together. Workflows are stored in the 
Vantage database, and executed by Vantage services.

Workflow Portal

Short for Vantage Workflow Portal. Also sometimes called just Portal, for short.

Workflow Designer

Short for Vantage Workflow Designer. Also sometimes called just Designer, for short.
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Index
Symbols
.Net Framework 4 or later, required for

Vantage 40
.Net Framework, required versions 40

Numerics
32 cores, exceeding causes difficulty de-

coding MPEG2 and H.264 34
3rd Party Devices view 266
64-bit processors, for Windows Server

2003/2008 32, 34

A
Address Book folder, deleting 146
aliases for stores 138
all-in-one installation 59
anti-virus software 60, 69
Array Statistics view 270
ASP.NET registration tool 87
aspnet_regiis.exe 87
attachment nicknames

importing / exporting 175
authorization settings, generally 115
authorization, credentials record,

adding 117

B
backing up a domain 215
browsers, recommended 252

C
CD-ROM installer 50
client programs, operating system

requirements 36
clients and services, uninstalling 289
component panel, generally 108
Computer Browser Service, must be en-

abled in Windows Server 2008 39
connecting manually to a domain 106
connecting to a domain 107
console workspace, using, generally 108
console, starting 104
copyright notice 3
CPU, minimum requirements 32, 34

D
data collection, for tech support 195
database files, removing 291
database server, dedicated, platform re-

quirements for 48
database, guidelines for 45
database, uninstalling 290
database, Vantage domain, moving 87
dedicated database server, guidelines for

using 48
default

password 255
user name 255

default values, specifying for
variables 175

DEP, configuring for license enabling 81
DEP, enabling 81
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details panel, generally 109
diagnostics, generally 191
disk space, recommended 33, 34
displaying filters 278
distributed domain, installing 64
Distributed Transaction Coordinator 60,

69
documentation, Web Dashboard 258
domain 103, 304

backing up 215
connecting to 107
connection settings 105
manually connecting 106
restoring from backup 215
selection 254
specified in MS SQL database 104

domain components 108
domain database, installing 51
Domain Job Status view 276
domain name, computer name or IP ad-

dress used 106
domains, Windows, accessing shares in

other 115
dotnet, see .Net 40
DTC Service, verifying settings 101

E
Email from Vantage, testing 114
Email settings, configuring 113
eSellerate, DEP error 81
eSellerate, using to validate Vantage

license 79
Ethernet, minimum requirements 33, 34

F
Fibre 33, 34
folder

adding 143
deleting 146
modifying 145

folder addresses
importing / exporting 147

folders, managing, generally 142

G
GigE, required for Vantage 34

H
H.264, decoding difficulty on servers ex-

ceeding 32 cores 34
hardware requirements 32
help documentation 258
help system, using 217
hostname, for SMTP server 114
HTTP 500.19 error 87

I
IIS 7.0, required on Windows Server 2008,

for Web applications 83
IIS server, installing Web applications

on 35
installer, CD-ROM for 50
installer, obtaining 50
installers, explained 51
installing the license 53
IPP, installing 61, 69

L
labels

creating and configuring in
console 171

deleting 172
duplicating 172
importing / exporting 172

license
adding to a domain 159
managing in console, generally 159
obtaining from Telestream 53
removing from a domain 159
reset Workflow Portal 160

License Status view 261
license, activating offline 77
license, enabling in Vantage 76
license, for Vantage, installing 53
license, requirements for mirror

database 50
license, requires DEP to enable 81
license, validating via eSellerate 79
licensing, generally 53
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log on ID, setting for Vantage services 72,
98

logging in 254
logging out 257
logs, configuring 153

M
maintenance mode

entering 266
exiting 266

managed storage 132
Management Console

starting 104
manually connecting to a domain 106
media nicknames, managing,

generally 164
Message Action, requires configuring

Email settings 113
metadata labels, managing, generally, in

console 166
metadata labels, see labels 169
Microsoft SQL Server standard Client Ac-

cess License, required for mirror
database 50

mirror database, license required for 50
Mirrored Database, System

Requirements 33
MMC 103, 304
MMX 33, 34
monitoring

3rd Party Devices view 266
Array Statistics view 270
Domain Job Status view 276
License Status view 261
Release & Patch Status view 262
Service Statistics view 268

MPEG2, decoding difficulty on servers ex-
ceeding 32 cores 34

MS SQL database, used to specify
domain 104

N
notices, legal, generally 3

O
operating system requirements 35

P
page control feature 277
page size, specifying 277
password

default 255
patches, installing 62, 71
Performance Primitives 52
planning for a distributed domain 54
ports, used by Vantage 41
processor, minimum requirements 32, 34

Q
QuickTime 39, 52

installing 61, 69
version, required for Vantage 39

R
RAM, min. requirement for Vantage 32
RAM, minimum requirements 32
Refresh button 266
Release & Patch Status view 262
removing database files 291
restoring a domain 215

S
Server Health chart 264
service

configuring 151
determining plugins installed for 200
disabling all services 266
enabling all services 266
logs for 153
managing in console 147
using variables in 154

Service Health chart 274
Service Marker 152
service metrics history, clearing 267, 275
Service Statistics view 268
services and clients, uninstalling 289
services, adding to a domain 74, 97
shares, accessing in other Windows

domains 115
Show Filters feature 278
SMPT server, setting hostname for 114
SMTP port, specifying 114
SQL instance, VANTAGE 51
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SQL Server 2008 Express SP3 51
SQL Server 2008 Standard, installing for

distributed Vantage domain 65, 91
SQL Server Standard, guidelines for

using 46
SSE 33, 34
SSE2 33, 34
starting the Management Console 104
starting the Web Dashboard 253
status of resources in domain, via

console 161
storage

managed 132
unmanaged 132

stores
adding 135
aliases for 138
assigning to service for use 154
configuring 135
defined in console 132
deleting, prohibited when files

attached 142
used in actions and services 132

stores, configuring 63, 74

T
tech support

data collecting for 195
Telestream

International 15
sales and marketing 15
technical support 15
Web site 15

Telestream Media Transcode and Analysis
engine

installing 62, 70
Telestream, contacting 15
Third Party Devices view 266
trademark notice 3
trademark notices 3
Transcode Installer 70

U
uninstalling

subsystems not removed 58, 286, 289
uninstalling services and clients 289

uninstalling Telestream Media Transcode
and Analysis engine 289

uninstalling the database 290
Uninstalling Web applications 288
Uninstalling Workflow Portal 288
uninstalling Workflow Portal 288
unmanaged storage 132
upgrading Vantage to 4.0 57
User Account Control Admin Approval

Mode, running installers when
enabled 39

user name, default 255
utilities

generally 191

V
Vantage

.Net Framework 4 requirement 40
activating the license offline 77
distributed domain, planning for 54
domain database installation 51
downloading installation software 50
eSellerate license validation 79
license, installing 53
port requirements 41
RAM requirements 32

Vantage 4.0, upgrading from previous
version 57

Vantage distributed domain, installing 64
Vantage domain

connection settings 105
manually connecting 106

Vantage domain database, moving to an-
other database 87

vantage folders, see folders 142
Vantage Job Status Web App 24
Vantage Management Console,

starting 104
Vantage Monitor chart 273
Vantage patches, installing 62, 71
Vantage service logon properties 73, 99
Vantage services, adding to a domain 74,

97
Vantage services, log on ID 72, 98
Vantage services, operating systems

for 37
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Vantage Web applications, operating sys-
tem requirement 36

Vantage Workflow Portal Web app,
generally 24

Vantage, all-in-one installation 59
Vantage, enabling a license in 76
VANTAGE, SQL instance name 51
variables

creating in console 175
specifying default values for 175
using in services 154

version, Web Dashboard 258

W
Web applications, installation steps 83
Web applications, operating system

requirement 36
Web Dashboard

log out 257
login 254
starting 253
version information 258

Web Workflow Portal app, generally 24
Windows 7, supported for Vantage

clients 36
Windows Firewall, must be disabled 36
Windows Installer 4.5, required for data-

base servers 37, 38
Windows Media Video V9 Advanced Pro-

file (VC1 Advanced Profile) codec,
requires Windows Media Player
11 37, 38

Windows Server 2003 R2 (32-bit | 64-bit),
required for Vantage services 37

Windows Server 2003 R2, supported for
Vantage clients 36

Windows Server 2003 Requirements 38
Windows Server 2003, on 64-bit

processor 32, 34
Windows Server 2003, required for Van-

tage services 37
Windows Server 2008 R1 and R2, support-

ed for Vantage clients 36
Windows Server 2008 R1, required for

Vantage services 37

Windows Server 2008 R1, required for
Web applications 36

Windows Server 2008 R2 37
Windows Server 2008 R2, required for

Web applications 36
Windows Server 2008 Requirements 38
Windows Server 2008, on 64-bit

processor 32, 34
Windows Server 2008, requires Computer

Browser Service to be enabled 39
Windows Vista, supported for Vantage

clients 36
Windows XP Pro Requirements 37
Windows XP Pro with SP3, for all-in-one

domains only 37
Windows XP Pro, supported for Vantage

clients 36
workflow design items

creating variable, in console 175
Workflow Portal, installation steps 82
Workflow Portal, uninstalling 288
workflows, importing/exporting 192
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